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Osnove rada s alatima za graficki dizajn (Inkscape, GIMP) (M100)

Uvod

Na ovome tecaju polaznik se upoznaje s osnovnim mogucénostima
programa za obradu vektorske grafike Inkscape i programom za obradu
rasterske grafike GIMP, koje ¢e mu omoguditi da izraduje jedinstvena
graficka rijeSenja. Oba programa su otvorenog kdda i besplatni za
koriStenje.

Tecaj je namijenjen pocetnicima ili onima koji su se malo sluzili
programima za obradu vektorske i rasterske grafike, odnosno onima koji
Zele dodatno utvrditi svoje znanje.

Polaznik ¢e na te€aju nauditi:

izradivati crteZe i obradivati postojece crteze
- rabiti boje i gradijente u crteZima

- precrtavati crteze

- dodavati tekst slikama i uredivati ga

- retuSirati slike

- koristiti se filtrima za poboljSanje slika

- izvesti slike u vektorski ili rasterski format.

Teclaj je namijenjen edukaciji svih zainteresiranih polaznika u podrudju
rasterske i vektorske grafike tj. izradi i koridtenju grafi¢kih elemenata u
besplathom programu za stvaranje i obradu vektorske grafike Inkscape i
besplathom programu za stvaranje i obradu rasterske grafike, GIMP.

Nakon tec€aja polaznici ¢e ste¢i osnovnu razinu znanja u grafi¢kim
programima Inkscape i GIMP, te ¢e moci stvarati jedinstvena grafic¢ka
rieSenja. Nau it Ce izradivati crteze ili obradivati postojece pomocu
osnovnih grafickih objekata ili prostoru¢nim crtanjem, koristenjem
Bézierovih krivulja. Savladat ¢e stavljanje boje na crteze u bilo kojem
obliku (heksadecimalnom, RGB, HSL, CMYK ili slobodnim odabirom),
stvaranje gradijenata, precrtavanje slika, dodavanje i uredivanje teksta,
izvoz slika u vektorski ili rasterski format. Naucit ¢e koristiti osnovne
alate za obradu slika, retusiranje slika, izmijeniti rezoluciju slike, koristiti
se raznim filtrima za pobolj$anje slika, umetnuti i prilagoditi tekst,
spremiti sliku ovisno o kasnijoj upotrebi (tisak ili web) i drugo.

Za oznacavanje vaznijih pojmova, naziva naredbi i elemenata sucelja te
naziva drugih elemenata koji se nalaze na ekranu, koriste se
podebljana slova. Pravo ime alata u priru¢niku je navedeno u zagradi
jer se do toga imena dolazi dvostrukim klikom lijeve tipke miSa na ikonu
alata u Toolboxu tako da nije odmah vidljivo, a opis alata koji se
pojavljuje prelaskom miSa preko ikone alata u Toolboxu je podebljan.
Prije ili poslije opisa i naziva alata nalazi se i prikaz ikone toga alata u
Toolboxu kao Sto je navedeno u sljede¢em primjeru: Zoom in or out

(Zoom) Q :

Put do naredbe pisan je kurzivom, a sama naredba podebljano,
primjerice Tools - Selection Tools - Rectangle Select.

@ srce '
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1. Upoznavanje radnoga prostora
programa Inkscape

Po zavrsetku ovoga poglavija moci cete:
e instalirati i pokrenuti program Inkscape
e prepoznati dijelove sucelja programa
e podesiti parametre pri stvaranju novoga dokumenta

e otvoriti postojecu datoteku te pregledati i objasniti njezina
svojstva

e zumirati, koristiti ravnalo, mrezZu i pomicne linije
e izvesti i spremiti gotov uradak.

1.1. Pokretanjei upoznavanje radnoga prostora
Inkscapea

Nakon instalacije programa, potrebno se upoznati s osnovnim alatima i
dijelovima sucelja Inkscapea. Kao i svaki drugi program tako i Inkscape
ima specifi¢ne dijelove sucelja pomocu kojih se moze vrlo lako do¢i do
Zeljenih naredbi, alata ili nekih drugih dodatnih opcija programa.

1.1.1. Instalacija Inkscapea i sustavi na kojima je dostupan

Instalacijsku datoteku potrebno je preuzeti sa stranice
https://inkscape.org. Odabere se poveznica, ovisno o vrsti sustava, te se
nakon toga preuzme instalacijska datoteka.

Na dolje prikazanoj slici prikazane su poveznice preko kojih je mogucée
preuzeti instalacijsku datoteku za operacijski sustav Gnu/Linux,
Windows, Mac ili izvorni kéd. Prilikom odabira opcije Windows,
oznacene crvenim okvirom na donjoj slici, moguce je jos i odabrati
instalacijsku datoteku za 32 ili 64 bitnu verziju sustava.

Gnu/Linux Windows Build Inkscape on your The raw code ready to
Mac with MacPorts compile

V Linux based Free Desktop My Microsoft's Windows Desk-
Systems [ ] top M a MacPorts X Source

Nakon preuzimanja potrebno je pokrenuti datoteku i slijediti korake koji
se uglavnom sastoje od toga da se odabire dugme Next te na kraju
instalacije dugme Finish.

S obzirom na to da se radi o programu otvorenoga kéda, osim verzije
programa koje su namijenjene obi¢nim korisnicima, moguce je preuzeti i
verziju programa za korisnike koji imaju odgovarajucu vrstu znanja i
voljni su razvijati program.

Zanimljivosti i napomene

Najpoznatiji sustavi za koje
je dostupan program
Inkscape: Windows 10,
Windows 8, Windows 7,
Windows Vista, Windows
XP, Mac OS X 10.5-10.10,
Ubuntu, Debian, Red Hat,
OpenSUSE...



https://inkscape.org/release/inkscape-0.92.4/
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1.1.2. Pokretanje Inkscapea

Za pokretanje programa u sustavu Windows, odabere se dugme Start >
Sve aplikacije = Inkscape. Prilikom prvoga pokretanja program ¢e se
sporije otvarati jer podeSava razne opcije, ali ve¢ drugi i svaki sljedeci
put pokretanje ¢e biti puno brze.

Za pokretanje Inkscapea na Linux sustavima, klikne se na Applications
-> Graphics - Inkscape.

Za pokretanje na sustavima Mac, potrebno je odabrati mapu
Applications te potom Inkscape.

1.1.3. Upoznavanje sa suceljem programa

Kada se otvori Inkscape prikazuje se jedan veliki prozor koji sadrzi
nekoliko manijih podrucja, razne ikone i padajuce izbornike.

Izgled samoga sucelja i polozaj dijaloSkih okvira moguce je promijeniti u
izborniku View. Mogucée je odabrati izmedu tri opcije, Default, Custom i
Wide.

U zadanim (Default) postavkama:

o Naredbena se traka (Commands Bar) nalazi na vrhu dok je
izbornik Snap Controls Bar na desnoj strani

U Custom postavkama:
e naredbena traka i Snap Controls Bar su na vrhu
U Wide postavkama:
e inaredbena traka i Snap Controls Bar su na desnoj strani.

Dodatni dijalo$ki okviri mogu se sakriti i prikazati pomoc¢u naredbe View
- Show/Hide Dialogs.

Klju€ni dijelovi koje moZemo vidjeti na sucelju programa su naredbe,
snap bar, alati i drugo.




Osnove rada s alatima za graficki dizajn (Inkscape, GIMP) (M100)

O © © O e o

New document 1 -

¥

Fill:
Stroke:

File Edit View Layer Object Path| Text Filters Extepsions Help
OUERES AF BRlDsed @@ TEaE &8 BPTREEI B H
El A B o 8 LB s £7 | %0000 ¥: | 0,000 W: |0,000 @ Hlood Flex [=] >
= I I I T NP I PO .11 TR P 201 Ll (=2 I2Layers (Shift+Ctrl+l) (& B
f\{ o % A ’ Layerl T‘“
£ 4
Q ] +- Fa103 J
% : Blend mode: | Normal E _t
|:| “ Opacity (%) IUU_UI; i
© i
7]
O | v
& -
O | :
] B
7 2
P 4 &

N/A o:|0 S @ dlayer1 B Mo objects selected. Click, Shift+click, Alt+scroll mouse on top of ﬁlgggg}l Z| % 5

@ O

Tool Box ili kutija s alatom — sadrzi alate za oznaCavanje, crtanje
ili izmjenu objekata. Klikom na ikonu alata odabire se zeljeni alat,
dok se dvostrukim klikom otvara dijaloSki okvir toga alata. Oblik
pokazivaa miSa mijenja se ovisno o odabranome alatu.

Menu Bar ili glavni izbornik — sadrzi glavne padajuce
podizbornike preko kojih je moguée doci do svih funkcija u
programu.

Commands Bar ili naredbena traka — sadrzi pre¢ace na mnoge
naredbe koje se nalaze u izbornicima, sluzi za brZi i lakSi rad u
programu.

Tool Controls Bar — sadrzi dodatne opcije odabranoga alata. Na
primjer, ako se u Tool Boxu odabere alat Poveéalo, u ovom
izborniku pojavit ¢e se sve dodatne opcije toga alata kao Sto su:
Uvecaj, Umaniji, Omjer 1:1, Prilagodi uvecanje odabira veli€ini
prozora, Prilagodi uvecanje stranice veli¢ini prozora te mnoge
druge korisne opcije toga alata.

Dialogs — dijaloski okviri koji se mogu ukljuiti ili isklju€iti, ovisno
o potrebi, a sluze za lakSi rad s elementima u programu.

Snap Bar — sadrzi ikone koje kontroliraju ,lijeplienje” elemenata
prilikom pozicioniranja i transformiranja.

Color Palette — sadrzi paletu boja. Boja se moze povuci iz palete
I direktno primijeniti na neki element. Ako se prilikom povlacenja
ili odabira boje drzi tipka [Shift], boja ¢e se primijeniti na obrub
elementa. Ispod palete boja nalazi se horizontalni kliza¢ pomocu
kojega se mogu vidjeti i odabrati sve ponudene boje.

Canvas — podrucje za crtanje, tj. platno na kojemu se crta u

......

ruba stranice $to znaci da nije ograni¢eno samo na obrubljeni dio

@ srce °
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kaji je vidljiv. Pritom rub predstavlja stranicu koja se ispisuje ili
izvozi, a sve §to je izvan njega se ne vidi ha ispisu ili na slici.

1.2. Prilagodba programa

Postavke programa moguce je prilagoditi preko izbornika Edit >
Preferences. Otvara se skocni prozor Preferences u kojemu korisnik
moze promijeniti gotovo sve postavke.

Q Preferences (Shift+Ctrl+P) liE-J
© Tools Interface
Windows I Language (requires restart): English (en] [~ I
Grids Toolbox icon size: Large |L|
Keyboard Shortcuts Control bar icon size: small [~
= Behavior Secondary toolbar icon size: Small |z|
Selecting
‘Work-around color sliders not drawing
Transforms
Serolling Maximum documents in Open Recent: | 36 = | Clear list
Snapping 100,00
100,00
Steps Zoom correction factor (in %): D
Clones o
| L L [mom [
Clippaths and masks
Markers V| Show filter primitives infobox (requires restart)
Cleanup Dockbar style (requires restart): Icons and text |z|
# Input/Output Switcher style (requires restart): Icons and text |z|
System
Bitmaps
Rendering
Spellcheck
m 3

Prvi izbornik Tools i podizbornik Shapes sadrzi dodatne opcije alata
kojima mozZemo pristupiti i ako dvostrukim klikom pritisnemo na bilo koji
alat u Toolboxu.

U izborniku Interface moguce je promijeniti sve postavke vezane za
prikaz u programu. Tako je moguce odabrati Zeljeni jezik na kojemu ¢e
biti program, veli¢inu ikona u raznim izbornicima, maksimalni broj
zapamcéenih dokumenata u izborniku Open Recent te mnoge druge
mogucnosti. Za promjenu jezika programa potrebno je kliknuti na
padajuéi izbornik pokraj mogucénosti Language (requires restart) te
odabrati Zeljeni jezik. Kako bi se promijenio jezik treba zatvoriti program i
ponovno ga pokrenuti kao $to je i navedeno u samoj opciji. Na gore
prikazanoj slici ta je mogucnost ozna€ena crvenim okvirom.

Ako se Zeli saznati precac do neke naredbe ili ako se Zeli postaviti neka
nova kombinacija tipki za neku odredenu naredbu, to je moguce izvesti
preko izbornika Keyboard Shortcuts. Promjena kombinacije tipki za
neku naredbu radi se tako da se klikne na naziv kombinacije tipki iz
stupca Shortcut te se umjesto naziva kombinacije pojavi natpis "New
accelerator” nakon kojeg biramo novu kombinaciju tipki (Shortcut). Popis
naredbi sortiran je po izbornicima.

Tijekom izrade crteza potrebno je mnogo puta pomicati element. Cesto
je taj korak kod pomicanja elementa velik pa ga je potrebno postaviti da

° @ srce
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bude maniji, a to se radi u izborniku Behavior - Steps. U njemu je
moguce odabrati za koliko odabranih mjernih jedinica ¢e se element
pomaknuti kada pritisnemo strelicu za pomicanje na tipkovnici ili za
koliko ¢e se mjernih jedinica povecati ili smanijiti neki element. Takoder
se moze odabrati i za koliko stupnjeva ¢e se rotirati neki element te neke
druge korisne opcije.

1.3. Izrada novoga dokumenta i njegove opcije

Stvaranje novoga dokumenta obi¢no je prvi korak u izradi nekoga crteza
u Inkscapeu. U pravilu se uvijek zapocinje crtati na praznome
dokumentu iako se moze poceti crtati i na nekome ve¢ postojeCem
dokumentu. Prazna stranica koristi se kada se Zeli crtati, bojati, izradivati
objekte od pocetka, a pocetnicima je korisna za istraZivanje novih alata i
svih mogucénosti koje nudi program.

1.3.1. Izrada novoga dokumenta

Prilikom otvaranja Inkscapea otvara se i stranica dokumenta koja je
spremljena u profilu korisnika i koja se moze u svakome trenutku
promijeniti. Osim standardne stranice, mogu se izabrati i mnoge druge
predefinirane stranice, ovisno o potrebama korisnika.

Ako se zeli otvoriti nov prazan dokument standardnih postavki, odabere
se izbornik File > New ili tipkovni pre¢ac [Ctrl] + N, nakon ¢ega se
otvara novi dokument u drugome prozoru. Novi dokument moze se
izraditi i preko Command Bara tako da se odabere dugme za izradu
novoga dokumenta naziva Create new document from the default
template. Dugme za izradu novoga dokumenta prikazano je na donjoj
slici.

Q *MNew document 1 - Inkscape ]

File Edit View Layer Object Path Text Filters Extensions Help

DpE& Ak I HE Deld Qaaa

E Createnw.-'ducumentfrnmthedefaulttemplate(CtrI+N:|i 87088 [ ¥

b I . I T - ST T o S I O - I A P 1

1.3.2. Opcije dokumenta

Izmjena svojstava dokumenta kao Sto su veli€ina stranice (promjena
veli¢ine prema standardno ponudenim dimenzijama ili nekom
proizvoljnom veli€¢inom), zadana jedinica, orijentacija, prikaz rubova ili
neka druga opcija vezana za stranicu mijenja se u izborniku File >
Document Properties.
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@' Document Properties (Shift+Ctrl+D]) l = El éj

7| Document Properties (Shift+ Ctrl+D) = &®

Page | Guidesl Gridsl Snapl Colorl Scriptingl Metadatal License|

General
Default units: | px |Z|
Page Size
-
US Letter 85x1L0n =l
US Legal 85x1401in
US Executive 73%10,5in
Al 841,0 x1189,0 mm
Al 5940 x 41,0 mm
A2 420,0 x 594,0 mm
A3 297,0 x420,0 mm
AS 148.0 x 210.0 mm i
Urientation: @ Portrat () Landscape
Custom size

Width: | 210,00000 : Units:  |mm IZ|
Height: | 297,00000 =

Resize page to content...

Display
Show page border
[T] Border on top of drawing
Show border shadow
Use antialiasing
Background color: DeeTeTemaema"
Border color: INEEEGEG——

U ovome izborniku moze se odabrati veli¢ina stranice koja je na gore
prikazanome primjeru 210 x 297 mm (milimetra). Veli¢ina se moze
upisati ru¢no ili odabirom neke ponudene opcije u podruc¢ju Page Size,
oznacene crvenim okvirom na gore prikazanoj slici. Ako se veli¢ina
upisuje ru¢no, potrebno je upisati posebno Sirinu i posebno visinu ili se
moze odabrati Zeljena veli¢ina pomocu okretnoga dugmeta. Pod opcijom
Orientation moguce je na brz nacin promijeniti usmjerenje dokumenta u
okomito (Portrait) ili vodoravno (Landscape).

Osim veli¢ine dokumenta i orijentacije, pritiskom na padajuci izbornik
opcije Units odabire se i jedinica koja se Zeli koristiti, a koja ovisi 0
namjeni crteza na kojemu se radi. Tako se mogu odabrati pikseli ako se
izraduje neka grafika za web, ili in¢i, milimetri, centimetri, metri, ili neke
druge od ponudenih jedinica kao $to je i oznateno crvenim okvirom na
dolje prikazanoj slici, ako se radi neka grafika za tisak.
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Custom size
Width: |210,00000 : Unitst 'mm B
Height: | 297,00000 = pt
Resize page to content... cm
m
Display i
Show page border m
[] Border on top of drawing pe
Show border shadow px
Use antialiasing &
Background color DR RN e e

Border color: [N

Kada se zavrsi s osnovnim podeSavanjima dokumenta, moguce je
odabrati i napredne opcije stranice. Primjerice, stranica se moze
automatski podesiti po sadrzaju koji je nacrtan u programu tako da se
odabere naredba Resize page to content ili oznaka ,+“ nakon ¢ega se
otvara dodatni izbornik koiji je prikazan na donjoj slici.

Custom size
Width: | 29700000 : Units:  mm IEI
Height: | 210,00000 =
=l Resize page to content...
Tep margin: | 10,00000 =
Left: | 15,00000 = Right: |15,00000 =
Bottom: | 10,00000 =

Besize page to drawing or selection

Prije pritiska na dugme Resize page to drawing or selection moguce
je odabrati udaljenost od svake margine, tako da rubovi stranice nisu
,zalijepljeni“ na elemente ve¢ da postoji odredeni razmak. U gore
navedenome primjeru udaljenost od gornje i donje margine je 10 mm,
dok je od lijeve i desne 15 mm. Nakon podeSenih udaljenosti od
margina, odabere se dugme Resize page to drawing or selection.

Na kraju, pod opcijom Display - Show page border moguce je jos
ukljuditi ili isklju€iti prikaz ruba stranice.

1.4. Uporaba zumiranja, ravnala, pomicéne linije i
mreze

U ovome poglavlju obrazloZit ¢e se emu sluZi i kako se koristi zumiranje
u programu, te ¢e se navesti tipkovni pre€aci koji se pritom mogu
koristiti. Pojasnit ¢e se i uporaba ravnala i pomi¢ne linije koje se koriste
za to€no poravnavanje elemenata po dokumentu, kao i mreza koja
takoder moze olak3ati poravnavanje elemenata u programu. Prije nego
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se krene u opisivanje spomenutih naredaba, potrebno je znati kako se
moze kretati, tj. pomicati po platnhu. Jedan od nacina jest da se pritisne i
drzi tipka [Space] te se mi¢e miS u zelienome smjeru na platnu. Ako se
zeli pomicati po platnu samo lijevo ili desno pritisne se tipka [Shift] i
okrece se kotaci¢ miSa prema gore za pomicanije u lijevu stranu ili prema
dolje za pomicanje u desnu stranu.

1.4.1. Zumiranje

Postoji nekoliko nagina zumiranja u programu Inkscape, a najceS¢e
koristeni opisani su u nastavku.

Zumiranju se moze pristupiti preko izbornika View - Zoom gdje se
otvara podizbornik sa svim moguc¢nostima zumiranja, kao $to je
oznaceno crvenim okvirom na donjoj slici.

Naredba Zoom In (skracenica na tipkovnici [+]) sluZi za priblizavanje,
dok naredba Zoom Out (skrac¢enica na tipkovnici [-]) sluzi za
udaljavanje.

Zoom 1:1 prikazuje crtez u realnoj veli€ini u pikselima, a do ovoga
nacina prikaza moze se dodi i pritiskom na tipku [1] na tipkovnici. Zoom
1:2 prikazuje crtez u dvostruko manjoj dimenziji od realne (skracenica
na tipkovnici [2]), a Zoom 2:1 prikazuje crtez u dvostruko veéoj dimenziji
od realne.

Naredba Selection (skracenica na tipkovnici [3]) zumira selektirane
elemente preko cijeloga prozora, dok naredba Drawing (skracenica na
tipkovnici [4]) zumira sve postojeée elemente u programu tako da su svi
vidljivi odjednom. Naredba Page (skracenica na tipkovnici [5]) daje
kompletan pregled cjelokupne stranice, bez obzira na orijentaciju, a
naredba Page Width (skra¢enica na tipkovnici [6]) postavlja prikaz
stranice na Sirinu stranice.

Naredbe Previous Zoom i Next Zoom koriste se kao povijest zumiranja
pa se pomocu njih moze vracati na prethodna zumiranja i odabrati
sljedeca.

View Layer Object Path Text Filters Extensions Help
b Zoom * | & ZeomlIn + |
i Display mode | € Zoom Out - 1
o Lolor display mode N i
 Zooml:l 1
I Page Grid *1la Zoom 1:2 2 [
Guides | &} Zoom 2:1
Color-managed view
Selection 3
Show/Hide Q Disang 4
Fo Show/Hide Dialogs F12 @ Page E
1 Swatches... Shift+Ctrl+W | & Page Width 6
& Messages.. @) Previous Zoom
f@] Previous Window Shift+Ctrl+Tab | @) Mext Zoom Shift+*
A Next Window Ctrl+Tab
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Osim preko izbornika View, koristan nac¢in zumiranja slike je
pozicioniranje miSa na platnu, nakon ¢ega se pritisne i drzi tipka [Ctrl] te
se kotaci¢em misa priblizava ili udaljava slika. Ovaj nacin je najbrzi i
najefikasniji jer se gotovo istovremeno moze zumirati elemente i koristiti
neki drugi alat.

Zumiranje se moze izvesti i preko Toolboxa pomocu alata Zoom in or

out (Zoom) Q ili skra¢enicom [F3] na tipkovnici. Nakon odabira alata
Zoom in or out (Zoom) i pritiskom na lijevu tipku misa priblizavaju se
elementi na platnu, a pritiskom na desnu tipku mida mozZe se udaljavati
od elemenata na platnu. Na dolje prikazanoj slici prikazane su dodatne
opcije toga alata u Tool Controls Baru koje se prikazuju nakon odabira
alata Zoom in or out (Zoom). Tu su navedene iste mogucnosti kao i u
izborniku View > Zoom, samo 5to je preko ovih ikona moguce na brzi
nacin pristupiti odredenoj naredbi.

R a@aa @eaaaa aa

* 'illlllllll-\;l':.'-llllllllll-?:.'-lll|||||||-%:.'-||||||||||-

N
_f‘_.

@ 4
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U donjemu desnom kutu programa, nalazi se broj u postocima koji
oznacava na kojoj je razini zumiranja dokument. U taj se okvir moze
upisati Zeljeni postotak zumiranja te potvrditi naredbu tipkom [Enter].

1.4.2. Ravnala

Ravnala su smjestena na gornjoj i na lijevoj strani dokumenta, tako da
imamo vodoravno i okomito ravnalo kao $to je i prikazano crvenim
okvirom na donjoj slici.

IQ *New document 1 - Inkscape -_

Eile Edit View Layer Object Path Text Filters Extepsions Help
DBEEHE AR I BE I DD Qaa
PRI AR AR T APk
kl|5‘?|.|.v.|.|'5‘:F'|.|.|.|.|'25‘?|.|.|.

1
24
5
a1

»
]

L

0 3 e

oLl

@ srce .



Osnove rada s alatima za graficki dizajn (Inkscape, GIMP) (M100)

Ravnala su korisna za odredivanje to¢ne lokacije misa, a samim time i
elemenata na slici. Kada se mi$ nalazi na stranici, dva crna trokuti¢a
pojavljuju se na vodoravnoj i okomitoj osi ravnala koja oznaCavaju X i Y
koordinate koje imaju polazisne to¢ke na donjemu lijevom rubu stranice.
Prikazane su pokraj prikaza razine zumiranja u donjemu desnom kutu
programa.

Zadana vrijednost ravnala je u pikselima (skracenica ,px“), a moze se
promijeniti u izborniku File > Document Properties - Page - Display
units.

Ravnala se mogu prikazati ili sakriti na izborniku View - Show/Hide -
Rulers ili pomoéu tipkovnoga precaca [Ctrl]+[R].

1.4.3. Pomic¢ne linije

Pomicne linije (engl. Guides) su linije koje mogu biti smjestene u
dokument pod bilo kojim kutom, a korisne su za to¢no poravnavanje
elemenata na dokumentu.

Pomi¢ne linije mogu biti brzo izradene tako da se klikne i drzi lijeva tipka
misa na okomito ili vodoravno ravnalo te se povuce do Zeljene pozicije u
dokumentu i tamo se ispusti. Ako se pomi¢na linija povuée iz blizine kuta
gdje se spajaju dva ravnala, okomito i vodoravno, dobije se nako$ena
pomicna linija.

Na dolje prikazanoj slici nalaze se tri pomicne linije, okomita, vodoravna
i nakoSena. Po standardnim postavkama programa, pomicne linije su
plave boje, a kada se prijede miSem iznad njih ili ih se oznaci postanu
crvene boje, kao Sto je i oznaceno crvenim okvirom na dolje prikazanoj
slici. Oznagenu pomicnu liniju mozZe se obrisati tako da se pritisne tipka
[Delete] na tipkovnici.

T - T . e S T i I I A A o O

Cu:u:n-.l
1

Ako se zeli rotirati pomic¢na linija potrebno je do¢i misem iznad Zeljene
pomicne linije te pritisnuti i drzati tipku [Shift] na tipkovnici. Pokazivac
misa ¢e se promijeniti iz obi¢noga u rotirajuci oblik. Rotiranje se izvodi
tako da se klikne i drZi lijeva tipka miSa te se pomicna linija slobodno
okreée u Zeljenome smjeru. Pomiéna linija se moze rotirati i po 15
stupnjeva, a to se radi tako da se pritisne i drzi tipka [Ctrl] na tipkovnici
te se lijevom tipkom miSa okrece ograni¢eno, tj. po 15 stupnjeva u
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zeljenu stranu. Tockica koja se nalazi na pomi¢nim linijama oznacava os
oko koje ¢e se okretati odabrana pomi¢na linija.

Ako se dvostrukim klikom lijeve tipke mia klikne na neku pomiénu liniju,
otvara se dijaloski okvir Guideline, s dodatnim opcijama pomicnih linija,
koji je prikazan na donjoj slici. U verziji Inkscapea 2.10.10 moguce je u
dodatnome izborniku promijeniti i boju pomiénih linija. Da bi se to u€inilo,
potrebno je kliknuti na dugme s bojom, nakon &ega se otvara jo$ jedan
dijaloski okvir Pick a Color u kojemu se moze odabrati Zeljena boja
odabirom na kotacu boja, direktnim upisivanjem vrijednosti u polje HSV,
RGB ili Color name (Sto znaci heksadecimalni kdd boje). Nakon odabira
boje na bilo koji nagin, pritisne se na dugme OK.

Osim boje, u dijaloSkome izborniku Guideline moguce je postaviti i
oznaku tj. ime na pomiénu liniju. Potrebno je samo upisati u polje Label
ime koje se Zeli zadati za tu pomic¢nu liniju. Na dolje prikazanoj slici
stavljeno je ime ,Gornja margina®“.

@ Guideline e |

Guideline ID: guidet150
Current: herizontal, at 917.99 px

Label: | Gornja marginal

% 183,598 gl [+
¥: (917,990 =
angle 0000 3 ° [~]
Relative change
| ok || Deete || Concel |

A\

Moguce je i pomicati pomi¢nu liniju na tocno odredeni dio dokumenta po
Xili Y osi, tako da se upiSe konkretna vrijednost u pikselima u polje X: ili
Y:, ovisno o orijentaciji pomi¢ne linije. Linija se moZe postaviti i na tocno
odredeni kut kojeg se upisuje ili odabire pomocu okretnoga dugmeta u
polju Angle.

Ako se oznaci moguénost Relative change, X i Y osi postavljaju se na
vrijednost 0 te se pozicioniranje pomic¢ne linije, tj. daljnji upis vrijednosti,
racuna od trenutne pozicije. Na primjer ako se odabere vodoravha
pomi¢na linija, uklju€i opcija Relative change i upiSe 100 px u polje Y,
pomicna linija ¢e se pomaknuti za 100 px od trenutacne pozicije, za
razliku od situacije u kojoj bi bila isklju¢ena mogucnost Relative change
— tada bi se pomicna linija pomaknula na 100 px dokumenta.

Na kraju se moze birati izmedu tri dugmeta, OK za potvrdu, Delete za
brisanje pomicne linije i Cancel za odustajanje.
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1.4.4. Mreza

Umijesto da se koristi mnogo pomicnih linija, moze se ukljuciti korisna
opcija Grids (mreza). UkljuCuje se preko izbornika View > Page Grid ili
preko tipkovnoga precaca [Shift] + [3].

Postoje dvije vrste mreza, pravokutna (rectangular) i aksonometrijska
(axonometric). Za odabir zeljene mreze potrebno je otvoriti dijaloski okvir
File > Document Properties = Grids koji je prikazan na donjoj slici.
NajceS¢e koriStena mreza ima pravokutni oblik te je stvorena od
okomitih i vodoravnih linija. Aksonometrijska mreza omogucuje
korisnicima definirati mrezu pod bilo kojim kutom $to moze biti korisno
za tehnicka ili arhitektonska crtanja.

Q Document Properties (Shift+Ctrl+D) = [E £

(7] Document Properties (Shift+Ctrl+D) H ®

Pagel Guides| Grids
Creation

Rectangular grid EH MNew ]

Snapl Colorl Scriptingl Metadatal License|

Defined grids
it grid4156

Enabled
Visible
Snap te visible grid lines only

Rectangular grid

Grid units: | px E|

QOrigin X | 0,00000
Origin ¥ | 0,00000
Spacing X 1,00000

L1 RN e KN IRl I

Spacing ¥: | 1,00000
Minar grid line color: MERTRISCRTST N

Major grid line color: [RERTRTRTRTET ING—
Major grid line every: |5

-

[ Show dots instead of lines

’ Remove ]

Na samome vrhu, pod opcijom Creation, moguce je u padaju¢emu
izborniku odabrati vrstu mreze te ju potvrditi klikom na dugme New.
Moguce je stvoriti viSe mreza koje ¢e biti istovremeno vidljive, a od kojih
Ce svaka biti u zasebnoj kartici i kao takvu moguce ju je uciniti vidljivom
ili nevidljivom, uklju€ivanjem ili isklju€ivanjem opcije Visible. Takoder je
moguce i onemoguciti neku od mreza odabirom opcije Enabled.

Umijesto piksela moguce je odabrati i neku drugu jedinicu ovisno o
potrebi, odabirom na opciju Grid units. Origin X i Origin Y sluze za
poravnavanje mreze na neku pocetnu to¢ku, dok opcije Spacing X i
Spacing Y sluze za postavljanje razmaka izmedu linija. Boja linije mreze
moze se odabrati pod opcijom Minor grid line color i Major grid line
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color kao i opcija kojom se odreduje nakon koliko linija e se pojaviti
malo deblja linija, Major grid line every.

Uklju€ivanjem opcije Show dots instead of lines prikazuju se tockice
umjesto linija (opcija ne vrijedi za aksonometrijsku mrezu) &to se moze i
zakljuciti iz imena naredbe.

Na kraju je moguce obrisati kompletnu karticu odabrane mreze pritiskom
dugmeta Remove.

1.5. Otvaranjei spremanje slika

Ako se zeli spremiti crtez, tj. dokument u izvorni format programa
Inkscape, otvoriti dokument u izvornome formatu, uvesti ili izvesti slika u
nekom drugom formatu, potrebno se pridrzavati nekih pravila koja su
odredena u programu.

1.5.1. Spremanje crteza ili dokumenta

Postoji nekoliko metoda pomocu kojih se moze spremiti dokument, a do
svih dolazimo preko izbornika File.

Naredba Save sprema postojec¢i dokument uzimajudéi isto ime datoteke.
Ako je dokument novi, tj. jo§ do sada nije nikad bio spremljen, otvorit ¢e
se dijaloski okvir u kojemu ¢&e biti potrebno upisati ime dokumenta i
lokaciju na koju se zeli spremiti. Do ove naredbe moguce je doci preko
izbornika File > Save, tipkovnim preCacem [Ctrl] + [S] ili pritiskom na
dugme, tj. ikonicu Save document u Commands Baru.

Naredba Save as sprema novu kopiju dokumenta pod drugim imenom,
a taj novi spremljeni dokument automatski postaje radni dokument, tako
da ¢e svaka buduca promjena ili spremanije biti primijenjeni na doti¢ni
dokument. Ova je opcija korisna za spremanje dokumenta po verzijama,
a do naredbe se dolazi preko izbornika File - Save as ili kombinacijom
tipki [Ctrl] + [Shift] + [S] na tipkovnici.

Naredba Save a Copy sprema identi¢nu kopiju trenutnoga dokumenta,
ali pod drugim imenom na lokaciji koja se odabere. Ovako spremljena
kopija odvojena je od trenutnoga dokumenta na kojemu se radi, Sto
znadi da se nastavlja raditi na starome dokumentu. Ovu opciju je takoder
dobro koristiti ako se Zele spremati meduverzije nekoga dokumenta. Do
naredbe se dolazi preko izbornika File > Save a Copy ili tipkovnim
precacem [Ctrl] + [Shift] + [Alt] + [S].

Ako se radi na novome dokumentu, odabirom bilo koje od gore
navedenih naredaba, otvara se dijaloski okvir Select file to save to,
prikazan na donjoj slici.
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7 S
@ Select file to save to &J

Spremi u: . Ogledne slike - G T ¥ [~

5
Medavna mjesta
| 2
-

radna povréina -
Primjer.svg

u=pi!
Biblioteke

L

=

Racunalo

@

Mreia

MNaziv datoteke: drawing]| - Spremi

Spremi u obliku: l\nkscape SVG (“sva) v] l Odustani I

Title:

U tome dijaloSkom okviru potrebno je upisati ime datoteke i odabrati
format u koji se zeli spremiti crtez. Nakon odabira pritisne se dugme
Spremi.

1.5.2. Formati

SVG je kratica engleskoga naziva Scalable Vector Graphics. SVG je
zamisljen kao otvoreni standard, a baza mu je XML (eXtensible Markup
Language) koiji jest takoder otvoreni standard. Najvaznija karakteristika
SVG formata je njegova skalabilnost, $to znacdi da je moguce proizvoljno
smanijivati ili poveéavati dokument bez gubitka kvalitete. XML osnova
donosi i nekoliko znacajnih prednosti SVG-u kao $to su moguénost
pretrazivanja, komprimiranja, animacije i relativho jednostavnoga
uredivanja.

Maziv datoteke: Primjer_1 -
Spremi u oblilu: Inkscape SVG (".sva) - Odustani
Title: Plain SVG (*sva)

Compressed Inkscape SVG ("svgz)
[ Compressed plain SVG (* svgz)
Portable Documert Format (*pdf)
Cairo PNG (" png)

PostScript {*ps)

Encapsulated Post Script (*.eps)
Enhanced Metafie (*.emf)
Windows Metafile (*wmf)

U nastavku ¢e se opisati najéeSce koristeni formati koji su prikazani na
gornjoj slici, na padaju¢emu izborniku koji sluzi za odabir formata u
kojemu se zeli spremiti dokument.

Inkscape SVG je izvorni oblik datoteke koji se koristi u programu
Inkscape. Sadrzi neke dodatne opcije za razliku od obi¢noga SVG
formata. Prilikom izrade crteza u programu Inkscape preporuca se
koristiti ovaj format.

Plain SVG je standardna SVG-datoteka, ali bez nekih specifi¢nih
obiljezja koje ima Inkscape SVG. Plain SVG se koristi ako se Zeli postiéi
najbolja moguca kompatibilnost s nekim drugim aplikacijama u kojima ¢e
se otvarati ta datoteka.
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SVGZ je komprimirana SVG-datoteka. Ova je vrsta datoteke daleko
manja, $to omoguéuje znatno brze preuzimanje ili prijenos putem
Interneta. Inkscape moze spremiti u SVGZ-dokument u oba formata,
Compressed Inkscape svg i Compressed Plain svg.

PDF format je izradila tvrtka Adobe kao format za razmjenu datoteka.
PDF dokumenti mogu sadrzavati bilo kakvu mjeSavinu teksta, fontova,
slika i vektora, a prikazom pomocu razli€itih programa, na razli€itim
operacijskim sustavima i hardverskim platformama zadrzati e jednako
oblikovanje, prikaz i svojstva.

PNG je otvoreni graficki rasterski format namijenjen pohrani ili
streamingu nepokretnih slika bez gubitaka, podrZava prozirnost, a
nastao je kao zamjena za GIF. PNG format je zami$ljen kao graficki
format za razmjenu preko Interneta, tako da ne koristi neke druge
sustave boja kao sto je CMYK. PNG datoteke u pravilu uvijek imaju
ekstenziju PNG ili png.

U PNG se moze izvesti i preko izbornika File > Export PNG Image,
nakon €ega se otvori dijaloSki okvir Export PNG Image, prikazan na
donijoj slici.

| Export PNG Image (Shift+Ctrl+E) = |
Export area
| Page |[ Drawing ]| Selection ” Custom
0 -159813 y0: 625,000 -
L 391,441 = yl: 782,585 |-
Width: 1989574~  Height 157,585 -
Units: | px E|
Image size
Width: 1326 [~ pixelsat (60,00 = dpi
Height: |105 = pixelsat 6000 = dpi
Filename
idkendel\Desktopirect4136.png Export As...
Batch export 2 selected objects
Hide all except selected
Close when complete Q:j;: Export

U njemu je moguce odabrati razne opcije o tome kako ¢e se izvesti slika.
Pritiskom na jedno od prva €etiri dugmeta, Page, Drawing, Selection i
Custom, odabire se $to se Zeli izvesti — cijela stranica, samo crtez,
odabrani dio ili nesto proizvoljno. Takoder se moze izvesti slika
proizvoljne kvalitete pod opcijom Image size, na nacin da se upise
koliko Ce slika imati dpi-a (engl. dots per inch). Mjesto spremanja
odabire se pritiskom dugmeta Export As i na kraju se odabere dugme
Export za izradu konacne slike u PNG-formatu.

Zanimljivosti i napomene

DPI je skracenica od dots
per inch (engl.), tj. broj
to¢aka po incu.
Preporucena rezolucija slika
koriStenih u pripremi za
tisak je 300 ppi za
fotografije, 600 ppi za
jednobojne ilustracije i 72
ppi za ekranski prikaz.

Zanimljivosti i napomene

Batch export selected
objects je korisna opcija
koja odvaja selektirane
elemente u zasebne slike.
Na primjer, ako su
oznacena Cetiri elementa i
ako je uklju¢ena ova opcija,
izvest Ce se Cetiri zasebne
PNG slike. Potrebno je prije
ovoga postupka spremiti
SVG datoteku jer se u ovoj
vrsti izvoza ne odabire
mjesto spremanja vec se
slike spremaju na mjesto
gdje je i spremljena SVG
datoteka.
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1.5.3. Otvaranje slika

Cesto je potrebno otvoriti ve¢ spremljeni SVG-dokument radi izmjene,
uzimanja nekih dijelova dokumenta, kopiranja u neki drugi dokument,
izvoza dokumenta u neki drugi format ili neCega drugog.

Postoji nekoliko nadina za otvaranje veé postojec¢ega dokumenta, a
svima se pristupa preko izbornika File. Naredba Open otvara datoteku u
potpuno novome prozoru gdje se potom moze izmjenijivati i raditi na njoj
neovisno o trenutno otvorenome dokumentu. Moguce je otvoriti datoteku
i preko tipkovnoga prec€aca [Ctrl] + [O] ili preko ikone Open an existing
document u Commands Baru.

Kada se odabere naredba Open na bilo koji od opisanih nacina, otvorit
Ce se dijaloSki okvir Select file to open, prikazan na donjoj slici. U
njemu se odabere mapa u kojoj je smjestena datoteka ili slika koja se
Zeli otvoriti, odabere se Zeljena datoteka i pritisne se dugme Open. BrzZi
nacin bi bio da se zeljenu datoteku odabere dvostrukim klikom, nakon
¢ega se ona otvara u novome prozoru.

N
4 Select file to open )
Pogledsiu: | Ogledne sike - @ Er

BT
Nedavna mjesta ol
0\ -

radna povriina

drawing.svg Hortenzija.jpg Koala.jpg Krizantema,jpg |-

J
757kB
Blbllcteke 1024 x 768
e - m

Meduza.jpg Pingvini.jpg Primjer.svg Primjer_l.svg

Mreza

Naziv datoteke:  Jelyfish pg - Otvor
Viste datoteka: (Al Fies v] [ Odustani |

Osim otvaranja dokumenta pomocu naredbe Open, sliku ili dokument
moguce je uvesti i naredbom Import. Na ovaj na¢in moguce je uvesti
neku sliku ili SVG-dokument u trenutno aktivni dokument, tj. u dokument
na kojemu se radi. Uvezene datoteke postaju elementi u ve¢
otvorenome dokumentu te se dalje s njima moze manipulirati.

Slika se moze uvesti preko izbornika File > Import, tipkovnim pre€acem
[Ctrl] + [1] ili klikom na ikonu Import a bitmap or SVG image into this
document na Commands Baru. Nakon odabira naredbe otvara se
dijaloski okvir Select file to import preko kojega se slika ubacuje na
jednak nacin kao i kod otvaranja slike preko izbornika Select file to
open.
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1.6. Vjezba: Upoznavanje radnoga prostora

1.

Izradite praznu stranicu dimenzije 272 x 385 mm (D3),
vodoravnoga usmjerenja.

Postavite prvu vodoravnu pomicnu liniju, zelene boje na
koordinate X = 0 px, Y = 480 px, kuta 0 stupnjeva naziva
"Gornja zelena".

Postavite drugu pomicnu liniju, crvene boje, relativho
odmaknutu od prve za -100 px po Y osi, kuta 0
stupnjeva.

Treéu pomiénu liniju postavite na koordinate X =0 pxiY
= 380 px pod kutom od 4,1 stupan;.

Stvorite kvadratnu mrezu, razmaka 2 cm po X osii 3 cm
po Y osi te ukljucite opciju da se prikazuju tocke umjesto
linija.

Zumirajte dokument na Sirinu stranice.

Spremite crtez u Inkscape SVG (*.svg) naziva
Podesene_linije.
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2. Osnovni grafi€ki objekti i njihove
opcije

Po zavrsetku ovoga poglavija moci cete:
e jzraditi osnovne graficke objekte
e koristiti alate za prostoruc¢no crtanje
e grupirati i oznadavati objekte
e jzabrati odredenu boju i njome se koristiti.

Program Inkscape nudi mnogo alata za crtanje geometrijskih oblika
poput kvadrata, pravokutnika, elipsa, poligona, zvijezda i spirala. Osim
tih standardnih oblika moguce je crtati i prostoru¢ne putanje pomocu
alata kao $to je olovka, kist ili pomocu Bezierovih krivulja.

2.1. Stvaranje osnovnih grafickih objekata

Stil svakoga objekta uklju€uje svojstva koja odreduju kako ¢e taj objekt
izgledati, tj. koje boje ispune (engl. fill) i kakve boje ili debljine e biti
obrub (engl. stroke). Stilovi mogu ukljuivati i neka specificna svojstva
poput broja to¢aka u zvijezdi, zaobljenost, veli€inu ili drugo.

Novi objekti crtaju se predefiniranim stilom, a kada se nacrtaju mogu se
mijenjati u dijaloSkome okviru Fill and Stroke (Object - Fill and
Stroke).

2.1.1. Pravokutnici i kvadrati

Crtanje pravokutnika ili kvadrata omogucuje alat Create rectangles and

squares (Rectangle) L] , koji se nalazi u Toolboxu, a moze se odabrati
i preko tipkovnice, pritiskom na tipku [F4] ili [R].

Za crtanje pravokutnoga oblika potrebno je odabrati alat Create

rectangles and squares (Rectangle) L] , pomaknuti mi$ do Zeljenoga
mjesta na platnu gdje se zeli izraditi na primjer pravokutnik te drzati
lijevu tipku miSa i povlaciti mi$ u Zzeljenome smjeru. Kada su veli€ina i
oblik zadovoljavajuéi, pusti se lijeva tipka misa te se dobije pravokutnik
sli¢an onome na dolje prikazanoj slici.

@ srce #



Osnove rada s alatima za graficki dizajn (Inkscape, GIMP) (M100)

Na gornjoj slici prikazano je:

1. Kvadrati¢ za podeSavanje veliine.
2. Krug za podeSavanje radijusa.

Uz drzanje tipke [Ctrl] na tipkovnici prilikom crtanja pomoéu ovoga alata

moguce je izraditi kvadrat ili nacrtati objekt koji je u omjeru zlatnog reza,
a drzanje tipke [Shift] omogucuje crtanje objekta oko pocetne tocke, sto

znaci da ¢e se pravokutni oblik crtati oko tocke na koju se prvo kliknulo u
programu.

Ako se zeli promijeniti radijus objekta, tj. napraviti zaobljene rubove,
potrebno je kliknuti i drzati lijevu tipku miSa na krug (koji je oznacen
brojem 2 na prethodnoj slici) te se kretati u Zeljenome smjeru. Drugi
nacin je takoder preko Controls Bara upisati broj¢anu vrijednost radijusa
u polje Rx ili Ry.

Ako se Zeli nacrtanome objektu promijeniti veli€¢ina, moguce je to izvesti
na dva nacina. Prvi je da se miSem dode do objekta (alat moramo imati
u ruci) te pritisne i drzi lijevom tipkom miSa na kvadrati¢ (oznaCen brojem
1 na gornjoj slici), kvadrati¢ promijeni boju, nakon ¢ega se moguce
kretati u Zeljenome smjeru, odnosno povecavati ili smanjivati objekt.
Kada se zavrsi, samo se pusti lijeva tipka misa.

o . Drugi nacin je da se veli¢ina izmijeni u Controls Baru, oznaCenim
Zanimljivosti i napomene

crvenim okvirom na dolje prikazanoj slici. To se radi tako da se upiSu
Tredi nacin da se izmijeni Zeljene broj¢ane vrijednosti u polje W (engl. Width), $to ozna¢ava Sirinu
veli¢ina objekta je odabirom objekta, i polje H (engl. Height), Sto ozna¢ava visinu objekta.

Selector alata. Takoder se

upiSu zeljene brojéane
vrijednosti u polje Width i

Fill:

Change: fw: 270,000 H: 1400005 JRe 0000 ) Relooo0 Fpx [¢]| TR e o

Height kao i u Controls
Baru.

Kada se Zeli rotirati ili iskositi neki objekt, to se mozZe izvesti na dva
nacina, preko alata Select and transform objects (Selector) ili
izbornika Transform. Prvi naCin je da se odabere alat Select and
transform objects (Selector) s kojim se svaki objekt u programu moze
oznaditi te se dva puta (s pauzom) klikne na objekt, nakon ¢ega ¢e se
oko objekta pojaviti rotirajuce strelice, kao Sto je prikazano na donjoj
slici.

----------------------------------------------------
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Na gornjoj slici prikazano je:

1. Rotirajucéa strelica koja se nalazi u svakome kutu objekta, a sluzi
za rotiranje toga objekta.

2. Strelica koja sluZi za vodoravno iskrivijenje objekta, nalazi se na
dva mjesta, na gornjoj strani objekta i na donjoj strani objekta i
jednakoga je oblika.

3. Krizi¢ koji oznaava centar rotacije i oko njega ¢e se objekt
rotirati.

4. Strelica koja sluzi za okomito iskrivljenje objekta, takoder se
nalazi na lijevoj i desnoj strani objekta.

Za slobodno rotiranje objekta potrebno je do¢i miSem na bilo koji kut
objekta na rotirajuce strelice, pritisnuti i drzati lijevu tipku miSa te objekt
okrenuti u Zeljenome smjeru. Za rotaciju objekta samo po 15 stupnjeva,
potrebno je ponoviti gore navedeni postupak uz drzanje tipke [Ctrl]. Ako
se drzi tipka [Shift], objekt e se rotirati oko suprotnoga kuta.

Za promjenu osi rotacije potrebno je doéi do krizi¢a koji se po
standardnim postavkama nalazi uvijek u sredini objekta (oznacen s
brojem 3 na gornjoj slici) te pritisnuti i drzati lijevu tipku miSa i pomaknuti
krizi¢ na Zeljenu poziciju. Kada je krizi¢ na zeljenoj poziciji potrebno je
pustiti lijevu tipku miSa. Nakon toga, objekt ¢e se rotirati oko novo
postavljene osi rotacije, tj. oko trenutno postavljenoga krizi¢a. Za
vracanje kriZi¢a, tj. osi rotacije, natrag na centar objekta potrebno je
pritisnuti i drzati tipku [Shift] na tipkovnici i kliknuti lijevom tipkom miSa na
krizi¢, nakon €ega se kriZi¢ automatski vraca u sredinu objekta.

Za vodoravno iskrivljenje objekta, potrebno je doéi do bilo koje strelice
za vodoravno iskrivljenje, pritisnuti i drzati lijevu tipku miSa i micati misS u
lijevu ili desnu stranu. Kada je oblik zadovoljavajuéi, pusti se lijeva tipka
misa. Za okomito iskrivljenje objekta potrebno je doci do bilo koje strelice
za okomito iskrivljenje, pritisnuti i drzati lijevu tipku misa i micati mis gore
ili dolje. Kada je iskrivljenje zadovoljavajuce, pusti se lijeva tipka misa.

Drugi nacin je preko izbornika Object > Transform, prikazanoga na
donijoj slici, do kojega se moze doéi i preko tipkovne kratice [Shift] +
[Ctrl] + [M].

" Transform (Shift+Ctrl+M) [«

Move | Scale| Botate | Skew | Matrix

¥ Angle 45000 3 0 [7][d] 2

Apply to each object separately

‘ Clear H Apply |

Za rotiranje objekta potrebno je prvo oznaditi objekt kojega se Zeli rotirati
te u izborniku Object - Transform - Rotate upisati pod opcijom Angle
kut pod kojim se Zeli rotirati objekt. Iz padajuéeg izbornika moguce je i
odabrati u kojim jedinicama se Zeli primijeniti okretanje, a u nastavku je
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moguce odabrati i smjer vrtnje, u smjeru kazaljke na satu ili suprotno od
smjera kazaljke na satu. Nakon upisane vrijednosti, moguce je pritisnuti
na dva dugmeta — Clear, $to ozna¢ava da se sve upisano i podeSeno
bride, ili Apply, €ime se primjenjuju zadane postavke.

Za iskrivljenje objekta potrebno je odabrati karticu Skew u istome
izborniku Transform. Na toj kartici moguce je upisati Zeljenu vrijednost
iskrivljenja ovisno o orijentaciji, Horizontal (vodoravno) ili Vertical
(okomito). Kada se upiSe zeljena vrijednost, odabere se dugme Apply
za primjenu ili Clear za brisanje i vra¢anje na pocCetne postavke.

Svi objekti se rotiraju na isti nacin tako da nije potrebno posebno
opisivati rotaciju za svaki pojedini objekt.

2.1.2. Elipse, krugovi i lukovi

Pomocu alata Create circles, ellipses, and arcs (Ellipse) O kojega
se moze odabrati u Toolboxu moguce je crtati elipse, krugove i lukove.
Do njega se moZe doéi i preko tipkovnoga pre€aca [F5] ili [E].

Za crtanje bilo kakvoga kruznog oblika ili lukova u njima, potrebno je

odabrati alat Create circles, ellipses, and arcs (Ellipse) O te doci
miSem na podrucje gdje se zeli izraditi kruzni oblik, pritisnuti i drZati
lijevu tipku misa te povlaciti u zelienome smjeru. Pojavljivat ¢e se kruzni
oblik u kvadratnoj isprekidanoj kutiji koja ozna¢ava pocetnu i zavrSnu
to¢ku povlagenja. Kada je oblik zadovoljavaju¢e dimenzije i oblika, pusti
se lijeva tipka misa.

Drzanjem tipke [Ctrl] na tipkovnici prilikom crtanja ovim alatom moguce
je izraditi krug, tj. da su mu visina i Sirina jednake, a drZzanjem tipke
[Shift] omoguéuje se crtanje objekta oko pocetne to¢ke Sto znadi da ce
se kruzni oblik crtati oko tocke na koju se prvo kliknulo na platnu.

Na donjoj slici prikazani su krug i elipsa, a oznake oznacavaju:

1. Kvadrati¢ za podeSavanje veli€ine.
2. Krug za stvaranje luka.

3. Kvadratna isprekidana kutija koja oznaCava poc€etnu i zavrSnu
toCku povlacenja.
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Osim crtanja krugova i elipsa moguce je od ve¢ nacrtanih takvih
objekata izraditi i lukove. Za crtanje zatvorenoga luka (kruzni isjecak), tj.

ako se Zeli da graf izgled kruga izgleda kao ,pita“, potrebno je pritisnuti

ljevom tipkom miSa na krug za izradu luka (oznacen brojem 2 na gornjoj
slici) i povladiti mi$ izvan toga objekta u Zeljenome smjeru. Kada je
objekt zadovoljavajuéega oblika pusti se lijeva tipka misa. Ako je

potrebno doraditi objekt, ponovi se opisani postupak. Na kraju se moze

dobiti izgled poput prikazanoga na donjoj slici.

A ako se miSem povlaci unutar objekta prema gore opisanome
postupku, isti objekt koji je prikazan na gornjoj slici, izgledat ¢e kao na

dolje prikazanoj slici (kruzni odsjec¢ak).

Pomodu tipke [Ctrl] moguce je pomicati radijus, tj. kut po 15 stupnjeva. U
Controls Baru moguce je odrediti kakav luk se Zeli izraditi, tzv. zatvoreni
ili otvoreni ili se moze resetirati stanje na poc¢etno tj. ukloniti lukove $to je
i oznaceno crvenim okvirom na dolje prikazanoj slici.

Change: Start (0,000 [+ End: 224,269 % I IS C’DI

Fill:
Stroke: None

2.1.3. Pravilni mnogokut i zvijezde

Pomocu alata Create stars and polygons (Star)

&

, koji se nalazi u

izborniku Toolbox, moguce je izraditi pravilne mnogokute ili zvijezde.
Alat se moze odabrati i tipkovnim pre¢acem [Shift] + [F9] ili [*].

Za crtanje mnogokuta, nakon odabira naredbe Create stars and

polygons (Star) 5 , potrebno je odabrati na Controls Baru opciju
Regular polygon, oznaceno brojem 1 na donjoj slici.
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-

Fill:

. E . = Spoke ratio: (0357 F : =
|Change. @L‘}' Corners: |5 = Spoke ratio: | 0,35 . Rounded: 0,000 = W ciroke: NGTe

Na gornjoj slici prikazane su opcije:

1. Regular polygon za crtanje mnogokuta.
2. Star instead of aregular polygon za crtanje zvijezda.

Nakon odabira, u istoj traci moguce je odabrati koliko kutova ¢ée imati
mnogokut, pod opcijom Corners. Za crtanje mnogokuta potrebno je
pritisnuti lijevu tipku miSa na mjestu gdje se Zeli stvoriti mnogokut te
povlaciti mi$ u zeljenome smjeru. Nakon dobivanja zadovoljavaju¢ega
oblika, pusti se lijeva tipka misa.

Za crtanje zvijezde, ponovi se isti postupak kao Sto je opisan za izradu
mnogokuta, samo se odabere opcija Star instead of a regular
polygon, oznadena brojem 2 na gornjoj slici. Na svakome od tih
objekata moguce je naknadno mijenjati oblik, veli¢inu, boju, itd.

Na dolje prikazanoj slici moze se vidjeti kako je mogu¢e mnogokut
pretvoriti u zvijezdu i obrnuto, koriste¢i samo kvadrati¢ za promjenu
radijusa koji je opisan kod svih prethodnih elemenata, a jednaku funkciju
ima i kod ovih objekata.

2.2. Prostoruéno crtanje i koriStenje Bézierovih
krivulja

Linije koje su izradene u programu Inkscape su zapravo zaobljeni
objekti. Linije mogu biti otvorene (znaci da imaju dva otvorena kraja) ili
zatvorene (nemaju kraj). Mogu jo$ biti i kombinirane (sastavljene od
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odvojenih otvorenih i zatvorenih linija). Kombinirane linije stvaraju se
tako da se oznaci vise odvojenih linija i odabere naredba Combine na
izborniku Path ili preko tipkovnoga pre¢aca [Ctrl] + [K]. Linije se prije
ovoga kombiniranja moraju pretvoriti u putanje (Path > Object to Path).
Ako se kombinirana linija Zeli pretvoriti opet u zasebne linije, oznaci se
kombinirana linija i odabere naredba Break Apart iz izbornika Path. Na
donijoj slici prikazana je s lijeve strane otvorena linija, u sredini je prikaz
zatvorene linije i na krajnjoj desnoj strani je prikazana kombinirana linija.

TN /\/

2.2.1. Bézierove krivulje

Bézierove krivulje koriste se za crtanje nepravilnih oblika kao i za
manipulaciju nad crtezima jer mogu mijenjati svoj oblik po nekim
predodredenim matemati¢kim principima. Bézierove krivulje definirane
su s najviSe Cetiri to¢ke, dvije od njih su zavrSne tocke (oznacene brojem
1 na dolje prikazanoj slici) dok su preostale dvije kontrolne tocke
(oznacene brojem 2 na dolje prikazanoj slici, u nekim slu¢ajevima moze
biti samo jedna kontrolna tocka ili nijedna). Kontrolne toCke korisne su
za naknadno prepravljanje krivulja kao i prepravljanje krivulja prilikom
njihove izrade.

Na gornjoj slici prikazana je krivulja s dvije kontrolne tocke:

1. ZavrSne tocke krivulje ili Evorovi (Nodes).
2. Kontrolne tocke krivulje.

Linije mogu biti izradene pomocu alata Z@ Draw freehand lines

(Pencil) — prostoru¢no crtanje, Draw Bezier curves and straight

lines (Pen) — crtanje Bézierovih krivulja i Draw calligraphic or
brush strokes (Callygraphy) — za pisanje kaligrafskom tehnikom.
Putanje, tj. linije se mogu izraditi i pretvorbom nekog regularnoga oblika
poput kvadrata, pravokutnika, kruga, tekstnoga objekta u linije, itd.
Putanje su u pravilu obiéne Bézierove krivulje bez nekih dodatnih opcija
editiranja kao $to ih imaju objekti ili neki sloZeniji elementi.
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Pomocu Bézierove krivulje (alat Draw Bezier curves and straight lines
(Pen)) mogu se puno izravnije kontrolirati parametri neke linije. Za
crtanje Bézierovih krivulja prvo je potrebno odabrati alat Draw Bezier

curves and straight lines (Pen) i? , koji se moze odabrati preko
izbornika Toolbox ili preko tipkovne kratice odabirom [Shift] + [F6] ili
samo slova [B]. Ako se Zeli nacrtati obi¢na ravna linija ovim alatom,
potrebno je pritisnuti lijevom tipkom miSa bilo gdje na platnu, povudi liniju
u zeljienom smjeru i nakon toga pritisnuti opet lijevu tipku misa. Nakon
toga moze se nastaviti crtati dodatna linija koja je spojena s prethodnom
ili se pomocéu desne tipke miSa potvrdi novonastala linija.

Kada je alat odabran, klikne se i drzi lijeva tipka misa na podrucju gdje
se zeli izraditi neka linija. To¢ka na koju se prvo kliknulo postaje
pocetnom tockom krivulje. Kako se pomice kursor tako se moze vidjeti
plava linija izmedu pocetne to¢ke i kursora mida — to je tangenta krivulje,
prikazana na donjoj slici.

Otpustanjem lijeve tipke miSa uspostavlja se prva kontrolna toc¢ka.
Kursor miSa potrebno je pomicati na sljedecu poziciju Bézierove krivulje,
na tzv. zavrsnu to¢ku. Prilikom pomicanja miSa, pojavit Ce se crvena
linija koja oznaCava oblik krivulje, prikazane na donjoj slici.

a

Kada se dode do mjesta gdje se Zeli postaviti druga tocka, klikne se i
drzi lijeva tipka miSa ako se Zeli odmah i prepraviti krivulja, a ako je
krivulja zadovoljavaju¢ega oblika samo se klikne na Zeljeno mjesto na
kojemu ce se stvoriti druga tocka krivulje. Kada se Zeli stvoriti krivulja
pritisne se tipka [Enter] ili desna tipka miSa. Na dolje prikazanoj slici
nalazi se krivulja stvorena s dvije kontrolne tocke.
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Krivulja se mozZe i naknadno uredivati, mijenjati oblik, pomicati, stvarati
dodatne kontrolne tocke pomocu alata Edit paths by nodes (Node)

F_.,.-El

, koji se nalazi u Toolboxu, i koja ¢e biti opSirnije objadnjena u
sljede¢em poglavlju.

2.2.2. Prostoruéno crtanje

Pomocu alata Draw freehand lines (Pencil) moguce je na najlaksi nacin

crtati proizvoljne, slobodne linije. Alat Draw freehand lines (Pencil) Z@
odabere se u Toolboxu ili pomoc¢u skraéenice na tipkovnici [F6] ili [P] te
se postavi lijeva tipka miSa na zeljeno podrucje. Kako se klikne i pomice
mi$ po platnu tako se i iscrtava linija. Sve dok se drzi pritisnuta lijeva
tipka misa i mi§ se mic¢e po prostoru, alat ostavlja liniju, a za prestanak
crtanja otpusti se lijeva tipka misa.

Za brisanje pogresne ili nedovrsene linije moze se pritisnuti kombinacija
tipki [Ctrl] + [Z] na tipkovnici ili se vratiti korak natrag preko izbornika Edit
- Undo.

Oblici koji su nacrtani ovim alatom sastavljeni su od mnogo Bézierovih
krivulja. Svaki od tih oblika moze se i pojednostaviti, $to znaci da ¢e
imati manje ¢vorova i da Ce biti gladega oblika. Oblik se moze ugladiti
tako da ga se oznaci i nakon toga odabere naredba Simplify u izborniku
Path ili preko tipkovne kratice [Ctrl] + [L]. Na donjoj slici, s lijeva na
desno, prikazan je isti oblik, ali sve viSe pojednostavljen. Tako krajnje
lijevi oblik nije pojednostavljen, srednji je jedan put, a desni viSe puta. Da
bismo vidjeli ovo zagladivanje, potrebno je odabrati alat Node.

Kada je odabran ovaj alat, u izborniku Tools Controls, prikazanome dolje
na slici, nudi se jo$ nekoliko korisnih opcija. Prva se odnosi na nacin
crtanja krivulja, druga na koli¢inu zagladenosti linije, a tre¢a na vrstu
Kista.
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Mode:("u ﬂkot‘h... 52| & | shape None‘ =] g:lrlijke- None ,
| _

Na prethodnoj slici prikazan je izbornik Tool Controls alata Pencil:

1. Nacin crtanja krivulje — moguce je birati izmedu regularne Bézier
krivulje (odabrana na gornjoj slici) i Spiro putanje koja se ne
koristi Cesto jer je puno bolje koristiti alat Pen umjesto te opcije.

2. Zagladenje — moguce je odabrati prije crtanja neke linije
zagladenje u rasponu od 1 do 100, gdje je 1 minimalno, a 100
maksimalno zagladenje.

3. Resetiranje parametara na pocetne vrijednosti.

4. Nekoliko opcija pomoéu kojih se moze primijeniti razli¢iti oblik na
linije. Potrebno je prvo odabrati neki od oblika te nakon toga
nacrtati oblik.

Ako se zeli nacrtati samo to¢ka pomocu ovoga alata potrebno je
pritisnuti i drzati tipku [Ctrl] + lijeva tipka miSa. Za duplo vecu to¢ku
pritisne se [Ctrl] + [Shift] + lijeva tipka miSa, a za toCke nasumicne
veli€ine pritisne se [Ctrl] + [Alt] + lijeva tipka misa.

2.3. Oznac€avanje, poravnanje i grupiranje
elemenata

Kada se zeli s nekim odredenim elementom nesto raditi potrebno ga je
prvo oznaditi, ali ako se na platnu nalazi velik broj elemenata, nije uvijek
lako odabrati to¢no one elemente kojima se Zeli manipulirati. Stoga
postoje razne tehnike ozna¢avanja elemenata. Kada su elementi jednom
oznaceni moZze ih se zajedni¢ki pomicati, povecavati, smanjivati, rotirati,
poravnavati ili ih se moze staviti u istu grupu da se pona$aju kao jedan
element, $to moze uvelike olak3ati rad.

2.3.1. Oznacavanje elemenata
Za oznaavanje elemenata miSem, potrebno je odabrati alat Select and

transform objects (Selector) u izborniku Toolbox te lijevom tipkom
miSa oznaditi zeljeni element tako da se klikne na njega. Ako se Zeli
oznaciti viSe elementa, potrebno je pritisnuti tipku [Shift] na tipkovnici te
pritisnuti lijevom tipkom miSa na svaki Zeljeni element. Oni elementi koji
su ve¢ oznaceni bit ¢e pritom odznaceni, a elementi koji jo$ nisu
oznaceni ¢e se oznaciti.

Ako se zeli oznaditi vise elemenata odjednom, to se izvodi tako da se
pritisne i drzi lijeva tipka miSa u praznome prostoru pokraj elementa te
se povlaci mis do svih zeljenih elemenata koji Ce se postupno
oznacCavati. Prilikom takvoga oznaCavanja pojavit Ce se pravokutan oblik
te ¢e svi elementi koji se nalaze unutar toga oblika biti oznaceni. Kada
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su jednom elementi oznaceni, s njima se moZe manipulirati kao da se
radi o jednome elementu.

Kada se pritisne i drzi tipka [Alt] i lijeva tipka miSa, moze se vidjeti
crvena linija prilikom pomicanja mida kojom se prelazi preko onih
elemenata koje se zeli oznaditi, $to je prikazano na donjoj slici.

...
/.O
.0

Svi elementi koji su dotaknuti linijom se oznace te se njima moze dalje
manipulirati, kao $to je prikazano na donjoj slici.

To je korisno kada se na platnu nalazi mnogo elemenata, a Zele se
oznaciti samo neki odredeni. Pomocu tipke [Alt] moguce je jos i oznaditi
elemente ako su u ukupnome poretku zadnji na istome mjestu. To se
odnosi na situaciju u kojoj se viSe elemenata nalazi na istoj poziciji, a
vidljiv je samo onaj element koji je najviSe rangiran po Z poretku (vise
informacija o Z poretku moze se naci u poglavlju 2.3.3. Poravhavanje
elemenata). Potrebno je oznaciti najviSe pozicionirani element, drzi se
tipka [Alt] te se samo klika lijevom tipkom mi$a po prvome elementu koji
se moze oznaciti, nakon toga se elementi ozna€avaju po razinama (od
najviSe prema najnizoj).

Oznaditi elemente moguce je i preko tipkovnice tipkom [Tab], a ako se
zeli vratiti na prethodno oznaceni element potrebno je odabrati
kombinaciju tipki [Shift] + [Tab]. Sve elemente odjednom moguce je
oznaditi kombinacijom tipki [Ctrl] + [A], Sto ¢e oznaCiti sve elemente
samo u trenutnome sloju (Sto su slojevi i ¢emu oni sluze objasnjeno je u
poglavlju 3.2. Uporaba slojeva), a ako se zZele oznaditi svi elementi u
svim slojevima potrebno je odabrati kombinaciju tipki [Ctrl] + [Alt] + [A].

Tipkom [Esc] uklanja se ozna€avanje sa svih trenutacno oznacenih
elemenata.
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2.3.2. Kopiranje, lijepljenje, dupliciranje i brisanje elemenata

Program Inkscape nudi naredbe za kopiranje, lijepljenje, dupliciranje i
brisanje elemenata na tri mjesta. Naredbama se moze pristupiti preko
glavnoga izbornika Edit, u Command Baru (nedostaje samo ikona za
dupliciranje) i preko brzoga izbornika do kojeg se dolazi kad se pritisne
desnom tipkom misa na neki element.

Najbrzi nacin za kopiranje nekoga elementa jest preko tipkovnice,
kombinacijom tipki [Ctrl] + [C]. Istu naredbu moguée je odabrati i preko
izbornika Edit > Copy ili desnim klikom miSa na element te u brzome
izborniku naredbom Copy.

Kopirani i izrezani element nalazi se spremljen u meduspremniku, a
moze se zalijepiti preko izbornika Edit > Paste ili pomocu tipkovnoga
pre€aca [Ctrl] + [V]. Element Ce se zalijepiti na mjesto gdje se nalazi
pokaziva¢ misa. Ako se Zeli zalijepiti element na isto mjesto s kojega je
bio kopiran, koristi se kombinacija tipki [Ctrl] + [Alt] + [V] ili preko
izbornika Edit > Paste In Place. Moguce je i zalijepiti samo stil nekoga
elementa (kao $to je debljina ruba, boja ili font, boja, stil, veli€ina za
tekst) tako da se odabere naredba Paste Style u izborniku Edit ili preko
tipkovnoga prec€aca [Shift] + [Ctrl] + [V].

Element se moze izrezati s platna, ali i dalje zadrzati u meduspremniku
pomocu naredbe Cut koju je moguce odabrati preko izbornika Edit ili
kombinacijom tipki na tipkovnici [Ctrl] + [X].

Elementi se mogu i duplicirati tako da se kopiraju i postave na vrh
postojeéega elementa, na isto mjesto. Potrebno je oznaciti element i
odabrati naredbu Edit > Duplicate ili odabrati kombinaciju tipki [Ctrl] +
[D] na tipkovnici.

Ako se jedan ili viSe elemenata Zeli obrisati, potrebno ih je oznaditi, te
pritisnuti tipku [Delete] ili [Backspace] na tipkovnici ili odabrati Edit 2>
Delete.

2.3.3. Poravnavanje elemenata

Poredak po Z osi

Elemente je moguce poravnavati, poredati i promijeniti poredak na viSe
nacina.

U matematici postoje X, Y i Z osi po kojima se moze odrediti tocna
lokacija nekoga elementa. U raCunalnim se programima X os odnosi na
vodoravno poravnavanje elemenata, Y os sluzi za okomito
poravnavanje, dok se Z os koristi za poravnavanje objekata po dubini.
Poravnavanje po dubini naj¢eS¢e se koristi kod 3D alata, ali i u grafi¢kim
2D programima potrebno je poravnati elemente po dubini 5to se naziva
Z poredak. Za promjenu poretka nekoga elementa, potrebno je oznaciti
element kojemu se Zeli promijeniti poredak te preko izbornika Object
odabrati jednu od Cetiri naredbe za tzv. Z poredak:

Object - Raise pomice oznaceni element prema gore za jednu razinu,
a naredbu je moguce ukljuciti i preko tipkovne kratice [Page Up].
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Object > Lower pomice oznaceni element prema dolje za jednu razinu,
a naredbu je moguce ukljuciti i preko tipkovne kratice [Page Down].

Object > Raise to Top pomice oznacéeni element na vrh, a naredbu je
moguce ukljugiti i preko tipkovne kratice [Home].

Object > Lower to Bottom pomice oznaéeni element na dno, a
naredbu je moguce ukljuditi i preko tipkovne kratice [End].

Iste naredbe nalaze se i na alatnoj traci Tools Control Bar.

Na dolje prikazanoj slici moze se vidjeti da je na lijevoj strani crveni krug
na vrhu slike po Z poretku dok je na desnoj strani crveni krug na dnu
slike po Z poretku. To se postiglo tako da se oznacio crveni krug s lijeve
strane i primijenila naredba Object - Lower to Bottom.

Raspored elemenata

Za poravnavanje elemenata koristi se naredba Object - Align and
Distribute pomocu kratice na tipkovnici [Shift] + [Ctrl] + [A], nakon Cega
se otvara istoimeni dijaloSki okvir prikazan na sljedecoj slici.

=:Align and Distribute (Shift+Ctrl+A) 1]
Align

Relative to: | Selection Area El

Treat selection as group: [

FTEEEED
o], 0 468} 1of] wf 2

Distribute
b afy [éd {1 R
EEEES

Rearrange
% T % % od

Remove overlaps
B0 [Flwoo 2

Nodes

as e LU
[Es Align and Distribute (Shift+Ctrl+A) -]

Ovaj dijaloSki okvir omogucuje pozicioniranje elemenata u odnosu na
druge elemente ili selekcije, crteZe ili u odnosu na stranicu. Dvije vrste
pozicioniranja su moguce preko ovoga izbornika — Alignment, gdje su
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centar ili rubovi elemenata poravnati jedni s drugima i Distributing, gdje
su elementi rasporedeni u nekome smjeru prema njihovim centrima ili
rubovima.

U podrudju opcije Align moguce je elemente poravnavati okomito ili
vodoravno, na ikoni je prikazana crvena linija koja oznaCava na &to se
odnosi poravnanje. Kada se pomice kursor mida preko ikona za
poravnavanje, pojavi se kratak opis Sto oznacava koja ikona, na primjer
Cetvrta ikona od okomitih znaci da ¢e se elementi poravnati po desnome
rubu, druga da se elementi poravnavaju po lijevome rubu, itd.

Prije poravnanja elemenata potrebno je odabrati u odnosu na $to Ce se ti
elementi poravnati. U sekciji Align nalazi se padajuci izbornik naredbe
Relative to u kojemu se mogu odabrati opcije po kojima ée se elementi
poravnavati. Tako se elementi mogu poravnati prema trenutnoj selekciji
(Selection Area), crtezu (Drawing), stranici (Page), najmanjemu
elementu u selekciji (Smallest object), najveéemu elementu u selekciji
(Biggest object), prvome selektiranom elementu (First selected) ili
zadnjemu selektiranom elementu (Last selected).

Na dolje prikazanoj slici nalaze se krugovi koji su ,razbacani®, tj. nisu
vodoravno poravnati.

Ako ih se Zeli vodoravno poravnati, potrebno je odabrati opciju Relative
to: Selection Area, iako bi u ovome slu€aju bilo koja od opcija bila
zadovoljavajuéa jer su svi krugovi jednakih dimenzija, samo se razlikuju
po boji. Nakon toga se oznace svi elementi te se odabere opcija Center
on horizontal axis (drugi red, tre¢a ikona pod sekcijom Align).
Konacan rezultat ove opcije prikazan je na donjoj slici.

Kao $to je i vidljivo na gornjoj slici, elementi su poravnati vodoravno, ali
razmak izmedu njih nije jednak. Ako se Zeli postaviti jednak razmak
izmedu svih elemenata potrebno se posluziti opcijama iz podrucja
Distributing. Oznace se svi elementi u kojima je potrebno primijeniti
jednak razmak i odabere se jedna od opcija za rasporedivanje
elemenata, na primjer Distribute centers equidistantly horizontally $to
znaci da ¢e se elementi rasporediti tako da imaju jednak razmak od
sredine jednoga elementa do sredine svakoga slijede¢eg elementa po
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vodoravnoj osi. Na dolje prikazanoj slici moze se vidjeti jednak razmak
izmedu elemenata nakon koriStenja spomenute opcije.

Ova opcija postavlja razmak izmedu elemenata tako da uzima
udaljenost od prvoga do posljednjeg elementa, a razmak izmedu njih
podijeli na ostale elemente. To znaci da pomocu ove opcije nije moguce
precizno odrediti razmak izmedu elemenata vec se on odreduje
pravilnom raspodjelom.

Poravnavanje po Xi Y osi

Za dodavanje to¢no odredenoga razmaka izmedu elemenata ili za
svrstavanje elemenata u redove ili stupce koristi se naredba Object >
Arrange . Nakon odabira se otvara dijaloski okvir Arrange, prikazan na
donijoj slici.

RE Arrange (3]

Rectangular grid | Polar Coordinates

Rows: Columns:

-

2 = * |2

-

-

[T] Equal height [[] Equal width
Alignment:
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¢ [o] e
& o 4
() Fitinto selection box
@ Set spacing:

Uﬂﬂ % |15,00000
g v: [15,00000

e []
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U ovome dijaloskom okviru moguce je odabrati na koliko redova ili
stupaca Ce se raspodijeliti oznaceni elementi, je li potrebno imati
jednaku visinu i Sirinu tih stupaca i redova ili nije, pa sve do XiY
razmaka izmedu elemenata.

Ako se zele postaviti Cetiri kruga, koja su trenutno u jednome redu, u dva
reda i dva stupca s jednakim X i Y razmakom, potrebno je u podrucje
Rows upisati ili okretnim dugmetom odabrati broj 2, Sto oznaCava dva
reda, i u podrucje Columns takoder upisati broj 2, $to oznacava broj
stupaca koiji ¢e biti izradeni. U podrucje X i Y potrebno je upisati razmak
izmedu elemenata koji je u pikselima, u ovome slucaju stavit ¢e se na 15
px razmaka izmedu elemenata po X osi i 15 px razmaka izmedu
elemenata po Y osi. Nakon $to se podese sve Zeljene postavke,
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potrebno je oznaciti elemente na koje se Zeli primijeniti te postavke
(elementi mogu biti oznaceni i prije poCetka upisa u ovaj dijaloski okvir) i
pritisnuti na dugme Arrange. Elementi ¢e se poredati po kriterijima koji
su zadani, kao $to je i prikazano na donjoj slici.

2.3.4. Grupiranje elemenata

U grupu se moze staviti bilo koja skupina elemenata. Jednom kada su
elementi smjesteni u grupu, s njima se moze manipulirati kao da se radi
0 jednome elementu. Tako im se moze mijenjati dimenzija koja ¢e se
jednako promijeniti na svim elementima u grupi, boja, mogu se rotirati,
pomicati, iskriviti te se mogu primijeniti mnoge druge opcije, koje se
mogu primijeniti i na zasebne elemente.

Za postavljanje elemenata u grupu, potrebno je prvo oznaciti one koji se
Zele staviti u odredenu grupu. Kada se Zeljeni elementi oznace, odabere
se naredba Object - Group. Sada se elementi nalaze u grupi i ako se
oznaci bilo koji element iz grupe, oznacit ¢e se cijela grupa. Ako se
elementi zele razgrupirati tj. maknuti iz grupe, to se moze napraviti
odabirom naredbe Object = Ungroup. Na dolje prikazanoj slici nalaze
se dvije grupe, a svaka od njih je iskrivljena na svoju stranu.

OO0

Alternativha metoda za razgrupiranje ili grupiranje elemenata je pritisak
desne tipke miSa na oznacene elemente i odabir odgovaraju¢e naredbe
iz kontekstnoga izbornika — Group za grupiranje ili Ungroup za
razgrupiranje.

NajceSc¢e koriStena, ujedno i najbrza metoda grupiranja i razgrupiranja je
preko tipkovnoga precaca. Za grupiranje elemenata koristi se tipkovna
kratica [Ctrl] + [G], dok se za razgrupiranje koristi kratica [Ctrl] + [Shift] +
[G].

U grupu elemenata ulazi se dvostrukim klikom lijeve tipke misa, a izlazi
na odabir bilo kojega elementa ili podrucja izvan grupe. Ulaziti se moze i
preko tipkovnice pritiskom na kombinaciju tipki [Ctrl] + [Enter], a izaéi se
moze kombinacijom tipki [Ctrl] + [Backspace].

Za dodavanje vec¢ postojecega elementa u postoje¢u grupu, potrebno je
odrezati element (Edit > Cut), uéi u Zeljenu grupu i zalijepiti na istu
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poziciju element (Edit > Paste In Place) te ¢e element postati dijelom te
grupe.

2.4. Koristenje boja

Boja se moze primijeniti na element uporabom opcije Fill ili Stroke. Fill
se odnosi na podrucje unutar elementa, dok se Stroke odnosi na obrub
elementa.

Mnogo je nacina za promjenu boje elemenata, a neki od njih su preko
dijaloSkoga okvira Fill and Stroke (Object - Fill and Stroke), preko
izbornika Palette (na dnu programa, paleta s bojama) ili preko izbornika
Swatches (View - Swatches).

2.4.1. Dijaloski okvir Fill and Stroke

U ovome dijaloSkom okviru mogucée je promijeniti boju unutar elementa
ili rub elementa tek nakon $to se nacrta neki element (za razliku od
mogucnosti predefiniranja boje u izborniku Palette). Za primjenu boje
unutar elementa ili postavljanje obruba potrebno je prethodno oznaditi
element. Na dolje prikazanoj slici nalazi se dijalo$ki okvir Fill and Stroke
do kojega se moze doci preko izbornika Object ili otvaranjem istoga u
skupini Dialogs, s desne strane programa (nalazi se tamo samo ako je
vec prethodno otvoren taj dijaloSki okvir).

[#Fill and Stroke (Shift+ Ctrl+F) E ®

Eill |I" Stroke paint |:' Stroke style |

xOoo@o?  of

Flat color

[ reB ][ st || cvvk |[ whee |[ cws |

B O RER IRl 3

= mo o m

RGBA; ffaaD0ff

Blur (%) 00 =

Opacity (%) 100,0] -

DijaloSki okvir ima tri kartice: prva kartica je Fill i odnosi se na boju
ispune elementa, druga kartica Stroke paint odnosi se na boju obruba
elementa, a tre¢a kartica Stroke style odnosi se na stil obruba
elementa.
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Na katrtici Fill moguce je prvo odabrati jednu od Sest ponudenih opcija
koje se odnose na vrstu prikaza boje unutar elementa. Tako se moze
odabrati:

¢ X (No paint) — oznacava da nece biti boje unutar elementa

e Flat color — §to znadi koristenje bilo koje pojedinaéne boje na
elementu

e Linear gradient — izraduje se linearni prijelaz boje minimalno
izmedu dvije boje

¢ Radial gradieng — oznacava kruzni prijelaz izmedu minimalno
dvije boje
e Pattern — moze se obojiti element u neki uzorak

¢ Mesh gradient — izraduje slozenije prijelaze izmedu minimalno
dvije boje

e Swatch — automatski se Cuvaju posljednje odabrane boje ili
spremljene boje.

Sama boja se moze odabrati iz paleta boja kao §to su RGB, HSL ili
CMYK jednostavnim upisom kéda boje za svaku pojedinu boju posebno
ili upisom jedinstvenoga heksadecimalnog kdda boje u podru¢je RGBA
na dnu svake kartice.

Na kartici Stroke paint moguce je takoder odabrati jednu od Sest
ponudenih opcija, koje su identi¢ne kao i kod gore opisane Fill kartice,
ali se te opcije odnose na obrub elementa, tj. boju obruba.

Posljednja kartica Stroke style koristi se za odabir svojstva obruba.
Tako se moze odabrati Sirina obruba, vrsta spoja, izgled zavrsetka linije,
oblik linije (crtice, tockice, puna linija itd.) i markeri na kraju linije poput
strelice, kruga, romba, kvadrata i drugo.

.....

Opcijom Blur mozZe se zamagliti neki element. Predefinirana postavka je
0% S8to znaci da element nije uopée zamagljen, dok 100% oznacava
potpuno zamagljenje elementa. Postotak se moze mijenjati upisom
konkretne vrijednosti u okvir Blur, povlacenjem kliza¢a ili okretnim
dugmetom. Druga opcija je Opacity, $to oznacava neprozirnost
elementa, a predefinirana vrijednost je 100% S$to znaci da je element
potpuno neproziran, a 0% da je potpuno proziran. Postotak se takoder
moze mijenjati upisom vrijednosti, okretnim dugmetom ili klizatem.

2.4.2. Dijaloski okvir Swatches

U ovome dijaloskom okviru, do kojega se dolazi preko izbornika View -
Swatches, moguce je odabrati neke predefinirane ili nedavno koriStene
boje. Za odabir neke predefinirane palete boja, u dijaloSkome okviru
Swatches se klikne na malu strelicu oznacenu crvenim okvirom na dolje
prikazanoj slici.
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M Swatches (Shift+ Crl+ W) = =
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Kada se odabere neka predefinirana paleta boja (Android icon palette,
Gold, Reds, Ubuntu ili neka druga) pojavit ¢e se sve boje iz te palete.
Element na koji se zeli primijeniti boja prethodno mora biti oznacen te se
lijevom tipkom misa klikne na zeljenu boju koja se primjenjuje na ispunu
elementa. Za odabir boje obruba potrebno je kliknuti deshom tipkom
misa na boju i odabrati opciju Set stroke. Boja obruba se moze postaviti i
metodom povuci i ispusti tako da se drZi tipka [Shift] prilikom prijenosa
boje. Moguce je i podesiti prikaz boja pomocéu raznih opcija koje se nude
pritiskom na gore oznacenu strelicu.

2.4.3. lzbornik Palette

Preko izbornika Palette moguce je na najbrzi nacin promijeniti boju
nekoga elementa. Nalazi se na dnu prozora, a uz njega su vezane i
opcije Fill i Stroke oznaéene crvenim okvirom na donjoj slici. Pokraj tih
opcija nalazi se i brza opcija s oznakom ,0“ §to oznacava Opacity, tj.

koli¢inu neprozirnosti elementa koja je opisana u poglaviju 2.4.1.

rl 1 3

Fill: . < . - % 1070,93 _ . =
Stroke: 103 1|0 < % @ elayer1 IZI Rectangle in layer Layer 1. Click selec v 587.35 7| 93% |5

Boja se moze odabrati i prije nego se krene crtati neki element, a moze
se i primijeniti na neki oznaceni element tako da se lijevom tipkom misa
klikne na Zeljenu boju. Boja obruba mozZe se na brz nacin promijeniti
kombinacijom tipke [Shift] + lijeva tipka miSa na Zeljenu boju.

Boja se moze i prenijeti metodom ,povuci i ispusti“ (engl. Drag and
drop), tako da se lijevom tipkom mi$a uhvati Zeljena boja na paleti boja
te se odvuce do elementa na kojemu se Zeli primijeniti. Isti je postupak
ako se Zeli primijeniti i na obrub elementa, samo $to se boja odvuce do
obruba elementa.

Kada je neki element oznacen moguce je promijeniti i nijansu boje
takozvanom gestikulacijom misa. Pritisne se i drZi lijeva tipka mi$a na
podrucju Fill, ispod palete boje, te se kre¢e miSem u lijevu ili desnu
stranu za promjenu boje. Na selektiranome elementu moguce je vidjeti
kako se mijenja boja ovisno o povlaenju miSa. Za mijenjanje boje
obruba, potrebno je na isti nacin pritisnuti i drzati lijevu tipku miSa na
podrucju Stroke. Ako se uz ovaj postupak pritisne i drzi tipka [Shift]
mijenja se zasicenje, a tipkom [Ctrl] svjetlina.
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2.4.4. Stvaranje i uredivanje gradijenata

Gradijenti su blagi prijelazi iz jedne boje u drugu, a mogu biti linearni
(prikazan na donijoj slici, lijevo) ili radijalni (prikazan na donjoj slici,
desno). Postoji nekoliko nacina kako se gradijenti mogu postaviti na
element, a neki osnovni su stavljanje gradijenta na Zeljeni element preko
izbornika Fill and Stroke, stavljanje na element pomoc¢u alata Gradient,
uredivanje tzv. stop to¢aka koje sluZe za dodavanje vise boja,
pode$avanije orijentacije gradijenta i drugi.

Najlak8i nagin za postavljanje gradijenta na neki element je preko
izbornika Fill and Stroke. Za postavljanje je potrebno samo oznaditi
Zeljeni element i kliknuti na dugme Linear gradient ili Radial gradient,
ovisno o potrebi, oznaceno crvenim okvirom na dolje prikazanoj slici.

AFill and Stroke (Shift+ Ctrl+F) = &

Eill [T Stroke paint |=* Stroke style |

X |E]DD? o[v

Linear gradient
Gradient 4 Mame #
IR <797 1

Nakon klika na jednu od opcija, stvorit ¢e se automatski gradijent s dvije
stop toCke. Prva stop toCka je izradena tako da je uzeta prethodno
koriStena boja koja se nalazi u opciji Fill sa 100% zasic¢enjem, dok je
druga ista ta boja ali 100% transparentna.

Za promjenu smjera gradijenta, dodavanje novih boja, koli¢ine gradijenta
ili neke druge modifikacije na gradijentnome elementu, potrebno je

odabrati alat Create and edit Gradients (Gradient) R koji se nalazi u
Toolboxu, a koji je takoder mogucée odabrati i preko tipkovnoga pre€aca
[Ctrl] + [F1] ili [G]. Nakon toga, potrebno je kliknuti lijevom tipkom misa
na element kojemu se Zeli promijeniti gradijent. Na dolje prikazano;j slici
moze se vidjeti kako izgleda gradijentni element s tri razliCite boje.
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Kvadrat, romb i krug predstavljaju po€etnu, srednju i zavrSnu stop tocku.
Gradijent od dvije boje sastoji se samo od kvadrata i kruga koji
oznacavaju pocetnu i stop toCku na kojima se mogu raditi preinake.

Stop to¢ke mogu se dodati izmedu pocetne i zavrSne tocke, kada je
odabran alat Gradient, preko izbornika Tool Controls Bar pritiskom na
dugme Insert new stop ili dvostrukim klikom lijeve tipke misa na
gradijentnu liniju. Za brisanje je potrebno oznaditi Zzeljenu stop to¢ku na
gradijentnoj liniji i pritisnuti na tipkovnici tipku [Delete] ili u Tool Controls
Baru odabrati naredbu Delete stop.

Stop to¢ke mogu se oznaciti alatom Gradient, tako da se pritisne
lijevom tipkom miSa na jednu od njih. Kada je stop to¢ka ozna¢ena, ona
se moze modificirati u smislu pomicanja, mijenjanja boje i prozirnosti.
Samo se na pocetnoj i zavr$noj tocci moze mijenjati smjer gradijenta. Za
oznacCavanije viSe stop to€aka, potrebno je pritisnuti i drzati tipku [Shift]
na tipkovnici i lijevom tipkom misa oznacavati Zeljene stop tocke. Za
oznacCavanje svih stop to€aka potrebno je odabrati kombinaciju tipki
[Ctrl] + [A] na tipkovnici.

2.4.5. Uzimanje boje alatom Dropper

Boja ispune elementa i njegova obruba mogu biti promijenjeni tako da se
uzme neka ve¢ postojeca boja na crtezu, koridtenjem alata Pick colors

from image (Dropper) 3/ koji se nalazi u Toolboxu ili preko tipkovnoga
pre€aca, pritiskom na tipku [F7] ili [D]. Pomoc¢u ovoga alata moguce je
uzeti prosje€nu boju nekoga elementa pomoc¢u ozna¢enoga kruznog
podrucja, invertirati uzetu boju ili spremiti boju u meduspremnik za
kasniju upotrebu.

Ako se zeli samo uzeti boja od nekoga ve¢ nacrtanoga elementa u
dokumentu, potrebno je uzeti alat Pick colors from image (Dropper)

3/ i lijevom tipkom misa kliknuti na Zeljenu boju. Nakon toga, boja se
postavlja u opciju Fill. Boju je moguce postaviti i u opciju Stroke tako da
se pritisne i drzi tipka [Shift] na tipkovnici i lijevom tipkom miSa se
odabere zeljena boja. Nakon postavljanja, svaki ¢e sljede¢i novo
nacrtani element imati postavljene te boje, tako dugo dok se one ne
zamijene u opcijama Fill i Stroke nekom drugom bojom.

Kada se nekomu elementu Zeli promijeniti boja pomocu ovoga alata,
potrebno je prvo oznaditi taj element. Nakon toga se odabere alat Pick

colors from image (Dropper) te se za ispunu elementa (Fill)
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Zanimljivosti i napomene

Boja pozadine moze se
izraditi na dva nacina.

Prvi nacin je odabir boje
pozadine pod opcijom
Background color do koje
je mogucée doci preko
izbornika File = Document
Properties = Page.

Drugi nacin je crtanje
pravokutnog oblika Zeljene
boje, istih dimenzija kao Sto
je i pozadina.

pritisne lijevom tipkom miSa na Zeljenu boju u dokumentu, a ako se Zeli

boja primijeniti na obrub (Stroke), pritisne se i drzi tipka [Shift] i odabere
boja lijevom tipkom miSa. Nakon pritiska, boja se odmah primjenjuje na

oznaceni element.

Za uzimanje srednje vrijednosti boje, pritisne se i drZi lijeva tipka miSa uz
povlaenje mida u bilo kojem smjeru. Stvara se krug koji oznacava
podrucje koje ¢e se uzeti u obzir za uzimanje srednje vrijednosti boje.

Za kopiranje boje, potrebno je kliknuti lijevom tipkom miSa na Zeljenu

boju alatom Pick colors from image (Dropper) te pritisnuti
kombinaciju tipki [Ctrl] + [C] za kopiranje heksadecimalnoga kdda boje.
Boja se lijepi tako da se selektira element na koji se Zeli primijeniti
kopirana boja te se u podru¢je RGBA, u dijaloSkome okviru Fill and
Stroke, kombinacijom tipki [Ctrl] + [V] zalijepi heksadecimalan kéd boje.

2.5. Vjezba: Izrada crteza

1.

Izradite crtez inspiriran popularnom starom igrom ,Pacman®,
koji je prikazan na donijoj slici. Boja pozadine je ,,000000ff, u
heksadecimalnom obliku, a dimenzija pozadine je 1100x760
pX.

Zuti krug koji izgleda kao glava s otvorenim ustima
(Pacman), dimenzije je 170x170 px. Zuti krugovi su
dimenzije 55 px i ,ffffOOff* boje u heksadecimalnome obliku.

Plave prepreke visine su 50 px, ,,0000ffff , boje u
heksadecimalnome obliku, a Sirina proizvoljna, §to sli¢nija
donijoj slici.

Postavite Zute krugove tako da su svi jednako odmaknuti
jedan od drugoga, a da je razmak izmedu njih 120 px po
vodoravnoj i okomitoj osi.

Spremite crteZ pod nazivom Pac-man.svg.
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3. Rad s putanjama i tekstom

Po zavrsetku ovoga poglavija moci cete:
e Kkoristiti i uredivati putanje
e dodati tekst na crtez
e uredivati tekst.

U ovome poglavlju govorit ¢e se o stvaranju novih elemenata pomoéu
dva ili viSe postojecih te kako se dodaje i ureduje tekst.

3.1. Putanje i njihovo uredivanje

U programu Inkscape moguce je uporabom vise naredbi izraditi novi
element iz jednoga ili viSe postojecih elemenata. Kod ovoga nacina jako
je bitan takozvani Z poredak elemenata (objasnjen u poglavlju 2.3.3.). U
gotovo svim slu€ajevima (iznimka je samo naredba Cut Path), Fill i
Stroke novoga elementa se naslijeduje, tj. kopira od donjega elementa,
tj. elementa koji je nize rangiran po Z poretku. Postoje neke iznimke
koje ¢e biti objasnjene kod konkretnih naredbi. Objekte nakon ovog
postupka nije moguce vratiti u prvobitno stanje pa se preporucuje rad na
kopijama objekata.

Svim naredbama ove vrste pristupa se preko izbornika Path, a
prethodno je potrebno osigurati svim objektima da postanu putanje. Sve
oshovne graficke objekte koji se mogu izraditi u Inkscapeu, kao i tekst,
potrebno je pretvoriti u putanje. Objekti se pretvaraju u putanje preko
izbornika Path - Object to path ili Path - Stroke to path.

Union

Za spajanje, tj. uniju dva ili viSe elemenata potrebno je oznaditi elemente
i odabrati naredbu Path - Union ili preko tipkovnoga prec€aca [Ctrl] +
[+]. Novi element sadrzi sva podrucja izvornih elemenata, osim spojeva
izmedu elemenata, koji su izbrisani i pretvoreni u jedan element kao $to
je i prikazano na donjoj slici. Na lijevoj strani slike nalaze se zasebni
elementi, dok je na desnoj strani novostvoreni element plave boje zbog
toga $to je element koji je najnize rangiran po Z poretku takoder plave
boje.

—>

Difference

Ako je potrebno obrisati donji element pomocu gornjega, ali samo
razlikom, tj. onim podrucjem gdje se dva elementa preklapaju, koristi se
naredba Path - Difference, a do nje se moze doc¢i i pomoéu tipkovnoga
pre€aca [Ctrl] + [-]. Kod ove naredbe moguce je oznaditi samo dva
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elementa istovremeno i nakon toga primijeniti naredbu. Na donjoj slici
prikazan je rezultat ove naredbe.

-

Intersection

Ako se zeli izraditi presjek izmedu dva ili viSe elemenata koristi se
naredba Intersection. Potrebno je oznaditi elemente i primijeniti
naredbu. Novi element koji se dobije ovom naredbom nastaje od
preklapajucega tj. zajedni¢koga podrudja izvornih elemenata. Do
naredbe se dolazi preko izbornika Path ili pomocu tipkovne kratice [Ctrl]
+ [*]. Na dolje prikazanoj slici prikazano je preklapanje dvaju elemenata.

S

Exclusion

Ako se Zeli iskljuciti dva ili vise elemenata u njihovim preklapanjima,
koristi se naredba Path - Exclusion na nacin da se oznace elementi na
koje se ta naredba Zeli primijeniti i odabere se naredba iz izbornika. Na
dolje prikazanoj slici moze se vidjeti rezultat primjene ove naredbe
izmedu tri elemenata.

0 - )

Division

Kada se neki element Zeli podijeliti koristi se naredba Path - Division
do koje se moze doci i kombinacijom tipki [Ctrl] + [/] na tipkovnici.
Naredba radi tako da je niZe rangirani element po Z poretku odrezan
vide rangiranim elementom. Moguce je oznaciti samo dva elementa
istovremeno za primjenu ove naredbe. Na donjoj slici moze se vidjeti
primjer naredbe — desna strana je malo odmaknuta tako da se bolje vidi
rezultat ove naredbe.
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Cut Path

Ako se Zeli odrezati neki element po obrubu, koristi se naredba Cut
Path koju je moguce odabrati u izborniku Path ili preko tipkovnoga
pre€aca [Ctrl] + [Alt] + [/]. NiZe rangirani element je odrezan vise
rangiranim elementom. Moguce je oznaciti samo dva elementa za
primjenu ove naredbe. Novonastali elementi nemaju nikakvu ispunu iako
su je mozda imali prije koriStenja ove naredbe. Na donjoj slici moze se
vidjeti rezultat naredbe ako novonastalom objektu dodijelimo vidljivu boju
obruba. Desni dio slike pomaknut je tako da se novonastali odrezani
elementi vide jasnije.

—>>

Osim tih osnovnih vrsta putanja, korisne su jo$ dvije naredbe na
izborniku Path: Combine i Break Apart.

Naredba Combine kombinira viSe oznaCenih elemenata u jedan slozZeni
element kojim se mozZe manipulirati kao i obicnim elementom. Prednost
ovoga nacina jest da se nakon zavrSene manipulacije tim slozenim
elementom on mozZe opet razdvojiti na pojedinaCne elemente naredbom
Path - Break Apart.

3.2. Dodavanje i uredivanje teksta

Dvije su osnhovne vrste tekstnih objekata u Inkscapeu, regularan, tj.
obi¢an i tekst koji uklju€uje pravokutni okvir. Tekst se kreira alatom

Create and edit text objects (Text) @I koji se nalazi u Toolboxu, a do
njega se moze doci i preko tipkovnoga prec€aca [F8] ili [T].

Kada se zeli dodati tekst prvim, ,obi¢nim*“ na¢inom na neki crtez

potrebno je uzeti alat Create and edit text objects (Text) AI u
Toolboxu i kliknuti miSem na podrucje u dokumentu gdje se Zeli dodati
tekst. Kako se tekst upisuje tako se i tekstni okvir prilagodava tekstu.
Prijelomi u retku moraju se ru¢no dodavati u ovome nacinu upisa. Na
donjoj slici prikazan je upis obi¢noga teksta.

Drugi nacCin dodavanja teksta jest upis u precizno odreden kvadratni
tekstni okvir. Kod ovoga nacina upisa, potrebno je uzeti alat Create and

edit text objects (Text) @I iz Toolboxa te izraditi tekstni okvir tako da
se pritisne i drZi lijeva tipka miSa na podrucju gdje se Zeli izraditi
kvadratni tekstni okvir te se povlaci u Zeljenome smjeru. Nakon
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zadovoljavajuce veli€ine tekstnoga okvira pusti se lijeva tipka misa.
Buduci da se tekst upisuje unutar tekstnoga okvira, nije potrebno
stavljati prijelome redaka vec se oni automatski stvaraju. Tekstni okvir
moze se i naknadno podeSavati tako da se alatom Create and edit text

objects (Text) AI klikne na zeljeni sadrzaj te se pritisne i drzi lijeva
tipka miSa na donji desni kut (romb) tekstnoga okvira i pomice u
Zelienome smjeru. Kada je novi oblik zadovoljavajuci, pusti se lijeva
tipka miSa. Na donjoj slici prikazan je upis teksta u tekstni okvir.

Ovo je tekst upisan u tekstni

Za uredivanje teksta, potrebno je uzeti alat Create and edit text objects

(Text) AI i kliknuti miSem u podrucje teksta koji se zeli promijeniti.
Tekst ¢e se oznaditi i pokaziva€ misa Ce biti postavljen izmedu onih
slova gdje se kliknulo.

Dodatne mogucénosti za uredivanje teksta, otvaraju se u Tool Controls
Baru koji je prikazan na donjoj slici, a na kojemu je moguée, osim
oshovnih izmjena poput promjene fonta, veli€ine ili pozicije teksta,
podesiti i neke naprednije moguénosti. Tako je moguce postaviti razmak
izmedu linija, slova, rijeci, vodoravan ili okomiti pomak slova, rotiranje
slova i drugo.

sans-serif F—IEIBL.QQ!EI Mormal IEI @l:l E B | o X ‘

A 1135 5 Aa 000 5 e 000 5 MA|000 5 AR 000 o Alg 000 |..ﬂ‘

Osim brzih podeSavanja u Tool Controls Baru, osnovne postavke
teksta je moguce i promijeniti u dijaloSkome okviru Text and Font do
kojega se dolazi preko izbornika Text. DijaloSki okvir sastoji se od dvije
kartice. Na prvoj kartici Font moguce je promijeniti font, veli€inu, stil,
poravnati tekst, postaviti ga okomito ili vodoravno i odabrati razmak
izmedu linija. Bitno je napomenuti da je poslije svake promjene u
dijaloSkome okviru potrebno pritisnuti dugme Apply za primjenu zadanih
postavki. U drugu karticu Text moguce je zalijepiti tekst iz nekoga
drugog programa koji ce se nakon toga prikazati u trenutno odabranome
tekstnom okviru.
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[T Text and Font (Shift+Ctrl+T) = ®

Font | Text

Font family- Style
I - | s e
8514fix A3BDCCIPDOg €t Mormal  Reguler
851doem A3
Adobe Arabic
Adobe Caslon Pro AaBbCeliPplyg « Font size: 32 IZI

Ttalic Ttalic
Bold Eeld -

@Ij E B H Al125% E|
Obican tekst napisan...

Osim standardnih postavki za oblikovanje teksta, u Inkscapeu je moguce
i postaviti tekst na neki element, pravilan ili nepravilan. Za tu moguc¢nost
potrebno je prvo izraditi neku putanju, element i upisati neki tekst. Nakon
toga je potrebno oznaditi tekst i element te odabrati naredbu Put on
Path koja se nalazi na izborniku Text. Ako se tekst zeli ukloniti, tj.
obrisati s putanje ili elementa potrebno je odabrati naredbu Remove
from Path koja se nalazi na istome izborniku. Na donjoj slici moze se
vidjeti kako izgleda neki tekst smjeSten na razliCite elemente.

a@e
\k QQ\Seo
(g8 4 ‘
> >7S‘?\ b /
("9160

Tekst se moze rotirati i dodatno oblikovati preko standardnih naredbi
koje se koriste u oblikovanju teksta. Element se moZze maknuti, tj. sakriti
tako da se ne vidi na kakvome je elementu taj tekst napisan. Potrebno je
oznaditi element i odabrati u dijaloSkome okviru ili na paleti boja da
element nema obruba. Nakon toga element viSe nije vidljiv kako je i
prikazano na donjoj slici.

U Pro
2 s, aPe
Q ,5(, 9‘56 )
e = & <e¥st N¥pis,
= = 2 a?s#\ b “or,
v 0 % O, e
% & 21607 “amy Inkscs®
g 20

Za vracanje elementa, potrebno je prvo oznaciti tekst te odabrati
naredbu Edit > Clone - Select Original. Nakon toga pojavit ¢e se
selekcija na jo$ uvijek nevidljiv element na koji je potrebno postaviti
obrub da postane vidljiv. Nakon postavljanja obruba, element i tekst ¢e
se prikazat kao i na poCetku.
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3.3.

Vjezba: Izrada posjetnice

1.

Izradite posjetnicu dimenzije 90 x 55 mm dizajna kao na
donijoj slici.

Zeleni krugovi kre¢u se od najtamnijega prema najsvjetlijemu
u ovim bojama:

e najtamniji krug, tj. najvide rangiran ima heksadecimalni
kéd boje ,,2ca02cff*,

e srednji krug ima heksadecimalni kod boje ,87de87ff*,

¢ najsvijetliji krug, tj. najnize rangiran ima heksadecimalni
kod boje ,,d7f4d 7ff*.

Radi boljeg dojma izrezite krugove pomoc¢u naredbe
Difference, tako da izgledaju $to sli¢nije donjoj slici.

Kompletan tekst koji se nalazi na posjetnici ima font Arial i
zelene je boje heksadecimalnoga kdda ,2ca02cff. Veliina
slova za ,Ime Prezime* je 14 pt i podebljano, ,Ime sektora“
je 6 pt i crne boje, heksadecimalnoga kéda ,,000000ff“, a svi
ostali podaci koji se nalaze na posjetnici su veli¢ine 9 pt.

Tri glavne linije su crne boje, Sirine 140 px i debljine 1 px, a
prva manja linija je Sirine 120 px, debljine 0,7 px, boje
heksadecimalnoga kbéda ,999999ff*.

Spremite crtez pod nazivom Posjetnica.pdf.

Ime Prezime

Ime sektora

Miroslava Krleze 22a,
10 000 Zagreb

Mob.: 098/ 322 75 87
Tel.: 01/ 487 622

ime.prezime@ustanova.hr

Ako ste zavrsili prethodne zadatke prije predvidenog vremena, pokusajte
rijeSiti i sliede¢a dva zadatka:

1.

Tri glavne linije su crne boje i kre¢u od 165 px po X osi.
Odmaknute su jedna od druge 35 px, Sirine 140 px i debljine
1 px, a prva manja linija je Sirine 120 px, debljine 0,7 px i
boje heksadecimalnoga kéda ,999999ff*, odmaknuta od prve
crne linije 13 px.

Adresa, mobitel i telefon te e-mail odmaknuti su od gornje
linije 8 px, dok je ,iIme i prezime® odmaknuto od donje linije
10 px. Sav navedeni tekst kre¢e od 170 px po X osi, dok
.Ime sektora“ kre¢e od pocetka linije.
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4. Slojevi i uredivanje putanja

Po zavrsetku ovoga poglavija moci cete:
e izraditi samostalno slojeve
e preurediti Evorove i efekte na putanjama.

4.1. Uporaba slojeva

Svaki sloj (engl. layer) moze sadrzavati jedan ili viSe elemenata.
Konacan crtez je izraden od svih elemenata spojenih i vidljivih slojeva.
Slojevi se mogu postaviti tako da budu vidljivi ili nevidljivi, moze im se
postaviti prozirnost, pomicati ih na vide razine ili na manje ovisno o
drugim slojevima, zaklju€avati ih, brisati i preimenovati.

Slojevima se moze manipulirati preko dijaloskog okvira Layers,
prikazanoga na donjoj slici, koji se nalazi u izborniku Layer, a isti se
moze dobiti i tipkovnim preCacem [Shift] + [Ctrl] + [L].

f=tLayers (Shift+Ctrl+L) = @

w @ Layer 3

W @ Layer1

+ = TR
Blend mode: | Mormal |Z|
Opacity (%) 100,0| -

DijaloSki okvir Layers prikazuje sve slojeve koji se trenutacno nalaze u
dokumentu, a trenutaCno oznaceni sloj je osvijetlien plavom bojom
(Layer 2 na gornjoj slici). Kada se oznaCavaju elementi na crtezu koji su
rasporedeni po razli€itim slojevima, oznacit ¢e se to€no taj sloj u kojemu
se nalazi oznaceni element. Samo jedan sloj moze biti oznacen u
jednom trenutku.

Ispred imena sloja nalaze se dvije ikonice, od kojih prva oznac¢ava je li
sloj vidljiv ili ne (ikonica oka), a drugom se moze odredeni sloj zakljucati
ili otklju€ati (ikonica lokota). Elementi koji su sakriveni ili zaklju€ani ne
mogu biti ozna&eni ili modificirani.

Ako se pritisne desnom tipkom miSa na bilo koji sloj, pojavit ¢e se mali
skocni izbornik u kojem je moguce preimenovati sloj, duplicirati ga,
obrisati, staviti ga na visu ili niZzu razinu i dodati razne funkcije tomu
sloju.

Tipke koje se nalaze ispod liste slojeva mogu se takoder koristiti za brzo
dodavanije (+) ili brisanje (-) slojeva, kao i za pomicanje slojeva na visu ili
nizu razinu (strelica gore ili dolje).

Izbornik Blend mode sluZi za dodavanje raznih filtera samo na odabrani
sloj. Moguce je odabrati viSe od desetak opcija u ovom izborniku.
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Na kraju je opcija Opacity koja oznaCava neprozirnost oznacenoga
sloja. PoCetna vrijednost je 100 %, $to je potpuno neprozirno, dok je 0 %
potpuno prozirno. Neprozirnost se mozZe mijenjati izravnim upisom
vrijednosti u podrucje Opacity, povlatenjem pokazivaca misa ili
okretnim dugmetom.

Sve mogucnosti koje se nalaze u dijaloSkom okviru Layers i joS neke
dodatne moguc¢nosti vezane za slojeve moguce je naci i na glavhom
izborniku Layer.

4.2. Uredivanje ¢vorova na putanjama

Pod pojmom uredivanje évorova na putanjama smatra se izmjena

a

jednog ili viSe Evorova (toaka) putanje koristenjem alata Node Tool N
Ovaj fleksibilan alat omogucuje dodavanje, brisanje i pomicanje ¢vorova
na putanjama, a odabire se klikom na ikonu alata Node Tool u Tool
Boxu ili tipkovnim pre¢acem [F2] ili [n]. Nakon odabira alata klikne se na
putanju koja se Zeli urediti. Na putanji ¢e se prikazati svi ¢vorovi
oznacene putanje koji se mogu uredivati pojedinacno ili u grupama
ovisno o tome koliko ih se selektira. Za selekciju vise &vorova pritisne se
i drzi tipka Shift + klik s lijevom tipkom misa.

Kad se alatom Node Tool prelazi preko neke putanje, nakratko ¢e se
prikazati obrub putanje. Trajanje i boja ovog obruba mozZe se promijeniti
u izborniku Preferences - Node, do kojeg se najlakse moze doci
dvostrukim klikom na alat Node Tool. U dodatnim opcijama ovog
izbornika moguce je onemoguciti prikazivanje obrisa putanje i podesiti
ostale korisne opcije.

4.2.1. Selektiranje évorova

Da bi se mogli uredivati, Evorovi se moraju prvo selektirati. Moguce je
odabrati jedan ili viSe ¢vorova na istoj putanji ili kombinaciju ¢vorova s
vide razli€itih putanja, a jedini je uvjet da su putanje, u kojima se odabiru
évorovi, istovremeno selektirane.

Cvorovi se mogu selektirati za uredivanje na vise nadina:

o pritiskom lijeve tipke miSa na &vor, nakon ¢ega &vor mijenja boju
u crvenu, §to znaci da je oznacen. Nakon toga pritisne se i drZi
lijeva tipka miSa ako se Zeli Evor pomicati

e pritiskom i drzanjem lijeve tipke miSa na putanji odabrat ¢e se
najblizi Evor ovisno o strani na kojoj se kliknulo

e drzanjem lijeve tipke mida i povlaCenjem preko ¢vorova, odabrat
Ce se svi ¢vorovi unutar okvira za oznaCavanje.

ViSe ¢vorova moze se oznacavati i drzanjem tipke [Shift] te pritiscima
lijeve tipke miSa po Zeljenim &vorovima.

Cvorovi se takoder mogu dodati ili ukloniti iz odabira pomoéu kotagi¢a
miSa. Dovoljno se samo pozicionirati na neki od ¢vorova i okretati
kotaci¢ miSa prema gore za dodavanje ¢vorova ili prema dolje za
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uklanjanje €vorova iz odabira. Na donjoj desnoj slici nalazi se primjer na
kojem su oznaceni svi ¢vorovi na desnoj strani i proporcionalno
smanjeni tako da se dobije efekt perspektive.

4.2.2. Koristenje Node Tool trake alata

Node Tool pruza jednostavan nacin pristupa mnogim metodama
uredivanja évorova.

| & o

$ -2 YA N VYR S0 G| el el F £ MY D

t Insert new nodes into selected segments — umetanje novih
¢vorova na odabranu putanju. Osim ovog nacina, ¢vorovi se mogu
ubaciti i dvostrukim klikom lijeve tipke miSa na putanju. Za rad ove
naredbe potrebno je oznadciti najmanje dvije tocke izmedu kojih ¢ée se
dodati nova tocCka.

- Delete selected nodes — brisanje odabranih ¢vorova. Odabrani
¢vorovi mogu se obrisati i pritiskom na tipku Backspace, Delete ili
kombinacijom tipki Ctrl + Alt + lijeva tipka misa.

v Join selected nodes — pridruzivanje, tj. spajanje odabranih
krajnjih vorova. Obi¢no se spojeni ¢vor nalazi na sredini izmedu
krajeva &vorova.

= Break path at selected nodes — prekid putanje na selektiranom
¢voru. Svaki odabrani ¢vor pretvara se u dva krajnja ¢vora.

Join selected endnodes with a new segment — pridruzivanje
odabranih krajnjih ¢vorova. Ako se odabere viSe od dvaju zavrdnih
¢vorova, parovi krajnjih &vorova Ce biti spojena sa novim segmentom.

*
oo

s Delete segmet between two non-endpoint nodes — brisanje
segmenta izmedu dvaju ¢vorista bez krajnje tocke.

Make selected nodes corner — stvaranje kutova na odabranim
¢vorovima.

Make selected nodes smooth — stvaranje odabranih ¢vorova
glatkima.

Make selected nodes symmetric — stvaranje odabranih ¢vorova
simetricnim.
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Make selected nodes auto-smooth — automatsko stvaranje
odabranih ¢vorova glatkima.

= Make selected segments lines — od odabranih ¢vorova izrade se
ravne linije.

= Make selected segments curves — odabrani se segmenti
pretvaraju u krivulje.

» Convert selected object to path — konvertiraju se odabrani
objekti u putanje.

@ Convert selected object's stroke to path — pretvaraju se
odabrani obrubi u putanje.

® 77235 v 220me 3 mm <) — OKVIF za unos x i y koordinata odabranih ¢vorova.

Show clipping path(s) of selected objects — prikaz putanje
isjeCaka selektiranog objekta.

c Show mask(s) of selected object(s) — prikaz maske selektiranog
objekta.

" Show next editable path effect parameter — prikaz parametara
efekata za sljedecu raspolozivu putanju za uredivanje.

»# Show transformation handles for selected nodes — prikaz
okvira za transformaciju oznacCenih ¢vorova.

% Show Bezier handles of selected nodes — prikaz Bezierovih linija
selektiranih ¢vorova.

= Show path outline — prikaz obruba putanja bez primjene efekta.

4.2.3. Poravnavanje ¢vorova

Dijaloski okvir Align and Distribute (Object > Align and Distribute)

ima posebne naredbe za uredivanje ¢vorova kada se koristi alat Node
Tool. Na donjoj slici prikazan je dijaloski okvir koji se pojavljuje samo u
slu¢aju kada je alat Node Tool aktivan, tj. odabran.

EAIign and Distribute (Shift+ Ctrl+A) = ™

Nodes

Relative to: First selected

w3

Naredbe koje su dostupne u dijaloSkom okviru Align and Distribute:

e 7 poravnanje odabranih &vorova na zajednitku vodoravnu liniju

. § poravnanje odabranih ¢vorova na zajednic¢ku okomitu liniju
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171} N -
o vodoravno rasporedivanje odabranih ¢vorova

=

okomito rasporedivanje odabranih &vorova.

Naredbe omogucuju poravhavanje i ravhomjerno distribuiranje
odabranih ¢vorova kao $to je prikazano na donjoj slici.

4.2.4. Podesavanje €vorova i markeri

Moguce je podesiti i viSe ¢vorova u isto vrijeme pomocu alata Node
Tool. Osnovni princip je da se odabere grupa ¢vorova i nakon toga se
oznaci samo jedan ¢vor pritiskom lijeve tipke miSa. Drzanjem lijeve tipke
misa te pritiskom i drzanjem tipke [Alt] mogu se pomicati Evorovi.
Mogucnosti ovakve manipulacije nad putanjama najbolje su prikazane
na donjoj slici.

T

Markeri su objekti kao $to su glave strelica postavljene na neku putanju.
U Inkscapeu se mogu odrediti razli¢iti markeri za razli€ita podrucja.
Razli¢iti markeri mogu se postaviti na pocetak putanje, na sredinu i na
kraj bilo koje putanje. Srednji markeri su smjesteni na svakom &voru koji
nije prvi ili zadnji.

KX

Na gornjoj slici su prikazana tri razliita markera, predniji, srednji i zadniji,
koji se mogu proizvoljno nacrtati i postaviti kao marker ili uzeti iz veé
pripremljene biblioteke markera.

Ako se zeli koristiti neki nacrtani objekt koji ¢e postati marker, potrebno
je crtez pretvoriti u putanju, ako ve¢ nije pretvoren od prije (Path >
Object to Path).
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Nakon toga, potrebno je selektirati nacrtani objekt i odabrati naredbu
Object > Objects to Marker. Objekt ¢e nestati jer se spremio u
biblioteku markera. Za koridtenje markera potrebno je prvo nacrtati
putanju na kojoj se Zele koristiti markeri. Potrebno je i dodati Zeljeni broj
¢vorova na putanju jer se markeri postavljaju samo tamo gdje se nalaze
¢vorovi. Selektira se putanja s alatom Node Tool i odabere se u
dijaloskom okviru Fill and Stroke kartica Stroke style. Pod opcijom
Markers moguce je odabrati tri mogucénosti preko padajucih izbornika.
Prvi izbornik je Start markers koji oznacava pocetni marker, drugi je Mid
markers i zadnji je End markers. U svakom padaju¢em izborniku
moguce je odabrati prethodno nacrtani objekt koji smo postavili za
marker. Nakon odabira, markeri ¢e se pojaviti na oznacenoj putanji.

[Z#Fill and Stroke (Shift+Ctrl+F) F®
Fill [ Stroke paint =* Stroke style

Width: |0,265 = |mm |~

Dashes ~ 1000 7

Markers: |— ~ | |— — v
Joim: (I: (I_' ; :
Cap: m :

Order:@ Q &«
1R
-

Blur (%) 00

Opacity (%)

4.3. Efekti na putanjama

Live Path Effect ili skraceno LPE je sustav za primjenu efekata na
odabranu putanju. Za koristenje LPE-a potrebno je oznaciti putanju
(kostur putanje, ne ¢vor), ukljuciti dijaloski okvir Path Effect Editor (Path
- Path Effect Editor) i u njemu odabrati Zeljeni efekt pomocéu dugmeta
Add. Nakon odabira potrebno je samo pritisnuti na dugme Add path
effect. ViSe efekata moze biti povezano zajedno. Redoslijed kojim se
svaki efekt primjenjuje na putanju, moze se promijeniti klikom na
odgovarajucu strelicu (gore ili dolje). Svaki efekt moze se privremeno
iskljuciti klikom na ikonu ,oka“ pored efekta.
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¥ Path Effects (Shift+Ctrl+7) = ®
4 Bend
4 Bounding Box
+ = & &
Construct grid
Size o |5 =
SizeY: |5 =

Kada se odabere objekt pomocu alata Node Tool koji ima neki LPE,
izvorni ¢vorovi putanje su prikazani. Sama izvorna putanja moze biti
prikazana crvenom bojom, a vidljivost putanje kontrolira se ikonom
koja se nalazi u opcijama za upravljanje ¢vorova.

Bend efekt poprima postojecu putanju i dopusta joj da se "savije" na
dobro definiran nacin putem kontrolne putanje. Kontrolna putanja se
automatski kreira kada se postavi Bend efekt. Putanjom se moze
manipulirati na sve nacCine kao i s regularnom putanjom, uklju€ujudi i
dodavanje novih &vorova i povlagenje putanje. Na donjoj slici prikazan je
primjer koristenja Bend efekta na tekstu.

¥, ]
')4_@ (,06‘
RS o
Dg je besplatan p“

Ruler efekt pretvara bilo koju putanju u ravnalo. Ovaj efekt moguce je
postaviti na brojne putanje, potrebno je prvo izraditi putanju i nakon toga
primijeniti efekt Ruler na tu putanju. U postavkama ovog efekta moguce
je mijenjati velik broj opcija koje se nude. Tako je moguce odrediti u
kojem smijeru Ce biti okrenuto ravnalo (gore, dolje ili u oba smjera),
oznake obruba na pocetku, na kraju ili na po€etku i kraju, u kojim
jedinicama ¢&e biti ravnalo (px, mm, cm, in...) itd. Putanju je moguce
svinuti, a samim time i ravnalo koje se nalazi na toj putanji kao Sto je i
prikazano na donjoj slici.
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Efekt Knot pretvara bilo koju putanju u ¢vor. To se radi na taj nacin da
se na svakoj to¢ki gdje se putanje isprepli¢u stvara razmak i pojavljuje
tzv. prekidac. Prekidac je vidljiv kada je aktivan alat Node Tool, a sastoji
se od kruzne strelice centrirane oko tocke prijelaza. Klikom na
x<dijamant®, évor na tocci prijelaza se mijenja u tri stanja. Na donjoj slici
mogu se vidjeti sva tri stanja prekidaca.
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4.4. Vjezba: Izrada vizuala

1. Otvorite novi dokument formata A4 i izradite vizual kao na
slici iza posljednjeg zadataka.

2. Zaizradu Skara najprije izradite jednu stranu koju cete
kasnije duplicirati, zrcalno okrenuti i spojiti u oblik Skare.

boja za sve objekte u ovom zadatku je ffccOOff u
heksadecimalnom obliku,

nacrtajte pravokutnik sirine 100 mm i visine 10 mm te
ga pretvorite u putanju (Path = Object to Path). Pomocu
alata Node napravite dva zaobljenja ruba i to tako da
gornju stranu zaoblite s lijeve strane, a donju s desne kao
8to je prikazano na donjoj slici ovoga zadatka,

nacrtajte jos jedan maniji pravokutnik Sirine 50 mm i
visine 5 mm te ga zalijepite na prethodni objekt,

nacrtajte elipsu sirine 45 mm, visine 30 mm, Sirine
obruba 5 mm i zalijepite ju na prethodne objekte tako da
dobijete tri spojena objekta kao na donjoj slici,

nakon $to ste uspje$no odradili gornji dio zadatka,
potrebno je sve objekte selektirati i grupirati (Object >
Group). Kada su grupirani, potrebno je grupu duplicirati
(Edit &> Duplicate) i vertikalno zrcaliti (Object = Flip
Vertical), tako da se dobiju dva dijela 3kara,

na kraju je potrebno svaki objekt rotirati za 20 stupnjeva i
na sredini spojiti tako da tvore oblik Skara.

3. Zaizradu ikone lista:

nacrtajte pravokutnik Sirine 160 mm i visine 210 mm,
koji ima crni obrub debljine 2 mm, bez ispune,

u gornjem desnom kutu, prvo napravite kvadrat Sirine i
visine 45 mm te ga namjestite tako da mu se samo lijeva
i donja stranica dodiruju s donjim objektom, kao $to je
prikazano na donjoj slici

oznacite gornji kvadrat, drzite tipku [Shift] i oznacite i donji
pravokutnik. Nakon toga odaberite naredbu Path - Cut
Path koja Ce odrezati na tom mjestu obrub donjega
pravokutnika,

oznacite odrezani gornji desni kut pravokutnika i rotirajte
ga za 180 stupnjeva te pomocu alata Pen spojite rubove
tako da Cine trokut (za ljepSi spoj linija, potrebno je
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odabrati na kartici Stroke style, pod opcijom Join,
naredbu Round join i pod opcijom Cap, naredbu Round
cap).
Priblizno na sredini stranice, pomocu alata Pen nacrtajte liniju
od desnog do lijevog ruba ikone lista i na kartici Stroke style,
izbornika Fill and Stroke promijenite oblik u isprekidanu liniju
(opcija Dashes) debljine 0,8 mm.

Postavljanje nacrtanih Skara u marker:

- duplicirajte Skare te jedne od njih proporcionalno
smanjite na Sirinu 9 mm i visinu 5 mm,

- smanjene Skare postavite da budu marker, tako
da ih oznacite i odaberete naredbu Object >
Objects to Marker.

Na isprekidanoj liniji dodajte 3 ¢vora alatom Node, opcijom
Insert new nodes into selected segments, u dodatnim
opcijama alata.

Na isprekidanu liniju dodajte poc&etni, sredniji i zavrsni marker
nacrtanih Skara u izborniku Fill and Stroke, na kartici Stroke
style > Markers.

Spremite crtez pod nazivom Izrezivanje.svg.
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5. Precrtavanje slika i dodatna dorada
grafike

Po zavrsetku ovoga poglavija moci cete:
e precrtati sliku u vektore
e preurediti sliku koristeci filtre.

5.1. Precrtavanje slika ili vektorizacija

Inkscape ima mogucénost konvertiranja rasterskih slika u krivulje
(vektore), tj. elemente. Taj se postupak haziva precrtavanje, tracing ili
vektorizacija. Precrtavanje slika nije nimalo lagan zadatak i moze proci
dosta vremena, pokusaja i promasaja do nekoga iskoristivog crteza u
vektorskome formatu.

Za precrtavanje neke slike potrebno je prvo uvesti sliku koja se Zeli
precrtati u Inkscape. Nakon toga se otvara dijaloski okvir Trace Bitmap
koji se nalazi na izborniku Path, a do kojega se moze doéi i preko
tipkovnoga pre€aca [Shift] + [Alt] + [B]. Na dolje prikazanoj slici mozZe se
vidjeti dijaloSki okvir Trace Bitmap s resetiranim postavkama.

-
4@ Trace Bitmap (Shift+Alt+B) [E=EE
K5 Trace Bitmap (Shift+Alt+B) H &

Mode | Options | Credits SIOX foreground selection

Single scan: creates a path Preview
@ Brightness cutoff Threshold: | 0,450 :
Edge detection Threshold: | 0,650 :
Color quantization Lolors: |8 :
Invert image Ka rlovac z
Multiple scans: creates a group of paths 500 m
Brightness steps Scans: |8 :
Colors

Grays

V| Smooth [V] Stack scans Remove background

Reset Stop OK

DijaloSki okvir sastoji se od tri kartice, na prvoj kartici Mode odabire se
nacin precrtavanja slike, na drugoj kartici Options mogucée je podesiti
razne dodatne mogucnosti, a na tre¢oj kartici Credits se moze vidjeti tko
je izradio ovaj koristan dodatak.

Kartica Mode podijeljena je na brojna podrucja. Na lijevoj strani nalaze
se dvije sekcije, Single scan i Multiple scans. U prvoj opciji, Single
scan: creates a path, zavrsni crtez je izraden od samo jedne krivulje,
dok se u drugoj opciji, Multiple scans: creates a group of paths,
zavrsni crtez izraduje od viSe krivulja. Na desnoj strani nalazi se prozor
za pretpregled u kojemu je moguce na brz nacin vidjeti kako ¢e izgledati
konacan rezultat. Opcija Live Preview sluzi za pretpregled kona¢noga
rezultata ovisno o odabranim opcijama, a dugme Update sluZi za
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osvjeZavanje prikaza u pretpregledu, a mogucée ju je odabrati samo ako
nije uklju¢ena naredba Live Preview.

Svakoj slici treba pristupiti individualno i isprobati moguénosti koje ¢e
dati najbolji rezultat za upravo tu sliku. Praksa je da se prilikom otvaranja
ovoga dijaloskog okvira pritisne dugme Reset kako bi se resetirale
prethodne postavke i krenulo s odabirom opcija iz poéetka. Prvo je
potrebno odabrati, tj. selektirati Zeljenu sliku koja se Zeli pretvoriti u
vektorski crtez. Nakon odabira Zeljenih opcija potrebno je pritisnuti na
dugme OK kako bi se kreirao vektorski crtez iz slike. Nakon pritiska na
dugme OK, dugme dobije sivu boju, a kada poprimi prvobitan izgled,
proces je zavrsen.

Po zavrSetku precrtavanja, izradena vektorska slika je postavljena na
isto mjesto kao i izvorna slika, odnosno na njezin vrh. Nije potrebno
zatvarati dijaloSki okvir da bi se oznacila i odvukla nova vektorska slika
na neko drugo mjesto u dokumentu. Nova slika je obi¢no grupirana i
sastavljena od vide elemenata pa je prvi korak razgrupiranje slike
(Object = Ungroup). Ako nova slika i dalje ostaje u jednome komadu i
nije moguce dohvatiti svaki element posebno, potrebno je sliku rastauviti
pomocu druge naredbe, Path - Break Apart. Nakon ove naredbe slika
se rastavila na zasebne elemente koje je potrebno urediti, postaviti
Zeljenu boju na njih, veli€inu i drugo.

Kod opcije Multiple scans: creates a group of paths moguce je
odabrati jo§ dodatne tri opcije, Smooth, Stack scans i Remove
backround.

Kada je opcija Smooth odabrana, ona se primjenjuje na izvornu sliku
prije precrtavanja. Ova opcija daje efekt zagladivanja izmedu razli€itih
susjednih piksela te se tako dobije bolji konagan rezultat.

Opcijom Stack scans odreduje nacin na koji ¢e biti definirane krivulje.
Ako ova opcija nije oznacena, krivulje se ne preklapaju, a ako je
oznacena, tada svaka krivulja ukljuuje podrucje, tj. povrsinu iznad nje
po Z poretku.

Opcijom Remove backround briSe se najniZe rangirana krivulja po Z
poretku, tj. briSe se pozadina.

Na lijevoj strani donje slike prikazan je izvorni prometni znak, u PNG
formatu. Nakon uvoza te slike u Inkscape i precrtavanjem slike pomocu
naredbe Trace Bitmap, izradena je slika u vektorskome formatu kojoj je
moguce promijeniti svaki element poput boje ili veli€¢ine slova, boje
strelice, pozadine i mnoge druge stvari (kao $to je vidljivo na desnoj
strani donje slike). Za dobivanje konac¢ne slike u vektorskome formatu
koristila se opcija Colors koja se nalazi u odjeljku Multiple scans:
creates a group of paths. Pod opcijom Scans upisan je broj 2 i
odabrane su opcije Smooth i Stack scans. Nakon razgrupiranja
elementi su se obojili u proizvoljne boje koje su prikazane na donjoj
desnoj slici.
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Karlovac Karlovac
500 m 7 500 m e

5.2. Uporaba filtara

Filtri omogucuju promjenu elementa dodavanjem neke odredene
teksture na ispunu elementa ili njegov obrub. Tako se moze postaviti
zamucenje na neki element, sjena, modifikacija boje elementa, tekstura i
drugo. Inkscape nudi vise od stotinu veé unaprijed pripremljenih filtara
koji se mogu primijeniti na element preko izbornika Filters. Mnogi filtri
imaju jo§ dodatni dijaloski okvir u kojemu se mogu podesiti razni
parametri prije primjene.

S tolikom koli€inom unaprijed pripremljenih filtra, traZenje ispravnoga
nije lako, ali su od velike pomoci kategorije koje omoguéuju lakde
snhalazenje.

Za primjenu nekoga filtra na odredeni element, potrebno je prvo oznaditi
zeljeni element i nakon toga odabrati zeljeni filtar.

Na donjoj slici prikazan je pocetni crtez na koji ¢e se primijeniti razni filtri.

@ Inkscape g

Jedan zanimljiv filtar naziva Fat Oil nalazi se odmah u prvoj skupini
Filters > Bevels na izborniku. Uporabom ovoga filtra, elementi ¢e
izgledati kao da su sacinjeni od masnoga ulja (kao na donjoj slici).

Inkscape ‘f.

Za poniStavanje bilo kojega filtra primijenjenoga na element, potrebno je
oznaciti element koji na sebi ima neki filtar i odabrati naredbu Filters >
Remove Filters. Nakon toga, element se vraca u svoje izvorno stanje.

Ako se zeli zamutiti neki element, moguce je u izborniku Filters = Blurs
odabrati jednu od viSe naredbi za zamucenje, a neke od njih imaju
dodatan dijaloski okvir u kojemu je moguée pode$avati dodatne
parametre zamucenja. Odabirom naredbe Blur otvara se dijaloSki okvir
prikazan na donjoj slici u kojemu je moguée podesiti okomito i
vodoravno zamucéenje, a ako se oznaci kva€icom opcija Live preview,
sve promjene se vide u realnome vremenu.
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Q Elur u
_I-Iorizontal blur 313 15
Yertical blur 2,09 =

[] Blur content only

’ Close H Apply ]

Nakon $to se podese opcije na zeljene vrijednosti potrebno je pritisnuti
dugme Apply za primjenu te naredbe na oznacene elemente. Na donjoj
slici prikazani su elementi nakon koristenja naredbe Blur.

@ Inkscape ¥
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5.3. Vjezba: Redizajn logotipa

1.

Izradite redizajn logotipa u vektorskome obliku koji ¢e
izgledati kao na donjoj slici. Sadasnja verzija logotipa postoji
samo kao slika, Logotip.png.

Izradite novu stranicu dimenzije 2200 x 1600 px.

Uvezite sliku Logotip.png te ju precrtajte pomocu naredbe
Trace Bitmap.

Potrebno je obrisati tekst ,Designed by Mia.Designs -
Freepik.com® s logotipa.

U redizajnu se koriste tri nove boje:

- Plava ima heksadecimalni kdd boje 007eacff

- Svijetlo naran¢asta ima heksadecimalni kéd boje ffb380ff
- Siva ima heksadecimalni k6d boje 8c8c8cff

Spremite logotip pod nazivom Logotip_konacan.pdf

MEN &

CLOTHES WE WEAR
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6. Upoznavanje radnoga prostora
programa GIMP

Po zavrsetku ovoga poglavija moci cete:
e instalirati i pokrenuti program GIMP
e prepoznati dijelove sucelja programa
e podesiti parametre pri stvaranju novoga dokumenta

e otvoriti postojecu datoteku te pregledati i objasniti njena
svojstva

e zumirati, koristiti ravnalo i pomiéne linije
e prilagoditi sucelje vlastitim potrebama.

6.1. Pokretanje programa i upoznavanje sucelja
GIMP-a

6.1.1. Sustavi na kojima je dostupan GIMP i instalacija
programa

GIMP je najpopularnija besplatna aplikacija otvorenoga kéda za
stvaranje i obradu rasterske grafike. Koristi se za retuSiranje, crtanje,
uredivanje slika, pretvaranje slika u razli¢ite formate te za jo$ niz korisnih
amaterskih i profesionalnih zadataka.

GIMP je dostupan za korisnike operacijskih sustava Windows, Mac i
GNU/Linux.

Proces instalacije programa GIMP na sustavima Windows prili¢no je
jednostavan.

Potrebno je preuzeti instalacijsku datoteku programa sa stranice
http://www.gimp.org/downloads/. Najlak3e je preuzeti instalacijsku
datoteku odabirom bilo kojeg od dva dolje navedenih linkova.

Download GIMP 2.10.8 Download GIMP 2.10.8

via BitTorrent directly

Nakon odabira, potrebno je instalacijsku datoteku.exe spremiti na
racunalo i pokrenuti. Proces same instalacije slijed je nekoliko osnovnih
opcija koje je potrebno procitati i odabrati one koje odgovaraju
zahtjevima (primjerice odabir jezika).

Zanimljivosti i napomene

Najpoznatiji sustavi za koje
je dostupan program GIMP:
Windows 8, Windows 7,
Windows Vista, Windows
XP, Snow Leopard 10.6X,
Leopard 10.5X, Tiger
10.4X, Debian, Fedora,
Gentoo Portage, Slackware,
OpenSUSE, Ubuntu...
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6.1.2. Pokretanje GIMP-a

Za pokretanje programa u sustavu Windows, odabere se Start > Svi
programi - GIMP. Prilikom prvoga pokretanja program ¢e se sporije
otvarati jer podeSava razne opcije, ali ve¢ drugi i svaki sljedeci put
pokretanje ¢e biti puno brze.

Za pokretanje na sustavima Mac, potrebno je odabrati mapu
Applications te potom GIMP.

Za pokretanje GIMP-a na Linux sustavima, klikne se na Applications ->
Graphics > GIMP.

6.1.3. Upoznavanje sa suceljem

Kada se pokrene GIMP, otvaraju se tri prozora, od ¢ega su lijevi i desni
namijenjeni raznim alatima, dok se u srediSnjem, radnom prozoru,
ureduje slika i pristupa izbornicima.

Osim navedenog nacina rada, postoji i drugi nacin, tzv. Single-Window
Mode, koji omogucava rad u samo jednom prozoru, $to znaci da se tri
prethodna prozora spajaju u jedan veliki prozor. Za promjenu prikaza iz
tri odvojena prozora u jedan veliki prozor, odabere se u srediSnjem
prozoru izbornik Windows - Single-Window Mode. Ovakav nacin rada
karakteristi¢an je i za druge grafi¢ke alate te je puno prakti¢niji od
uporabe zasebnih prozora. Prozori su ujedno i prilagodljive veli€ine, $to
znaci da se mogu uhvatiti za rub i povecati ili smanijiti, ovisno o potrebi.

(1) (2]

4 GNU Imagd Manipulation Program

Elle Edit Select View |mage Layer Colors Iools Fiters Windows Help

soacino ot
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1. Toolbox (Kutija s alatima) — prozor koji se nalazi s lijeve strane,
podijeljen na dva dijela. U gornjoj polovici Toolboxa nalaze se
alati kojima se obavljaju razliite radnje u programu, a u donjoj
polovici opcije vezane za trenutno odabrani alat.

2. Sredidnji prozor je radni prozor i u njemu se odvijaju sve radnje
na otvorenoj slici.

3. Desni prozor sluzi za organiziranje slojeva (engl. Layers),
povijesti (engl. History), palete boja (engl. Color pallete) te sadrzi
razne dodatne opcije koje se ne nalaze u Toolboxu.

6.2. lzrada novoga dokumenta

Prije poCetka rada u GIMP-u vazno je znati kako izraditi i otvoriti neku
sliku. Prazna slika koristi se kada se zeli crtati i bojati, a poCetnicima je
korisna za istrazivanje novih alata i svih moguénosti koje nudi Toolbox.

6.2.1. Otvaranje prazne slike

Ako se zeli otvoriti prazna slika, odabere se izbornik File > New nakon
kojeg se otvara prozor Create a New Image.

& Create a New Image *
Termnplate: ~
Image Size

Width: | 1024 =
Height: | 768 2 pxv
1024 = 768 pixets

i Fe
300 ppi, RGB color

+ Advanced Options

Help Reset oK Cancel

U ovom izborniku moZze se odabrati velicina prazne slike koja je u gore
navedenom slu€aju 1024 x 768 px (piksela). Veli¢ina se moze upisati
ruéno, gdje se posebno upisuje Sirina i posebno visina ili se moze
odabrati pomocu okretnog dugmeta.

Osim veli€ine slike, pritiskom na oznaku jedinice odabire se i jedinica
koja se zeli koristiti, a koja ovisi o0 namjeni slike na kojoj se radi. Tako se
mogu odabrati pikseli, in¢i, milimetri, centimetri, metri ili neke druge od
ponudenih jedinica. Nakon odabira jedinice, odabire se okomito ili
vodoravno usmjerenje slike.
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u Create a New Image b
Template: w
Image Size

Width: |1024 =
Height: | 768 > | pixels
g [[a)| 192 inches
3000
millimeters
+ Advanced Options points
picas
Help Be centimeters K Cancel
meters
feet
yards

typogr. points
typogr. picas

Kada se zavrsi s osnovnim podeSavanjima nove slike, moguce je
odabrati i napredne opcije pritiskom na naredbu Advanced Options ili
na oznaku ,+“ nakon ¢ega se otvara dodatni izbornik.

Piee: | Create a New Image s
Template: ~
Image Size

Width: | 1024 =
Height: | 768 = v

1024 = 768 picels
72 ppi. RGB color

R

= Advanced Options

X resolution: | 72,000 : 1

Y resolution: | 72,000 = ? pixelsfin

Color space: | RGE color -
Precision: 8-bit integer ~
Gamma: Perceptual gamma (sRGE) ~

Color manage this image
Color profile: |Built-in RGB (GIMP built-in sRGB) ~
Fill with: Background color ~

Comment:  |Created with GIMP

Help Beset QK Cancel

U dodatnom izborniku mozZe se odabrati X i Y rezolucija slike, koja za
tisak mora biti minimalno 300 ppi (pixels per inch). U gore navedenom
primjeru je 72 ppi.

U izborniku Color space odabrano je RGB color, Sto znaci da ¢e novi
radni prostor biti u boji, to€nije u RGB modelu boja (viSe o modelima

boja u poglavlju 2.3. Priprema slike za tisak i web, str. 19). Nudi se jo$
opcija Grayscale, odabirom koje radni prostor postaje crno-bijeli.
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Izbornik Precision nije postojao u starijim verzijama GIMP-a, a sada,
pomocu ove moguénosti, moze se raditi s mnogo vise informacija o boji i
detaljima na slikama, $to znaci da ova podrska daje mogucénost
stvaranja super glatkih prijelaza boja na slici.

U izborniku Gamma moguce je odabrati izmedu dvaju ugradenih ICC
profila koji se automatski dodjeljuju slici, dok se u izborniku Color
profile moze dodijeliti novi ICC profil na sliku koji je prethodno spremljen
na ra¢unalu.

Jos jedna priliéno vazna opcija u dodatnom izborniku jest i izbornik Fill
with gdje se odabire kakva ¢e biti pozadina slike, u boiji ili prozirna.

U komentar se mogu napisati neki op¢i podaci o slici, ali za stvaranje
slike to nije nuzno.

Nakon podes$enih svih postavki, odabere se dugme OK.

6.2.2. Otvaranje fotografije ili slike

Osim stvaranju nove slike, program GIMP namijenjen je i obradi neke
postojece slike ili fotografije. Otvaranje se radi, kao i kod vecine drugih
programa, odabirom izbornika File > Open.

4l GNU Image Manipulation Program
File Edit 5Select View Image Layer Colors Toels Filters Windows Help

* Mew... Ctrl+M
Create ¢
T Open... Ctrl+ O
" Open as Layers... Ctri+Alt+0
@ Open Location...
Open Recent »

Pojavljuje se sko&ni prozor Open Image u kojem se prikazuje struktura
mapa i podmapa na racunalu. Kada se pronade Zeljena fotografija ili
slika, odabere se i pritisne dugme Open.

& Open Image X
# 4|5 Polaznik
Places Name + Size  Modified 4 Figuo
| Search Baloni PG TI23kB 22.4.2015. —
= Recently Used 2 Bubamara tif 889kB 2242015,
= Polaznik 2 Bubamara_povecana.tif 554,4kB 17.6.2015.
[ Deskiop & Buketjpg 3524 kB 2442015,
& Windows7 05 (C) = DjevojkaJPG 28MB 2842015,
- Dats2 (D) = Dvoracjpg 10MB 2442015,
= DVD RW gogen (F) = Hipster.JPG 958,9kB 2842015
i Pictures A Jabuka.png 2666 kB 2042015,
8 Documents = Konj.JPG 958,7kB 2042015
% Nepotrebni_baloni.png 367,6kB 24.4.2015.
= Pisajpg 1,5MB 2242015,
& Planinajpg 1,6MB 742015
= Ptica PG 4106 kB 21.4.2015.
= Ptica_u_letujpg 3,5MB 1232015,
= Rezolucijajpg 13MB 2042015,
+ - ) Slojevixct 1657kB 452015 v
[ Show All Files

) Select File Type (Automatically Detected)

Zanimljivosti i napomene

Odabranu sliku moguce je
otvoriti i dvostrukim
pritiskom lijeve tipke miSa
na sliku. Moguce je i
oznaditi viSe slika odjednom
i sve ih otvoriti istovremeno
pritiskom na dugme Open.
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Nakon toga prikazuje se odabrana fotografija ili slika u srediSnjem,
radnom prostoru.

Ty o x
Crrill o S T
Easan ! [ . v =
T n¥a -
KEACE/ 7
sRina _:_
v

[ ]
|[f e i
Es

4

U programu GIMP moguce je istovremeno otvoriti viSe slika pa se one
nakon otvaranja nalaze svaka u svojoj kartici, kako je i oznaceno
crvenim okvirom na dolje prikazanoj slici. Odabrana kartica razlikuje se
od ostalih po tome $to je izboCena kao drugi po redu na dolje prikazanoj
slici.

“. [Baloni] (imported)-18.0 (RGE color 8-bit gamma integer, GIMP built-in sRGE, 1 layer) 40006000 - GIMP

File Edit Select View |mage Layer Colors Tools Filters Windows Help

TeEnsan ]

Slika, tj. kartica koja je oznaena, moze se zatvoriti pritiskom na dugme
X pokraj svake kartice ili preko izbornika File > Close View.

Ako se zele zatvoriti sve kartice odjednom, a i dalje ostati u programu
GIMP, odabere se naredba File = Close all.

6.3. Pregled informacija o slici i prilagodba
programa

U ovom poglavlju ¢e se vidjeti kako se moze doci do detaljnih
informacija o bilo kojoj slici u smislu veli€ine, rezolucije, broju piksela,
nacinu prikaza boje itd. Osim toga, vidjet ¢e se kako je moguce
prilagoditi program tako da odgovara svakom korisniku, od vrste sucelja
pa do odabira alata individualnim pre€icama.

6.3.1. Pregled informacija o slici

Kada je slika otvorena u GIMP-u, velik broj informacija o samoj slici
prikazuje se u zaglavlju programa, bez potrebe za odabirom neke
posebne naredbe. Informacije koje se odmah nude su:
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1. Naziv otvorene slike nalazi se odmah na pocCetku naslovne
trake. U ovom slu€aju naziv slike je Buket.

2. Odmah pored naziva slike nalazi se tzv. Color Mode, koji je u

ovom slu€aju RGB.

3. Takoder, jedna korisna informacija je i broj slojeva na slici. Slika

Buket ima 1 sloj.

4. Dimenzija otvorene slike nalazi se na posljednjem mjestu. Slika
Buket je dimenzije 2592 x 1944 piksela.

o ©6

©
| (4]

File Edit Select View Image Layer Colors Tools Filters Windows Help

DOP % &
DA AD L

L 2 1 T

T
& Bullet] (imported)-19.0 (RGB colorlg-bit gamma integer, GIMP built-in sRGB, 1 layer) 2592x1944 - GIMP.

&
£ Z
FIRR¥aEB
KREASCE/ 2
BLONERY
bw e

]

saale
Transtorn:| | W A
Drection
@ Normal (Forward)
O Conectie (Backward)

Interpoiation Cuic

Gipping gt

[ show image preview

lImage opacity wo ] |

Gudes voowa V] T |
9

[ Keep aspect (shi) 8

[] Around center (cery

Osim tih osnovnih informacija o slici koje su odmah dostupne i vidljive,
program GIMP nudi i dodatna svojstva o otvorenoj slici koja se nalaze

na izborniku Image - Image Properties.

U tom izborniku vidi se kolika je
maksimalna dimenzija slike, ako
se ona ispisuje (Print size).
Takoder je vidljiva i rezolucija
slike (Resolution), koja je u ovom

& Image Properties

[Buket] imported)-19

Size in pixels:

.o. Image Properties

8|

Color Profile  Comment

2582 x 1944 pixels

v . . .. Print size: 219,46 = 164,59 millimeters
slucaju__300 X 300 ppi. Mlnlmalna Resolution: 300 x 300 ppi
rezolucija slike za tisak je 300 Color space: RGB color

Precision: 3-bit gamma integer

ppi. Korisne informacije su jos

. M iy . . . File Name: C:\Users\Pol...es\Buket.,jpg
mformacu(.—:' o] ve.llcml (File Size) i Fle Size: 352.4 kE
formatu slike (File Type). File Type: JPEG image

Dodatan izbornik Image
Properties zatvara se pritiskom
na dugme Close.

Size in memory:
Undo steps:
Redo steps:

Number of pixels:
Number of layers:
Number of channels:
Number of paths:

Help

47,0 MB
Mone
MNene

5038348
1
0
0

Close
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6.3.2. Prilagodba programa

Postavke programa moguce je prilagoditi na vrlo jednostavan nacin,
preko izbornika Edit - Preferences. Otvara se skocni prozor
Preferences u kojem korisnik moze promijeniti gotovo sve postavke.

U prvom izborniku, Environment, postoji moguc¢nost promijene
minimalnoga broja ponistavanja, tj. Povijesti preko opcije Minimal
number of undo levels. Tu opciju najbolje je postaviti na 30 ili vise. Ispod
te opcije nalazi se opcija Maximum undo memory koju se takoder
preporucuje postaviti na viSe od 150 MB. Na dolje prikazanoj slici te
dvije opcije oznacene su crvenim okvirom.

Ako se Zeli promijeniti zadana postavka veli€ine prazne slike prilikom
njenog stvaranja, odabere se izbornik Default Image. Ovaj izbornik jako
sli¢i izborniku koji se pojavljuje kada se stvara nova slika, a upravo je i to
cilj, da se postave nove zadane postavke za veli€inu slike, rezoluciju,
boju pozadine itd.

Kada se &esto koristi neka opcija ili alat u GIMP-u, radi udtede vremena
koriste se tipkovni precaci, bilo za odabir nekog alata ili neke akcije.
Tako je, primjerice, za kopiranje odredenog elementa na slici tipkovni
precac [Ctrl]+C, Sto Stedi vrijeme u odnosu na odabir te iste naredbe
preko izbornika Edit >Copy. Upravo takve skracenice za pojedinu
akciju moguce je mijenjati preko izbornika Interface. Potrebno je
pritisnuti na dugme Configure Keyboard Shortcuts nakon kojeg se
pojavljuje skoéni prozor u kojem je moguce dodijeliti gotovo svim
akcijama u GIMP-u odgovarajuéi tipkovni pre€ac, ako ve¢ ne postoiji.

&) Preferences X

m System Resources
u Color Management
T Image Import & Export
Tool Options

=] @ Default Image

System Resources

Resource Consumption

Minimal number of undo levels: 5

. Default Grid Maximum undo memony: 1014 2 Megabytes |~
= E Interface Tile cache size: 4155622 : Kilobytes v
ﬁ_l Theme Mazximum new image size: 123 = Megabytes |+
lcon Theme Mumber of threads to use: 4 :
=
58 Toolbox Hardware Acceleration
;'-J' Dialog Defaults [ Use OpenCL
BN
S Help System Image Thumbnails
'E Display Size of thumbnails: Mormal (128x128) o
Window Management Mazxirmum filesize for thumbnailing: |4 = Megabytes |+
=] Image Windows
E Document History
E‘ Appearance
— Keep record of used files in the Recent Documents list
Title & Status
Snapping

=] D_n"’] Input Devices

! Ineudt Cantrallere

Help Reset aK Cancel
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6.4. Uporaba zumiranja, ravnala i pomicne linije

U ovom poglavlju obrazloZit ée se ¢emu sluZi zumiranje u programu,
kako se koristi te ¢e se navesti tipkovni pre€aci koji se mogu koristiti.
Pojasnit ¢e se i uporaba ravnala i pomic¢ne linije koje se koriste za to¢no
poravhavanje elemenata po dokumentu.

6.4.1. Zumiranje

Kada se slika otvara u programu GIMP, prikaz se pode$ava tako da
slika stane u slobodan prostor u radnom prozoru. Prilikom rada na slici,
Cesto je potrebno zumirati i vidjeti izgled slike, fotografije na 100 % ili
viSe, a takoder je potrebno i vidjeti kompletnu sliku na ekranu, za sto se
potrebno udaljiti od originalne veli€ine.

Neki od nacina za udaljavanje i priblizavanje slike su:
1. Uporaba alata za zumiranje koji se nalazi u Toolboxu.

2. Odabir dugmeta za prilagodbu slike veli€ini prozora — nalazi se u
gornjem desnom kutu radnoga prozora. Tipkovni pre¢ac za
uporabu ove naredbe je [Shift]+[Ctrl]+J.

3. Odabir ili upis Zeljenoga postotka zumiranja s padajuéeg
izbornika na dnu radnoga prozora te potvrda tipkom [Enter].

\o \9

Zanimljivosti i napomene

Priblizavanje ili udaljavanje,
bilo koriStenjem povecala
koje se nalazi u alatima s
lijeve strane ili upisivanjem
postotka na dnu programa,
ne utje€e na veli€inu slike.
To je samo prikaz slike na
ekranu.

8 (Bukel] (imported)-13.0 (RGB color &-bit gamma integer, GIMP buit-in $RGE, 1 layer) 29321944 - GIMP - o x
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Jos jedan nacin zumiranja slike jest pritisak miSem na sliku u radnom
prostoru, nakon ¢ega se pritisne i drzi tipka [Ctrl] te se kotaCi¢em miSa
priblizava ili udaljava slika.
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Najlaksi naCin za zumiranje slike jest odabir brojeva na tipkovnici:
1 =100 %, 2 = 200 %, 3 =300 %, itd. Osim tih preaca, korisne su joS i
tipke [+] za priblizavanje i [-] za udaljavanje.

Zumirati se moze i preko izbornika View - Zoom.

6.4.2. Ravnala

Ravnala su korisna za:
e odredivanje to¢ne lokacije mi$a na slici
e kreiranje pomicnih linija prema odredenoj lokaciji miSa na ravnalu
e kreiranje Sample Pointsa koji se stvaraju tako da se drzi
pritisnuta tipka [Ctrl] i pomi€u pomi&ne linije.

Ravnala se prikazuju samo kada se otvori neka slika ili kada se stvori
nova slika, tj. samo kada se nesto nalazi u radnom prozoru. Smjestena
sSu na gornjoj i na lijevoj strani slike u radnom prozoru.

ﬁ [Buket] (imported)-19.0 (RGE color 8-bit gamma integer, GIMP built-in sRGB, 1 layer) 2592x1944 — GIMP
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Ravnala se mogu prikazati ili sakriti na izborniku View - Show Rulers
ili pomocu tipkovnog pre€aca [Shift]+[Ctrl]+[R].

U podnozju dokumenta moze se promijeniti mjerna jedinica za prikaz
ravnala te vidjeti joS neke dodatne informacije:

1. Dva broja odvojena zarezom prikazuju koordinate miSa na
otvorenoj slici. Gorniji lijevi kut slike su koordinate ,0, 0“ dok su
donji desni kut koordinate ukupne veli€ine slike. Kako se pomice
mi$ po slici, tako se i mijenjaju brojevi te se moze iS€itati tocna
koordinata. Jedinica u kojoj se prikazuju koordinate jednaka je
jedinici u kojoj se prikazuje ravnalo.

2. Zadana vrijednost ravnala je u pikselima (skracenica ,px“), a ako
se Zeli prikaz ravnala promijeniti u neku drugu jedinicu, odabere
se padajuci izbornik i iz njega Zeljena jedinica.

3. Osim u zaglavlju, ime otvorene slike nalazi se i u radnom
prozoru, dok se u zagradi pokraj imena nalazi informacija o tome
koliko sistemske memaorije ta slika zauzima.
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6.4.3. Pomicéne linije

Pomicne linije ili Guides su linije koje se mogu pomicati i postaviti
vodoravno ili okomito preko otvorene slike u radnom prozoru. Sluze za
to€no poravnavanje objekata na slici.

Pomicna linija postavlja se tako da se miSem dode do ravnala, bilo
okomitog ili vodoravnog, pritisne i drZi lijeva tipka miSa te se miSem
pomice na Zeljenu poziciju. Nakon uspjesno izvedene akcije, prikazat ¢e
se linija na slici u radnom prozoru. Linija se moze i dalje pomicati kada je
u radnom prostoru, a kada viSe nije potrebna, odabere se alat Move
Tool (koji se nalazi na izborniku Tools > Transform Tools - Move) i
miSem se odvuce natrag na ravnalo.

Pomicne linije su plave isprekidane linije, dok je oznaena pomicna linija
prikazana crvenom bojom, kako je oznaceno crvenim okvirom dolje na
slici.
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Zanimljivosti i napomene

Skocni prozor New Guide

obi¢no se otvara u pozadini,

tj. iza glavnog prozora
programa pa ga je potrebno
odabrati s programske
trake.

Osim dodavanja pomic¢nih linija miSem, moguce je i preko izbornika
pozicionirati pomi¢nu liniju na to¢no odredeno mjesto na slici, vodoravno
ili okomito. Odabere se naredba na izborniku Image - Guides > New
Guide. U novootvorenom sko&nom prozoru odabere se smjer,
vodoravan ili okomit te vrijednost na koju se zeli postaviti pomi¢na linija.
Nakon odabira, pritisne se dugme OK.

U izborniku Image > Guides moze se jo$ dodati pomicna linija po
postotku, mozZe se postaviti ovisno o selekciji i mogu se obrisati sve
pomiéne linije odjednom odabirom naredbe Remove All Guides u
izborniku Image - Guides.

4 Script-Fu: New Guide >
Direction: |Horizontal w
Position: 160

Help Reset 0K Cancel

6.5. Vjezba: Upoznavanje radnoga prostora

1.

N g &

Stvorite novu sliku dimenzije 1000 x 700 px, 300 ppi X iY
rezolucije, prozirne pozadine.

Spremite sliku pod nazivom Prozirna_pozadina.xcf sa svim
ponudenim opcijama.

Stvorite novu sliku dimenzije 700 x 800 px, 150 ppi XiY
rezolucije, bijele pozadine.

Novootvorenu sliku bijele pozadine zumirajte na 70 %.
Postavite pomicne linije na 200 px i 400 px vodoravno.
Postavite okomite pomicne linije na 70 % i 80 % slike.
Provjerite komentar na slici i koliko slika ima ukupno piksela.

Ukupan broj piksela:

Zatvorite sliku Prozirna_pozadina.xcf.
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7. Rad s rasterskom grafikom

Po zavrsetku ovoga poglavija moci cete:
e navesti najvaznije formate slika i objasniti njihove razlike
e definirati pojam rezolucije
e podesiti rezoluciju slike

e jzabrati odgovarajucu rezoluciju slike za objavu na web-
stranicama i za tiskanje

e izvesti i spremiti gotov uradak.

Digitalne slike pojavljuju se u reklamama, novinama, na Internetu,
televiziji i dr. Relativno niska cijena digitalne slike potaknula je mnoge
ljude da istraZuju svoju kreativnost kroz razne programe za obradu slika.
GIMP nudi mogucnost odabira veli€ine slike, oblika, kontrolu ekspozicije,
omogucuje dodavanije teksta, slike na sliku, dijelova slika na neku sliku i
drugo. To se naziva obrada rasterske grafike jer je slika na zaslonu
sacinjena od niza to¢kica rasporedenih u kvadratnu mrezu, a te tockice
nazivaju se pikselima. Kvadratna mreza naziva se raster pa od tuda
naziv rasterska grafika.

7.1. Znacajke pojedinoga formata za slike

Odabir pravilnoga formata slike jako je vazan jer se na taj nacin
osigurava ispravan prikaz slike u najboljoj moguéoj kvaliteti. GIMP radi s
velikim brojem razlicitih slikovnih formata, a za pocCetnike je najbolje
spremati slike u XCF formatu, koji je ujedno i GIMP-ov izvorni format.
Ako se zeli slika prikazati u nekom drugom formatu, vidljivom na ostalim
racunalima, moze se izvesti u neki od poznatih formata kao sto su JPG,
PNG, TIFF...

7.1.1. Format JPG

Skrac¢enica JPEG (JPG) je kratica engl. Joint Photographic Experts
Group, $to je naziv udruge koja je donijela normu za taj format zapisa.

Format koristi saZzimanje podataka uz gubitak kvalitete slike. Moze
sadrzavati slike koje imaju od 2 do 16 milijuna boja (ili nijansi sive boje).
Prvenstveno se koristi za pohranjivanje fotografija, rjede za
pohranjivanje crteza ili slika s relativno malo boja.

Najveca prednost formata u odnosu na druge formate je u bitno manjem
zauzecu memorije.

Nedostatak ovoga formata su dosta izrazene nepravilnosti slike,
posebno rubne nepravilnosti i Sum, koje se na Stetu ostrine slike, tj.
bogatstva nijansi i finih detalja mogu umanijiti zamucéivanjem ili
primjenom raznih filtara.
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JPG je vrlo popularan format i koristi se za spremanje slika u vecini
fotoaparata, mobitela, tableta i drugih uredaja.

Preporuca se izrada kopija JPG slike prije poCetka obrade u programu
jer se svakim spremanjem slike gubi na kvaliteti slike i taj gubitak je
trajan.

Format JPG prikladan je za koriStenje na Internetu jer ima moguénost
znatnog smanjivanja veli€ine slike, a manje slike ¢ine web-stranice
brzima za ucitavanje.

To je format koji ne podrzava prozirnost i animaciju, ali je prikladan za
arhiviranje.

7.1.2. Format GIF

GIF (Graphic Interchange Format) je 8-bitni grafiCki format koji koristi
paletu od maksimalno 256 boja te se zbog toga najéesce koristi na
webu. Pretvaranjem izvornih bitmapa (BMP, JPG, TIFF, PNG idr.) u GIF
drasti€no se smanjuje broj nijansi kojima se interpretira sadrzaj, sto
rezultira stepeniCastim prijelazima pri pretapanju boja i gubitkom finijih
detalja, a naj¢e&cCe i prejakim kontrastom boja.

Iz navedenih razloga GIF je prikladniji za razne dijagrame i sli¢ne
graficke sadrzaje nego za fotografije.

7.1.3. Format PNG

PNG (Portable Network Graphics) je otvoreni grafi¢ki format namijenjen
pohrani ili streamingu nepokretnih slika bez gubitaka, a nastao je kao
zamjena za GIF.

SaZimanje podataka bez gubitaka naziv je za proces uklanjanja zalihosti
bez gubitaka informacija. Za razliku od sazimanja podataka s gubitcima,

kod postupka sazimanja bez gubitaka dobiva se slika €iji je prikaz
jednako vjeran izvornom.

To znaci da su postupci koji spadaju u ovu kategoriju reverzibilni,
odnosno svakome pripada odreden obratan postupak, koji iz sazete
poruke moze ponovno stvoriti izvornu.

PNG format je zamisljen kao graficki format za razmjenu preko
Interneta, tako da ne koristi neke druge sheme boja (kao sto je CMYK).

PNG datoteke u pravilu uvijek imaju ekstenziju PNG ili png.

7.1.4. Format PSD

GIMP moze otvarati i spremati izvornu datoteku programa Photoshop —
PSD (Photoshop document). U GIMP-u je moguce uredivati svaki sloj
posebno, spremiti datoteku kao PSD i nakon toga je otvoriti u
Photoshopu.
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Datoteke PSD otvorene u GIMP-u koje imaju posebna podeSavanja po
slojevima napravljena u Photoshopu, neée se dobro prikazivati u
GIMP-u.

Datoteke PSD koje su izradene u GIMP-u mogu se bez ikakvih
problema otvoriti i uredivati u Photoshopu.

7.1.5. Format RAW

Format RAW je format zapisa slikovnih datoteka u kojemu nema gubitka
informacija, odnosno, to je izvorni oblik slikovne datoteke dobiven
snimanjem nekog motiva. RAW zapis sadrzi sve informacije koje
prilikom fotografiranja aparat zabiljezi bez ikakvih obrada odnosno
kompresije. Slikovna datoteka u RAW formatu sadrzi minimalno
obradene podatke iz senzora digitalnoga fotoaparata, skenera ili film
skenera.

RAW format pokazao se kao idealan format u odnosu na druge formate
jer pruza mogucnost da se proces generiranja fotografije u potpunosti
preseli iz fotoaparata na radunalo. S druge strane, s obzirom na
koli¢inu informacija koje sprema, RAW zapis je znatno veci od ostalih
formata, ¢ak i do nekoliko desetaka megabaijta, Sto ga €ini nezgodnim za
spremanje, slanje i sli¢no.

Jednom kad se datoteka RAW otvori u GIMP-u, ne moze se ponovno
spremiti u formatu RAW, nego se moZze izvesti kao JPG ako je potrebna
slabija kvaliteta ili TIFF, ako se slika priprema za ispis.

7.1.6. Format TIFF

TIFF (Tagged Image File Format) je format za pohranu slikovnih
datoteka, iznimno popularan format medu grafi¢arima, izdavackoj
industriji te amaterskim i profesionalnim fotografima. Format je objavljen
1986., a od 2009. godine njime upravlja tvrtka ,Adobe Systems*.

Format TIFF je Siroko podrzan u aplikacijama za obradivanje fotografija,
izgleda stranice, skeniranje, faksiranje, obradu teksta, opti¢kih znakova
za prepoznavanije i drugih aplikacija.

Format podrzava sazimanje podataka bez gubitaka, ali moze
pohranjivati i nesazete podatke. MoZe sadrzavati slike koje imaju od 2
do 16777216 boja (ili nijansi sive boje). Samo neki (poluprofesionalni i
profesionalni) fotoaparati mogu snimati direktno u TIFF-u, ali vrijeme
spremanja slike na memorijsku karticu aparata moze se produziti na
desetak sekundi pa i do pola minute.

TIFF je memorijski vrlo zahtjevan slikovni format za profesionalnu
uporabu, postere, izlozbene i Jumbo plakate, tehnicke fotografije s
najfinijim razlaganjem detalja. Odlikuje se manje izrazenim
nepravilnostima slike, koristi se za sve namjene, od pohrane crteza i
jednostavnijih slika, do fotografija gdje izvrsno ocrtava sitne detalje.

Zanimljivosti i napomene

U GIMP-u se za korisnike
Mac racunala RAW
datoteke otvaraju s vec
unaprijed instaliranim
UFRaw dodatkom, dok ¢e
korisnici Windowsa morati
instalirati dodatak za GIMP
pod nazivom UFRaw ili
pretvoriti Raw datoteku u
TIFF.
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Zanimljivosti i napomene

Za pocetnike se
preporucuje spremanje slika
u XCF format tako da se
kasnije, prilikom ponovnog
otvaranja, mogu vidjeti svi
podaci o slici.

Prednost opisanoga formata u odnosu na format JPEG jest kvaliteta
slike.

7.1.7. Format XCF

XCF je GIMP-ov izvorni format. U taj format se spremaju svi podaci koji
su napravljeni na slici kao $to su slojevi, putanje, prozirnost i drugo.
Preporuca se koristenje ovoga formata kada se slika ureduje u vise
navrata.

XFC format koristi samo GIMP, no kada se zavrSi s uredivanjem slike,
zavrsni korak je izvoz slike u neki drugi format. RjeSenje za to je
spremanije slika u vise faza tijekom uredivanja tako da se kasnije moze
vratiti na neku od tih faza ako je potrebno.

7.2. Rezolucijaslike

Rezolucija kod digitalne fotografije i grafike je ukupni broj piksela nhekog
uredaja ili medija (fotoaparata, monitora, fotografije...) kao i broj piksela
po jedinici povrsine. Broj piksela po jedinici povrSine izraZzava se
“pikselima po in¢u” ili PPI (engl. pixels per inch).

DPI je skracenica od dots per inch (engl.), tj. “broj to¢aka po incu” i
odnosi se na broj to¢aka po in¢u kod ispisnih uredaja. Da bi se dobila
neka boja, pisa¢ mijesa tinte razlicite boje i za jedan piksel mora ispisati
odredeni broj toCkica. Broj to¢kica ovisi o razlucivosti pisaca.

Veci broj DPI-ja ne moze povecati PPI. PPI se odnosi na raspoloZive
piksele po inu koji grade fotografiju, a DPI na to koliko ¢e tockica tinte
pisac ispisati da bi ispisao piksele na jednom in¢u papirne plohe. Manji
broj DPI-ja moze zamaskirati nedostatak PPI-ja.

Elil ViSe ukupnih piksela na nekoj slici znaci vecu
rezoluciju slike i samim time kvalitetniju sliku, a
manje piksela manju rezoluciju, tj. loSiju sliku.
Kada se ureduje neka slika u GIMP-u, ureduju
se zapravo pikseli na toj slici. Piksel je najmaniji
graficki element neke slike koji u sebi sprema

varijaciju svjetline i boje.

U programu GIMP rezolucija slike provjerava se preko izbornika Image
- Image Properties.

7.3. Priprema slike za tisak i web

Priprema slika za web i tisak razlikuje se prvenstveno u kvaliteti same
slike, $to podrazumijeva rezoluciju slike, broj to¢aka po in¢u i modelu
boja. Za tisak je potrebno imati sliku vide kvalitete u CMYK modelu boja,
dok je za web dovoljna i slika slabije kvalitete u RGB modelu boja.

RGB je skracenica za engleski pojam Red (crvena), Green (zelena),
Blue (plava). RGB je aditivhi model boja kod kojeg se sabiranjem
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oshovnih boja dobije bijela boja. Jedna boja opisuje se kroz tri
vrijednosti: dio crvene, dio zelene i dio plave boje. Svaki dio boje varira
izmedu 0 % i 100 %, odnosno izmedu 0 i 255.

CMYK je suptraktivan model mijeSanja boja koji se primarno koristi u
tiskarstvu. Skracenica je oznaka boja u engleskom jeziku: Cyan (cijan,
tirkizna), Magenta (purpurna), Yellow, (Zuta) i Key (crna). lako se
kombinacijom prvih triju boja teoretski dobije crna boja, u tiskarstvu se
crna koristi kao zasebna (Cetvrta) boja, radi bolje reprodukcije tamnih
boja.

7.3.1. Slike za tisak

Preporucena rezolucija slika koristenih u pripremi za tisak je 300 ppi za
fotografije i 600 ppi za jednobojne ilustracije. Ako se kompletna priprema
radi kao bitmapa (npr. u GIMP-u), potrebno je prije poCetka rada na
pripremi odrediti $to viSu rezoluciju (barem 300 ppi, preporuka 600 ppi
ako priprema uklju€uje vecu koli¢inu teksta ili tekst maniji od 12 tocaka).

Sve boje koriStene u pripremi za tisak moraju biti u CMYK-u (fontovi,
slike i vektorski elementi). Boje u dokumentu koje nisu CMYK nego
RGB, bit ¢e konvertirane u CMYK, prilikom &ega su moguci maniji ili vedi
odmaci u vjernosti reprodukcije boja.

Kada se smanjuje rezolucija slike, treba uzeti u obzir da smanjivanje
rezolucije slike povec¢ava Sirinu i visinu slike, dok povec¢avanje rezolucije
slike smanjuje Sirinu i visinu slike. To je bitno zapamititi jer se prilikom
promjene rezolucije slike mijenja samo broj piksela koji ¢e se prikazivati
po inCu doti¢ne slike, a ne koliko piksela &ini tu sliku.

Za promjenu rezolucije slike odabere se Image - Print Size... U
sko&nom prozoru Set Image Print Resolution mozZe se mijenjati
rezolucija slike.

8% Set Image Print Resclution ot
Set Image Print Resolution 8~
%1 [Buket] [impored)-18 ;
Print Size

Width: 210, 4cH=

Height: 16459 5 mm

¥ resolution: | 300,000 'é

¥ resolution: | 300,000 : 1 | pixelsfin

Help Reset oK Cancel

Sliku je najbolje snimiti u TIFF formatu, ali mozZe se odabrati i JPG
format, no tada je potrebno odabrati visoku kvalitetu (u GIMP-u pod
Quality: 90-High ili 100-Maximum).
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Zanimljivosti i napomene

Sliku spremljenu u XCF
format moguce je otvoriti na
drugom ra¢unalu samo ako
i to drugo racunalo ima
instaliran program GIMP.
Ako ra¢unalo nema
instaliran GIMP, potrebno ju
je izvesti u neki drugi
standardni format.

7.3.2. Slike za web

Slike za web ne trebaju biti vrhunske kvalitete poput slika za tisak pa je
najceSc¢a radnja koja se koristi u GIMP-u za prikazivanje slika na webu,
smanjivanje slike na zadovoljavajucu rezoluciju.

Za promjenu rezolucije slike odabere se na izborniku Image naredba
Scale Image. Kao duljinu najdulje stranice preporuca se unijeti 700 px.
To je standardna veli€ina slike za web s obzirom na to da je normalno
vidljiva na ekranu rezolucije 1024 x 768. Nakon unesenih vrijednosti
potrebno je kliknuti na dugme Scale.

i Scale Image >

B Scale Image

* [Buket] (mpored)-19

Image Size
Width: 700 =
Height: 525 S, e~
700 x 525 pixels
X resolution: | 72,000 : é
¥ resolution: | 72,000 : 1 | pixelsfin
Quality
Interpolation: | Cubic w
Help Reset Scale Cancel

U nazivima slika ne preporuca se koristiti dijakriticke znakove, ve¢ samo
slova engleske abecede. Takoder, u nazivima se ne preporucuju
razmaci, a ako se naziv slike sastoji od viSe rijeci, povezuje ih se crticom
ili donjom crticom. Nazivi slika mogu sadrzavati velika i mala slova.

7.4. lzvozi spremanje slika

Nekako je intuitivno da se kod spremanja slike u neki odredeni format
odabere naredba iz izbornika File > Save ili File > Save As..., aliu
grafickim alatima kao $to je GIMP, naredbe Save ili Save As... koriste
se za spremanje u GIMP-ov izvorni format XCF. Nakon to se odabere
jedna od tih naredaba, upiSe se Zeljeni naziv slike te se pritisne na
dugme Save.

Ako se zeli spremiti slika u nekom drugom formatu, kao $to je JPG,
TIFF, PNG, PSD, GIF PDF, BMP ili neki drugi, potrebno je to u€initi
preko izbornika File > Export As.

U prozoru Export Image potrebno je upisati naziv slike koja ¢e se
spremiti, odabrati mjesto spremanja i format.

Naziv slike upisuje se u polje Name na vrhu izbornika, oznaceno
crvenim okvirom na donjoj slici.

= @ srce



Osnove rada s alatima za graficki dizajn (Inkscape, GIMP) (M100)

U sredini izbornika odabire se mjesto spremanja slike. Nakon odabira
zeljenoga mjesta, moguce je i izraditi novu mapu pritiskom na dugme
Create Folder.

Na kraju se odabire format u koji Ce se slika spremiti. Moguce je upisati
direktno format pokraj naziva slike (koji se piSe u obliku
Ime_slike.format_slike) ili pritisnuti na oznaku + koja se nalazi pored
teksta Select File Type (By Extension) za prikaz svih ponudenih formata.

& Export Image *
Mame: I Buket.png

Savein folder: | 4 | [ Polaznik Create Folder
Places Mame ~ Size Modified

Preview:

\, Search m Camera Roll Yesterday at 15:25

= Recently Used m Saved Pictures Yesterday at 15:25

[ Polaznik * Jabuka.png 966,6 kB 29.4.2015,

[ Desktop # Nepotrebni_balonipng 3676 kB 24.4.2015, @
£ Windows7_0S [C) ®. Tekst na bijeloj pozadini.png 36kB 1762015

- Data2 (D9) ®. Tekst na prozirnoj pozadini.png 3,7kB  17.6.2015.

<= DVD RW pogon (F) No selection

s Documents v

e

[ Show All Files

(=] Select File Type (PMG image)

File Type Extensions ~
PEM image pbm

PFM image pfm

PGM image pgm

p

PMG image

PMM image pnm

Portable Document Format pdf o

Svi ponudeni formati mogu se pregledati pomocu kliza¢a na desnoj
strani te pritiskom na Zeljeni i odabrati. Nakon odabira pritisne se na
dugme Export. Na gornjoj slici odabran je format PNG u dodatnom
otvorenom izborniku za izbor formata slike i oznaen crvenim okvirom.

Ponekad je potrebno smanijiti veli¢inu JPG slike na Stetu kvalitete slike.
Kada se na izborniku Export Image odabere format JPG i pritisne na
dugme Export, pojavi se prozor Export Image as JPEG u kojem je
pomocu kliza¢a, prikazanoga crvenim okvirom na donjoj slici, moguce
povecavati ili smanjivati kvalitetu slike od 0 do 100, a samim time i
konacnu veli€inu slike na raCunalu. Pravilo je da $to je veca kvaliteta
slike, slika zauzima viSe prostora, a $to je manja kvaliteta, slika zauzima
i manje prostora na racunalu.

@ srce »

Zanimljivosti i napomene

Prije po€etka rada na
uredivanju slike u GIMP-u,
preporudljivo je izraditi
kopiju originalne slike.

Ako se ne izradi kopija
originalne slike, moze se
dogoditi sljedece:

- ako se napravi neka
greSka na slici, unistit
¢e se jedina kopija te
slike

- ako se slika umaniji za
prikaz na web-stanici,
moze se dogoditi da
nam ostane samo
primjerak koji je
neupotrebljiv za tisak
zbog veligine i kvalitete

- viSekratnim
otvaranjem,
uredivanjem i
spremanjem slike u
JPG formatu smanjuje
se razina kvalitete JPG
slike pa je zato uvijek
dobro raditi s TIF ili
XCF datotekom.




Osnove rada s alatima za graficki dizajn (Inkscape, GIMP) (M100)

& Export Image as JPEG >

Quality:

File size: unknown

[] Show preview in image window

+ Advanced Options

Load Defaults | | Sawe Defaults

Help Export Cancel

7.5. Vjezba: Rezolucija
1. Otvorite dva puta istu sliku Ptica_u_letu.jpg, tako da imate
dvije otvorene kartice s istom slikom (File - Open).
2. Na prvoj kartici smanijite neproporcijalno rezoluciju slike
(Image - Scale Image) na 300 x 500 px.
3. Na drugoj kartici smanjite proporcionalno sliku na 1500 x 1000
px i postavite prikaz slike na 100 % (View - Zoom - 100 %).
4. Vratite se opet ha prvu karticu i povecaijte sliku na istu
rezoluciju kao i na drugoj kartici, 1500 x 1000 px te postavite
prikaz slike na 100 %.
5. Premijestajte se iz jedne kartice na drugu i napiSite na kojoj
kartici je slika kvalitetnija.
Kvalitetnija slika je na:
6. lzvezite sliku manje kvalitete pod nazivom Ptica_LQ.png i
sliku vece kvalitete pod nazivom Ptica_HQ.png.
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8. Osnovni alati zarad s rasterskom
grafikom

Po zavrSetku ovoga poglavija moci cete:
e objasniti ulogu slojeva u obradi slika
e dodati, ukloniti i duplicirati sloj te podesiti prozirnost sloja
e upotrijebiti razli¢ite alate za oznacavanje dijelova slike

e obrezati sliku, promijeniti joj veli¢inu, rotirati je, zrcaliti,
pomaknuti ili skalirati

e upotrijebiti alate za crtanje

e podesiti boje na slici

e dodati tekst na sliku

e preurediti sliku koristeci filtre.

Za uspjesno bavljenje obradom grafike u GIMP-u te obavljanje radnji
poput uklanjanja nepotrebnih dijelova, crtanja novih dijelova, rotiranja
slike, izrezivanja, povecavanja i smanjivanja, potrebno je dobro
poznavati osnovne alate.

8.1. Uporaba slojevai alata za ozna¢avanje

Za obradu bilo kakve grafike, jednostavnije ili slozene, nuzno je shvatiti
¢emu sluze slojevi i kako se koriste. Jednako tako, upoznavanje s
alatima kojima se oznacava neki dio slike da bi se kasnije s oznacenim
djelom nesto radilo, vazno je kako za pocetnike tako i za naprednije
korisnike.

8.1.1. Slojevi

Slojevi (engl. layers) sluze za spajanje dviju ili vise slika u jednu. Slojevi
su kao zasebne slike poredane jedna iznad druge, a mogu biti prozirni
tako da se vidi cijela ili samo neki dio slike ispod ili iznad tog sloja.
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Osnove rada s alatima za graficki dizajn (Inkscape, GIMP) (M100)

1 [I

Na primjeru crteza kucice moze se vidjeti da su oblik kucice, prozori i
vrata zasebne slike, svaka u svojem sloju. Kada se spoje pravilnim
redoslijedom, dobiva se kompletna kucica. Pravilan redoslijed znaci da
¢e se u zadnjem sloju nalaziti oblik kuée, na sloju iznad prozori te u
prvom sloju vrata. Kada se koriste slojevi, vrlo lako moze doéi do
izmjena slike u bilo kojem segmentu te slike, bez utjecaja na neke druge
dijelove na slici, jer se radi samo na tom odredenom sloju.

8.1.2. Dodavanje novoga praznog sloja

Za dodavanje novoga praznog sloja na otvorenoj slici potrebno je
odabrati naredbu New Layer... iz izbornika Layer.

24 New Layer W
B Create a New Layer
Slojevixcf-24 = =
Layer name: Layer Switches
@ | Visibl
Color tag: . ] mmmm [ visible
Linked
Mode: Mormal (1) | v W O _—m €
Z O
Zanimljivosti i napomene Blend space: Auto t
Composite space: | Auto ’;' [] Lock pesitien and size

Dobra je praksa svakom B O Lockalpha

Composite mede: | Auto

sloju promijeniti naziv radi -
lak$eg snalazenja u kasnijoj Opacity: 1°°—€’|.‘
fazi obra_de sllke_kada_lm_a_ R 200 :
puno slojeva na jednoj slici. -
Height: 600 7 | pxv
Offset }: ] =
Offset ¥: 0 e
Eill with: Transparency ~
Help oK Cancel

Pojavljuje se skocni prozor New Layer gdje se nudi mogucnost upisa
naziva sloja, promjena veliCine sloja, odabir ispune sloja i joS neke druge
opcije koje nisu u ovom trenutku toliko vazne. Nakon zavrSetka pritisne
se na dugme OK.
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Osnove rada s alatima za graficki dizajn (Inkscape, GIMP) (M100)

Novi sloj pojavljuje se u desnom dijelu programa i oznacen je plavom
bojom. Za promjenu imena sloja odabere se dvostrukim klikom lijeve
tipke misa sloj i upise novo ime.

Layers & Channels ) Undo History |E|E-rusr'es =

Mode Normal ) | [l |

Cpacity 100,0

Osim dodavanja novoga sloja, u izborniku Layer moguce je i obrisati
oznaceni sloj pomoéu naredbe Delete Layer, duplicirati sloj naredbom
Duplicate Layer te druge opcije, manje vazne pocetnicima.

Sve najceSce koristene naredbe, oznacene crvenim okvirom na gornjoj
slici, vezane za slojeve nalaze se i na odmah dostupnom desnom
dijaloSkom okviru u skupini Layers.

Kada se koristi viSe slojeva, mnogo puta je potrebno premjestati slojeve,
tj. zamijeniti raspored slojeva. To se radi metodom Povuci i ispusti
(engl. Drag & Drop), to jest odabere se i drZi lijevom tipkom misa sloj koji
se Zeli premjestiti i premjesti se na Zeljeno mjesto. Osim tog nacina,
slojevi se mogu premjestati pomoc¢u narancastih strelica koje su takoder
oznacene na gornjoj slici, a nalaze na dnu brzoga desnog izbornika
Layers. Potrebno je samo oznaciti sloj koji se Zeli premjestiti i pritisnuti
na strelicu gore ili dolje.

Na svakom sloju moguce je promijeniti i prozirnost toga sloja, tj. Opacity
u vrijednosti od 0 do 100, gdije je 0 potpuno prozirno, a 100 potpuno
neprozirno. Vrijednost je moguce upisati, pomicati pomocu klizaca ili
promijeniti pomocu okretnog dugmeta. Na gornjoj slici je oznacen
crvenim okvirom sloj Layer, s Opacity vrijedno$¢u 100.

Ako se kopira neki segment slike, crteza ili kompletna slika na otvorenu
sliku i zalijepi na nju, taj dio ¢e se odmah postaviti u novi ,plutajuci” sloj
(engl. Floating Selection (Pasted Layer)) kako je prikazano dolje na slici
te nije potrebno izradivati poseban sloj za taj segment, nego je potrebno
samo odabrati desni klik miSa na tom ,plutaju¢em® sloju i pritisnuti
naredbu To New Layer. Tako ¢e se kopirani segment automatski
postaviti u novi sloj te se dalje moze nastaviti raditi na tom sloju.
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Zanimljivosti i napomene

Ako se kopira neki objekt
koji ve¢ postoji na toj slici,
prilikom lijepljenja na tu istu
sliku objekt ¢e se poravnati
na isto mjesto gdje se
nalazi i izvorni, kopirani
objekt. Objekt se nakon
lijeplienja moze pomaknuti
pomocu alata Move.

.....

Layers .Channels 2 Undo Histony IE‘Brushes E

& Edit Layer Attributes...
Elend Space
Composite Space
Composite Mode
Color Tag

Maode Mormal |5 |[g S
Opacity 1000(_
Lock 4 e #

v v v w

- To Mew Layer

Mew from Visible

2 Mew Layer Group Lce

8.1.3.
Mnogi

Alati za oznacavanje

korisnici ne znaju pravilno koristiti alate za oznaavanje i tako si

otezavaju rad u GIMP-u. Alati za oznaCavanje nalaze se na vrhu
Toolboxa.

%1°1°1°

K- N

a0 i

6

.
°

0

GIMP sadrzi sljedece alate za oznaCavanje u Toolboxu s lijeve strane:

1.

Rectangle Select — je koristan alat za ozna€avanje kvadratnih ili
pravokutnih oblika na slici.

Ellipse Select — koristi se ako se zeli oznaditi neki kruzni oblik
na slici.

Free Select ili Lasso — omoguéuje oznaCavanje nekoga
nepravilnog objekta tako da se oznacava lijevom tipkom misa
vanjski rub tog objekta pomoc¢u to€aka. Ako se pogrijesi, moze
se dodi iznad toCke koja je krivo postavljena i pomaknuti je na
Zeljenu poziciju. Selekcija se zavrSava odabirom pocetne tocke.

Fuzzy Select ili Magic Wand — jako koristan alat koji oznaCava
samo ono podrucje koje je odabrano tim alatom.

Color Select — je koristan alat ako se Zeli oznaciti samo dio slike
izraden bojom koja je odabrana tim alatom.

88
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6. Scissors Select — je odlican i jednostavan alat kojim se moze
odabrati neki objekt, ali za odabir je potrebno samo okvirno
kliknuti miSem oko objekta, a Skare ¢e same pronaci rubove. Za
zavrSetak selekcije, potrebno je odabrati po¢etnu tocku.

7. Foreground Select — sluzi za ozna€avanje na slici u dva koraka.
Prvi je odabir zeljenoga dijela slike, a drugi je dodatna korekcija.

Osim navedenih alata, korisne naredbe za ozna¢avanje nekoga dijela
slike nalaze se jos i u izborniku Select, €iji se opis moZze pronaci u
prilogu ovoga priru¢nika.

Obi¢no je najlakSe i najbrze oznacCavati neke pravokutne ili kruzne
oblike, ali ako je potrebno napraviti selekciju na nekom nepravilnom
obliku tu je potrebna domisljatost i dobro poznavanje alata. Ponekad je
lak$e oznacavati pozadinu objekta te nakon toga samo izokrenuti
selekciju tako da bude oznacen zeljeni objekt, a nekad je pozadina toliko
razliCita da je lakSe oznaciti objekt.

Jedan jednostavan alat za selekciju nepravilnih oblika je Scissors
Select koji se jos naziva i Intelligent Scissors, ako se do njega pristupa
preko izbornika Tools - Selection Tools. Moze mu se pristupiti i preko
Toolboxa koji se nalazi s lijeve strane programa.

Moguce je u nekoliko koraka oznaciti neki nepravilan oblik:

1. Prvo se otvori sliku u GIMP-u.

2. Da bi se lakse i to¢nije mogao oznaditi Zeljeni objekt na slici,
dobro je zumirati taj objekt na minimalno 200 %.

3. Sada je potrebno odabrati alat Scissors Select i oznaCavati
pomocu todaka granice objekta koji se Zeli oznagiti. Sto je vedi
broj toCaka, to ée biti preciznija konacna selekcija. Selekcija se
zatvara tako da se zatvori krug, tj. odabere se pocetna tocka.
Ako se pogrijedi s nekom to¢kom u selekciji, moguée je zadati
novu toCku te nakon toga odabrati onu koja je na pogreSnom
mjestu i premijestiti je na Zeljenu poziciju ili odabrati neki drugi
alat u Toolboxu, pa opet na alat Scissors Select i krenuti iz
pocetka. Nakon zavrSenog oznacavanja, objekt bi trebao
izgledati kao na donjoj slici.

4. Nakon uspjedno oznagenog objekta, pritisne se tipka [Enter] tako
da se vidi ozna€eno podrucje. Kada je objekt oznaéen, kopira se
naredbom Edit > Copy ili tipkovnim pre¢acem [Ctrl + C].

5. U novoj kartici se otvori slika Drvece.jpg (File = Open) i na nju Zanimljivosti i napomene

se zalijepi izrezana ptica naredbom Edit - Paste ili tipkovnim

preCacem [Ctrl + V], nakon ¢ega se postavi u novi sloj (desni klik Ptica se moze i uskladiti s
na sloj i odabir naredbe To New Layer). bojom pozadine raznim
. - L . . filterima i naredbama. Ako
6. Alatom Scale '_I'o_ol_ se klikne na pticu i smanji njena dimenzija na se odabere sloj u kojem se
Sirinu 250 px i visinu 341 px. nalazi ptica, pomoc¢u

naredbe Colors > Levels
moguce je podesiti boju
Za ljepSi prikaz slike, odabere se zadnji sloj tako da ptica nije ptice okolini u kojoj se
vide oznadena. nalazi, tj. pozadini.

Alatom Move Tool premjesti se ptica na Zeljeno drvo u Sumi.
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UspjeSno oznacen objekt moZe se kopirati, rezati, bojati, premjestati te
se na njemu mogu raditi sve akcije kao na zasebnoj slici.

¥ [Ptica) (imported)-26.0 (RGB color 8-bit gamma integer, GIMP built-in sRGB, 1 layer) 2033x1819 - GIMP

File Edit Select View Image Layer Colors Tools Filters Windows Help

i Z ®
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@
O
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Mode:| 3§ | g K
Antiafiasing

[] Feather edges

[ interactive boundary
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e s |_._1_1__J_._|_._|_._1_._1_.__
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S
L

P
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8.2. Alati za transformaciju

Mnogo puta je potrebno obrezati sliku, promijeniti veli€inu, rotirati,
zrcaliti, pomaknuti ili u€initi neke druge transformacije s otvorenom
slikom, a to se postize skupinom alata koji se nalaze u izborniku Tools
- Transform Tools.

Rotiranje slike

Ako se Zeli izravnati neka slika ili rotirati, koristi se naredba Rotate:

=

Otvori se slika u GIMP-u koju je potrebno rotirati.

n

Za rotiranje slike odabire se naredba Rotate u izborniku Tools
->Transform Tools ili u Toolboxu s lijeve strane.

3. Kada se odabere bilo koji alat, pa tako i Rotate, pojavljuju se
dolje niZze u Toolboxu dodatne opcije za taj alat, naziva Tool
Options. U tim je opcijama potrebno odabrati u padaju¢em
izborniku pod Clipping, naredbu Crop to result, koja odmah
obreze sliku.

H

Pritisne se lijevom tipkom misa na sliku gdje se pojavljuje mreza
ispred slike i dodatni sko¢ni izbornik Rotate.
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“. [Pisa] (imported)-29.0 (RGB color 8-bit gamma integer, GIMP built-in sRGB, 1 layer) 2000x3008 - GIMP
File Edit Select View Image Layer Colors Tools Filters Windows Help

. Rotate

£ -

‘Q‘ Rotate |
Pisajpg-78 ([Pisz] (mported)) &
Angle:  |0,00 i A

Center X: | 1000,00

BN ZE L,

BeSs O & 0
B D EF>
CAPB$=E

Center Y: | 1504,00

Help Reset Cancel

@
=
®

Rotate
Transform: ™% | jl§ A
Direction
(® Normal (Forward)
(O Corrective (Backward)
| Interpolation Cubic 7}
Ciipping Adjust | v |

Show image preview

Image opacity n'i

Guides Number of fines | v |

.
i

[ 15 degrees (shif)

5. U sko&nom prozoru moguce je pomoc¢u okretnog dugmeta
odabrati za koji kut ¢e se slika okrenuti, lijevo ili desno, moguce
je ru€no upisati vrijednost ili odabrati vrijednost pomocu klizaca.
Nakon odabira pritisne se na dugme Rotate.
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E" *[Pisa] (imported)-29.0 (RGB color 8-bit gamma integer, GIMP built-in sRGB, 1 layer) 2000x3008 - GIMP

File Edit Select View Image Layer Colors Tools Filters Windows Help

'@ Duplicate Ctrl+D |
N Mode »
Q A Precision >
= Color Management >
B i
Transform >
WOE| T
™, Canyas Size...
A Fit Canvas to Layers
8 @ Fit Canvas to Selection
== Print Size...
-"r ™, ScaleImage...
7 & Crop to Se&cnon

/+ Crop to Content
/o [ 7T!LE__I
Zealous Crop -
Rotate
Transform: || i A Merge Visible Layers... Ctrl+M K
Direction Flatten Image
(® Normal (Forward) # Align Visible Layers...

Corrective (Backward)
o Guides >

|Interpolation Cubic Confiqure Grid

Ciipping Crop to result

© Image Properties Alt+Return
Show image preview Metad

| Guides Number of ines | v
155

[ 15 degrees (shift)

6. Slika je sada ispravno poravnata, ali ima prazan prostor oko
rubova. Najlaksi nacin za brisanje praznoga prostora oko slike je
da se naizborniku Image odabere naredba Crop to Content,
kako je i oznaeno crvenim okvirom na gornjoj slici.

Zrcaljenje slike

Kada se otvori slika koja je okrenuta naopako, vertikalno ili horizontalno,
moguce je vrlo lako sliku vratiti u ispravan polozaj. Postoje dva nacina;
da se slika zrcali preko izbornika ili preko Toolboxa.

Za zrcaljenje slike preko izbornika odabere se Image - Transform. U
tom izborniku mogucée je odabrati naredbe Flip Horizontally za
zrcaljenje slike vodoravno, Flip Vertically za zrcaljenje slike okomito te
naredbe za brzo rotiranje slike po 90 stupnjeva.

Slika se moze zrcaliti i preko alata Flip Tool koji se nalazi u Toolboxu.
Nakon odabira alata, odabere se pod dodatnim opcijama alata naredba
Horizontal ili Vertical, ovisno o tome Zeli li se slika zrcaliti vodoravno ili
okomito. Pritiskom na sliku ona se zrcali na odabranu stranu.
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Na sljedecoj slici crvenim okvirima oznacen je izbornik Transform i
dodatne opcije alata u Toolboxu.

B *[Baleni] (imported)-30.0 (RGE color &-bit gamma integer, GIMP built-in sRGE, 1 layer) 4000x6000 — GIMP

File Edit Select View  lmage Layer Colors Tools Filters Windows Help

0 =
P

v,

o [ [E]

Flip

Transform: | @ | il #

Direction {Ctrd)
@ Horizontal

O Wertical

Clipping

Ciip)

L]

P " .

%

ik

Duplicate

Mode
Precision

Color Management

Transform

Canyas Size...

Fit Canvas to Layers
Fit Canvas to Selection

Print Size...

+ Scale Image...

Crop to Selection
Crop to Content

Zealous Crop

Merge Visible Layers...
Elatten Image

Align Visible Layers...

Guides
Configure Grid...

lmane Pronerties

Obrezivanje slika

Ctrl+D

Ctrl+M

Alt+ Return

“ Flip Horizontally

¢

Flip Vertically

: ]

&
2

# Guillotine

Rotate 90° clockwise
Rotate 80° counter-clockwise

Rotate 180°

Obrezivanjem slika briSu se originalni rubovi ili dijelovi slike. Obrezivanje

slike korisno je kada se Zele obrisati neki dijelovi koji nepotrebno
odvlace paznju na slici, kada se Zeli bolje istaknuti motiv ili se
jednostavno neki dio slike zeli odrezati. U programu GIMP obrezivanje
se izvodi alatom Crop Tool koji se nalazi u Toolboxu ili na izborniku

Tools - Transform Tools > Crop. Prije obrezivanja poZeljno je napraviti

kopiju originalne slike za slu€aj da se preveliki dio slike odreze.

Postupak obrezivanja slike je vrlo jednostavan:

1. Prvo je potrebno otvoriti sliku i odabrati alat Crop Tool.

2. Nakon toga potrebno je oznaditi sliku, a to se radi tako da se
pritisne i drZi lijeva tipka miSa na dijelu slike koji se Zeli oznaciti,

zatim se povuce miSem dijagonalno preko dijela slike koji se Zeli
oznaditi. Oznaceni dio slike ¢e posvijetliti, a ostali dio potamnijeti.

Sav dio koji je potamnio bit ¢e odrezan, a samo ¢e ostati

posvijetlieni dio slike. Kada se oznadi slika, moguce je i korigirati
selekciju tako da se prode miSem iznad bilo kojeg ruba selekcije i
pomocu njega poveca ili smanji ukupna selekcija.

3. Zakonacno obrezivanje slike, potrebno je pritisnuti tipku [Enter].
Primjer obrezivanja prikazan je na sljedec¢im slikama.
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t [Zivotinja] (imported)-32.0 (RGB color 8-bit gamma integer, GIMP built-in sRGB, 1 layer) 3264x2448 - GIMP

File Edit Select View Image Layer Colors Tools Filters Windows Help

e M4
Ze a4
= O
® o A
(O} / ¢ B L
@ H& 84O
e &
.4
o M =
Crop
[[] curent tayer onty
[ Atiow growing
[] Expand from center
[ | Foced Aspect ratio | v
Current | E W
Position: pxv
142 | 765 B
Size: pxv
795 &i| 1545 B

Highiight
e
No guides v
Auto Shrink

[ shrink merged

Nakon obrezivanja slike i spremanja kao zasebne slike, rezultat je samo
motiv koji se zelio istaknuti u centru slike.
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Promjena veli€ine slike i rezolucije

Promjena veli¢ine slike tako da bude manja od originalne, obi¢no ne
utjeCe na kvalitetu slike, ali promjena veli€ine slike na viSe, tj. da slika
bude veca od originalne slike, moze utjecati na kvalitetu slike. Kao i kod
drugih alata, i kod ovoga je dobro napraviti kopiju originalne slike prije
nego se pocne mijenjati veli€ina slike.

Ako se zeli promijeniti veli€¢ina neke slike, koristi se alat Scale Tool koji
se nalazi u Toolboxu ili na izborniku Tools - Transform Tools - Scale.
Promjena veli€ine slike moze se primijeniti u gotovo svim standardnim
jedinicama kao &to su pikseli, postotci, in¢i, milimetri, centimetri, metri i
drugi.

Primjerice, ako se neka slika zeli povecati, tj. skalirati za 250 %,
postupak je vrlo jednostavan:

1. Prvo je potrebno otvoriti sliku kojoj se Zeli promijeniti veliina i
uzeti alat Scale Tool te kliknuti miSem na sliku u radnom
prostoru ili doéi do naredbe preko izbornika Image - Scale
Image...

2. Pojavit e se skoc¢ni prozor Scale Image gdje se prvo odabire u
kojim jedinicama se Zeli promijeniti veli€ina slike. Za primjer ¢e
se odabrati postoci, tj. znak %. U podrucje Image Size moze se
ru¢no upisati ili pomocu okretnog dugmeta odabrati vrijednost na
koju Ce se slika skalirati u odnosu na originalnu veli€inu slike. Na
dolje prikazanoj slici, slika se povec¢ava za 250 %, Sto je
oznaceno crvenim okvirom. To se jo$ naziva i interpolacija ili
umjetno povecanje slike.

g Scale Image >
lxi Scale Image
[Bubamarz] {imported)-33 -

Image Size
Width: 250 = 'é
Height: 250 :J pr
250 = 176 pioels
X resolution: | 180,000 :'é
¥ resolution: | 180,000 :_. pixelsfin
Quality
Interpelation: | Cubic o
Help Beset Scale Cancel

3. Nakon odabira pritisne se dugme Scale.

Zanimljivosti i napomene

Skaliranje ili promjena
veli¢ine slike je razli¢ito od
zumiranja. Kada se slika
priblizava ili udaljava to
samo utjee na vrstu
pogleda na ekranu i ne
utjeCe na veli€inu same
slike, dok skaliranje mijenja
trajno sliku na potpuno
drugadiju veli€inu.

@ srce .




Osnove rada s alatima za graficki dizajn (Inkscape, GIMP) (M100)

Izgled originalne slike prije poveéavanja:

Na isti nacin se i smanjuje veli€ina slike, samo $to bi se u ovom slu¢aju
odabrao maniji broj od 100 %.

Pomicanje objekata

Za pomicanje bilo kakvih objekata, selekcija ili teksta na slici, koristi se
alat Move Tool u Toolboxu, a do njega se moZze dodi i preko izbornika
Tools = Transform Tools - Move. Odabere se alat i klikne se lijevom
tipkom miSa na objekt koji se Zeli pomaknuti.

8.3. Alati za crtanje

Svi alati za crtanje nalaze se u izborniku Tools = Paint Tools. Vecina
tih alata koji su namijenjeni bas za crtanje prikladna je i za graficke
tablete, ali moguce ih je koristiti i pomo¢u miSa. Tako su intuitivni alati za
crtanje poput olovke, Pencil Tool u Toolboxu kaji

74| Tool Options =

Paintbrush sluZi za crtanje linija s tvrdim rubovima,

v i alyZi i :

= Mo [V Paintbrush koji sluZi za crtanje mekih rubova,
e | =% Eraser bride linije ili dijelove crteZa ili slika,

Airbrush sluzi za crtanje jako mekih linija, Ink
e sw> s 8 | sluZi za pisanje ili crtanje kaligrafskim stilom,

[—— oo g | Bucket Fill popunjava podrucja s odabranom

nge | k| 3[R bojom, Blend ili Gradient popunjava gradijentnom
[pocg [ of]c1[8 bojom odabrana podrudja.

pons | =22 8 | Svaki od tih alata za crtanje sadrzi u dodatnim

e | =& | opcijama Tool Options, puno parametara koji se
mogu podesiti. Tako se moze birati veli¢ina, oblik,
1 Dynamics Optons kut pod kojim se Zeli crtati, boja, prozirnost te

L] Aepy s mnoge druge mogucnosti koje mogu biti jako

=i korisne.

I:‘ Leck brush to view

I:‘ Incremenial
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Crtanje sa selekcijama

Selekcije, osim $to sluze za oznaCavanje objekata, mogu se Koristiti i za
crtanje tako da ih se popunjava bojom ili se obrubljuju.

Za popunjavanije selekcija bojom prvo je potrebno odabrati alat za
oznacCavanije i napraviti zeljeni oblik selekcije. Kada se izradi oblik,
moguce je korigirati taj oblik po svakom rubu selekcije te nakon toga
pritisnuti tipku [Enter] tako da selekcije izgledaju kao na dolje prikazanoj
slici.

Zanimljivosti i napomene

Za dodavanje izvornoj
. oznaci dodatnu oznaku,
¥ % potrebno je drzati tipku
I [Shift] i bilo kojim alatom za
' ! oznacavanje docrtati
. . oznaku. Za oduzimanje
' o oznake, potrebno je
el - pritisnuti tipku [Ctrl].

Kada se izradi selekcija, potrebno je samo uzeti alat Bucket Fill,
odabrati boju Foreground u Toolboxu i pritisnuti miSem unutar selekcije.
Selekcija je obojana u boju koja je odabrana na paleti boja, unutar opcije
Foreground.

Osim popunjavanja selekcija bojom, moguce je i bilo kojoj selekciji
dodati rub koji se kasnije boja s Bucket Fillom ili se odmah dodaje rub
obojan u boju Foreground boje. To je jako korisno ako se zeli oznaditi
neki dio slike okvirom, obrubiti neka slika ili samo njezin dio.
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Za izradu ruba na selekciji kre¢e se od same izrade selekcije, koju je
potrebno podesiti, te nakon $to se izradi selekcija klikne se desnom
tipkom miSa na selekciju i iz izbornika Select odabere se naredba
Border.

& Border Selection *
Border selection by

W E =l o
Border style Smooth |~

Selected areas continue outside the image

Help QK Cancel

U sko¢nom prozoru Border Selection by potrebno je upisati debljinu ruba
u jedinicama koje se mogu birati, na gornjoj slici su to pikseli. Opcija
Selected areas continue outside the image, ako se ukljuci, tj. stavi
kvacica, pruza njezan prijelaz boja na rubu. Nakon zavrSetka, pritisne se
na dugme OK.

Na kraju je potrebno uzeti Bucket Fill, odabrati Zeljenu Foreground boju
i pritisnuti unutar ruba da se on oboji ili odabrati izbornik Edit = Fill with
FG (ili BG) Color.

Osim bojanja nakon dodavanja ruba, moguce je i odmah obojiti rub bez
upotrebe alata Bucket Fill. Kada se izradi selekcija, pritisne se desnom
tipkom miSa na selekciju i u izborniku Edit odabere se naredba Stroke
Selection... U otvorenom sko¢nom prozoru Stroke Selection, koji je
prikazan na slici dolje, mozZe se upisati ili okretnim dugmetom odabrati
debljina ruba pod opcijom Line With:. Boja ruba bit ¢e jednaka boji koja
je odabrana u paleti boja Foreground.
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@ Stroke Selection p4

""" _" Choose Stroke Style
Selection Mask-101 {[Untitled]) -

(@) iStroke line;

(® Solid color
() Pattern

Antialiasing
Line width: |60 = | pxw
& Line Style

() Stroke with a paint tool
Paint tool: | 4* Paintbrush

Emulate brush dynamics

Help Reset Cancel

Nakon odabira debljine, potrebno je pritisnuti lijevom tipkom misa na
dugme Stroke. Dolje na slici prikazano je obrubljivanje pomocu naredbe
Border i Stroke Selection.
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Dupliciranje ili kopiranje dijelova slika

Za dupliciranje dijela slike s iste ili neke druge slike koristi se alat Clone
Tool koji se nalazi u Toolboxu ili na izborniku Tools - Paint Tools >
Clone. Osim za dupliciranje, alat je odli¢an i za popravak osteéene slike
te uklanjanje nepotrebnih dijelova.

Za dupliciranje ili popravljanje slike potrebno je poduzeti sljedece
korake:

1. Otvori se slika te se zumira radi lakSe obrade.

2. Odabere se alat Clone Tool te se prije koriStenja podese
dodatne opcije alata. Bitno je da se podesi pravilna veli¢ina alata,
tvrdoc¢a rubova i kakvo ¢e biti poravnanje (engli. Size, Hardness i
Alignment). Veli€ina i tvrdo¢a rubova alata ovise o tome duplicira
li se veliki dio slike pa je potrebna veca veliina ili se nesto
precizno radi pa je bolje da je veli€ina $to manja. Poravnanje se
moze odabrati s padajuceg izbornika, a ¢esto se koriste None i
Aligned. None uvijek kre¢e od pocetne toCke dok Aligned prati
kretanje ovisno o lokaciji na slici, $to ¢e se bolje razumjeti
prilikom koristenja tog alata.

3. Clone Tool radi malo drugacije od dosadasnjih alata te ga je
potrebno prvo aktivirati. Aktivira se tako da se pronade na slici
dio koji se zeli duplicirati ili kopirati te se pritisne na tipku
[Ctrl]+lijeva tipka miSa. To je poCetna to¢ka od koje ¢e se poceti
duplicirati ili kopirati taj dio slike.

4. Nakon toga pomice se alat na podrucje gdje se zeli postaviti
duplicirani dio i kreéu se raditi linije ili se tapka po tom podrudju
pritiskom na lijevu tipku misa. Uvijek se moze pritisnuti na
kombinaciju tipki [Ctrl]+[Z] ako se pogrijeSi te se krece iz poCetka.

Primjerice, po€etna ili originalna slika prikazuje balone koiji lete. Ako se
neki baloni Zele ukloniti, a neki duplicirati, Clone Tool je odli¢an alat za
takve stvari.
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Nakon uspjesnog koriStenja alata Clone Tool, uklonjena su tri balona, a
lijevi balon je dupliciran, $to se moze vidjeti na donjoj slici.

8.4. Alati za podeSavanje boja

Slike s previsSe svjetla ili tame, koje nisu ostre, koje su prebogate bojama
ili imaju neki drugi problem s bojama moguce je rijesiti alatima koji se
nalaze u izborniku Tools - Color Tools. Osim u tom izborniku, svim
podesavanjima boja moguée je pristupiti i preko izbornika Colors.

Podesavanje svjetline i kontrasta

Ako se slika Zeli posvijetliti, potamniti ili se Zeli dodati kontrast, koristi se
opcija Brightness-Contrast... koja se nalazi u izborniku Colors ili Tools
-> Color Tools, a moze se koristiti i ako se Zeli pomoéu svjetline istaknuti
neki objekt na slici.

Za podeSavanje svjetline potrebno je otvoriti sliku i u izborniku odabrati
opciju Brightness-Contrast....

& Brightness-Contrast X
(0 * Adjust Brightness and Contrast m
Dvorac jpg-108 {[Dvorac] {imported))
Presets: v 4+ =
Erightness 0 :
Contrast 0 :
Edit these Settings as Levels
Preview ] Split view
Help Reset QK Cancel
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Pojavljuje se skoCni prozor Brightness-Contrast u kojem je moguce
mijenjati svjetlinu i kontrast. Ako je slika previSe tamna, potrebno je u
redu Brightness pomicati kliza€ u desnu stranu ili odabrati okretno
dugme za povecanije vrijednosti svjetline, a ako je slika previse svijetla ili
eksponirana, potrebno je kliza¢ pomicati u lijevu stranu ili okretnim
dugmetom smanjivati vrijednost svjetline.

Gotovo uvijek kombiniraju se svjetlina i kontrast, tako da kada se
promjeni svjetlina, pozeljno je mijenjati i kontrast. Kontrast se nalazi u
redu Contrast i vrijede ista pravila za kliza¢ i okretno dugme kao i kod
svjetline.

Dobro je taj sko&ni prozor pomaknuti tako da se vidi i slika koja se
obraduje u radnom prostoru, zato da se vide promjene u realnom
vremenu, §to znadi da se prilikom pomicanja kliza¢a odmah vidi rezultat
te promjene na slici. To je moguée samo ako je stavljena kvacica na
opciju Preview u lijevom kutu sko¢noga prozora.

Nakon odabira Zeljene svjetline i kontrasta, pritisne se lijevom tipkom
miSa dugme OK.

Slika prikazuje gradevinu koju je potrebno viSe istaknuti jer je zbog
svjetline neba i oblaka ostala malo zasjenjena.

Na Stetu oblaka i pozadine slike koji su sada preeksponirani, osvijetljena
je gradevina. Sama gradevina moze se izrezati i koristiti u nekom
buduc¢em kalendaru ili necem slichom. Na dolje prikazano;j slici za
svjetlinu i kontrast koristena je vrijednost 60.
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Pretvaranje slike u sive tonove

Nekad se slika zbog umjetni¢kog dojma ili zbog nekog drugog razloga
zeli postaviti u crno-bijelu boju, tj. samo u sive tonove. U programu
GIMP to se moze izvesti na vise nacina. Jedan od njih je da se odabere
naredba u izborniku Image - Mode - Grayscale.

Drugi nacin je da se na izborniku Colors odabere Desaturate >
Desaturate. Kada se otvori sko¢ni prozor, moguée je odabrati izmedu
pet opcija: Luminance, Luma, Lightness (HSL), Average (HSI Intensity) i
Value. Najbolje je ukljuciti opciju Preview i isprobati svaku od tih opcija
te nakon toga odlugiti koja je najbolja. Nakon Zeljenog odabira, potrebno
je lijevom tipkom mi8a odabrati dugme OK.

2 Desaturate ot

Desaturate r:ﬂ

Buketipg-110 {[Buket] [importzd])

Presets: o I

Mode Lurinance

Luminance

Lurma

Lightness (H5L)
Average (HSl Intensity)
WValue (H5V)

Primjer slike koja se zeli pretvoriti u sive tonove preko izbornika
Desaturate.
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PodeSavanje razina boja na slici

Pomodu izbornika Colors = Color Balance moguce je podeSavati
koli€inu tirkizne, purpurne ili zute boje na slici (engl. cyan, magenta ili
yellow), kao i dodavanje crvene, zelene ili plave boje.

Izbornik se sastoji od tri klizaca pomocu kojih je moguce regulirati
koli¢inu svake boje odvojeno. Osim toga, moguce je i odabrati izmedu tri
opcije na koje ¢e se odnositi to podesavanje boja, a to su Shadows,
Midtones i Highlights. Kod ovog izbornika zanimljivo je da se kod svake
od opcija moze zasebno mijenjati koli¢ina boje, a sve zajedno se
primjenjuje na otvorenu sliku.
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Wi Color Balance X
Color Balance -
Sumajpg-114 {[Suma] {(imported))
Presets: v 4+ &
Select Range to Adjust
() Shadows
(® Midtones
() Highlights
Adjust Color Levels
Cyan 0,0 | Red
Magenta 0,0: Green
Vellow 0,0 | Blue
Reset Range
Preserve luminosity
Breview Il Split view
Help Beset oK Cancel

Dolje prikazana izvorna slika drve¢a nakon uporabe izbornika Color
Balance moze izgledati potpuno drugadije.

Slika ima sada potpuno drugadiji, topliji ugodaj nakon korekcija boja te

su joj poja¢ane blage zelene nijanse.
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Za jesensku varijantu izvorne slike, prethodna slika je odabrana i
nadogradena.

8.5. Dodavanje teksta

Za dodavanije teksta na sliku potrebno je otvoriti sliku na koju se zeli
dodati tekst ili izraditi novu sliku na kojoj ¢e biti tekst. Odabere se alat
Text Tool koji se nalazi u Toolboxu ili na izborniku Tools - Text i
pritisne se lijevom tipkom miSa na mjesto na slici gdje se zZeli umetnuti
tekst.
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U dodatnim opcijama alata Text Tool mogucée

4| Taol Options =l je odabrati Font preko padajuceg izbornika i
Tedt veli¢inu fonta u viSe ponudenih jedinica.
senecset _ Takoder se odabire i boja teksta koja je po
i L - # 1 standardnim postavkama jednaka boji
[ e ctor Foregrounda, a moZze se i zasebno promijeniti
A pod opcijom Color.
Hinting:| Medium L
<o [N Pod opcijom Justify moZe se poravnavati
L tekst, a u opcijama ispod veli€ina uvlake,
e prored i razmak izmedu slova.
[Sij{e0 E Tekst se moze i upisati te naknadno mijenjati,
0 samo ga prethodno treba oznaditi u cijelosti ili
Bax | Dynamic | v djelomicno, ovisno o tome koji se dio zeli
Lenguzge: promijeniti.
Croatian

Osim navedenih opcija, kada se pocinje pisati
tekst na slici, pojavljuje se jo$ jedan skocCni prozor u kojem je moguée na
brzi nacin promijeniti font, veli€inu fonta, podebljanje, kurziv, podcrtati
tekst ili ga precrtati. Takoder je moguce promijeniti prored, razmak
izmedu slova kao i boju teksta.

-

Sans-serif 29 px

= - -
<= ([a] (Al [A] (2 0.0 =100 5 .

Tekst napisan u programu Giml:]:

Prilikom pisanja, tekst je obrubljen okvirom koji sluzi za prikaz teksta na
slici. To znacCi da se samo ono Sto je unutar okvira i prikazuje, a ako se
okvir pomakne po bilo kojoj stranici, nakon toga je potrebno korigirati i
tekst. To je korisno ako se Zeli tekst prikazati u nekim granicama na slici
pa se samo postavi okvir u te granice i piSe tekst unutar okvira, nije
potrebno razmisljati je li se preslo izvan granica.

Za poniStavanje okvira s tekstom pritisne se tipka [Esc] ili se odabere
neki drugi alat u Toolboxu.

Za pomicanje teksta potrebno je odabrati alat Move Tool te nakon toga
to€no oznaciti tekst i pomaknuti ga na Zeljenu poziciju.

8.5.1. Tekst na prozirnoj pozadini

Tekst na prozirnoj pozadini koristan je za web-stranice ili ako se zeli
postaviti tekst preko neke slike. To znaci da ¢e se samo vidjeti slova,
bez ikakve pozadine, dok Ce se iza slova vidjeti web-stranica ili slika na
koju se postavio tekst.

Bitno je napomenuti da ne podrzavaju svi formati slike prozirnost, tako
da se prozirne slike najéescée spremaju u PNG ili GIF datoteku.
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Zanimljivosti i napomene

Uvijek je dobro oznaditi
kvacicom polje Work on
copy kod svih filtara koji to
nude. Time se osigurava da
izvorna slika bude
nepromijenjena, tj. kao u
pocetnom stanju, a filtar se
primjenjuje automatski na
njenoj kopiji.

Za izradu prozirnoga teksta potrebno je prvo stvoriti prozirnu sliku, a to
se radi preko izbornika File > New... U sko€nom prozoru Create a New
Image pritisne se lijevom tipkom miSa na oznaku + pokraj teksta
Advanced Options. U padaju¢em izborniku Fill with potrebno je
odabrati Transparency. Nakon toga, ako ve¢ nije odabrana, odabere se
zeljena dimenzija, te se pritisne na dugme OK.

Nakon &to se upide Zeljeni tekst, ostatak slike moze se obrezati ru¢no ili
preko alata Autocrop Image, koji se nalazi u izborniku Image.

Tekst na transparentnoj pozadini.

Na kraju je potrebno sliku izvesti iz programa u neki format koji podrzava
prozirnost, u gornjem slucaju je to PNG. Tekst je na gornjoj slici
postavljen na tri pravokutnika razliCite boje te se moze vidjeti da, bez
obzira na boju pozadine, tekst ostaje proziran.

8.6. Uporaba filtara

Filtri sluze za promjenu izgleda neke slike, a program GIMP nudi preko
100 razlic¢itih vrsta. Jako se jednostavno koriste. Otvori se slika i samo
se preko izbornika Filters primijeni neki od filtara.

S obzirom na to da se vra¢a u modu starinski izgled slika, najlaksi nacin
za pretvaranje obic¢ne slike u sliku sa starinskim izgledom je pomocu
filtra Old Photo. Otvori se slika kojoj se Zeli dati starinski izgled i
odabere naredba iz izbornika Filters - Decor - Old Photo.

& Script-Fu: Old Photo x

Border size: 20
Sepia
[ Mettle

Work on copy

Help Reset

Pojavljuje se skoCni prozor Old Photo u kojem je moguée odabrati
dodatne opcije filtra. Preporuka je ako se prvi put koristi neki filtar, da se
samo pritisne na dugme OK te se nakon toga moze vidjeti rezultat filtra
po standardnim postavkama. Uvijek se moze ponoviti postupak i
odabrati drugacije postavke u tom izborniku.

Na gornjoj slici nalazi se izvorna slika, a na donjoj se nalazi slika hakon
koristenja filtra Old Photo.
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Na isti nacin koriste se i ostali filtri u toj skupini, otvori se slika i primjeni
filtar. Dolje je naveden primjer koriStenja filtra Slide... u skupini Decor.

Gore je prikazana izvorna slika koja se pomodu filtra pretvorila u ,sliku
na filmu“, tj. dodan joj je okvir filma.

GIMP

~

Filtri se mogu osim na kompletnim slikama koristiti i na dijelovima slika,
selekcijama, tekstu te ostalim grafickim objektima.

Za koristenje filtra na selekcijama, postupak je isti kao i kod cijele slike,
samo $to se prije toga treba oznaditi dio na koji se Zeli primijeniti neki
filtar.

Na dolje prikazanoj izvornoj slici Zeli se da pozadina slike izgleda kao
prasina. Prvo je potrebno oznaciti pozadinu slike te nakon toga
primijeniti na njoj odredeni filtar.
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To se postize uz pomoc filtra koji se nalazi u izborniku Filters - Decor
- Fog. Potvrdene su standardne postavke pritiskom na dugme OK.

Cesto je potrebno i neki tekst malo obogatiti, da izgleda zanimljivije, pa
se najCesce koristi neka vrsta sjene ili neki drugi proizvoljan efekt koji se
dodaje preko filtra.

Prvo je potrebno napisati tekst te nakon upisa upotrijebiti filtar Drop
Shadow koji se nalazi na izborniku Filters - Light and Shadow.
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“ Drop Shadow X
@ Drop Shadow ) ——
Gimp je besplatan greAcki ala_~128 {[Untitied]}
Presets: “ + &
X 6000 1
¥ 6,000 - JE
Blur rhdius 9,001
coo I |
Opacity 08151
Preview
Help Reset Cancel

U sko€nom prozoru Drop Shadow mogucée je promijeniti poziciju sjene, o
radijus zamagljenja, boju sjene te neprozirnost. Nakon odabranih Zanimljivosti i napomene

vrijednosti, potrebno je pritisnuti dugme OK. Skoé&ni prozor Drop Shadow

= e obi¢no se otvara u pozadini
GIMP je besplatan graficki alat za j. iza glavnog prozora
5 W = programa pa ga je potrebno
stvaranje i obradu rasterske grafike. odabrati s programske
trake.
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8.7. Vjezba: Koristenje osnovnih alata

1. Otvorite sliku Pas.png.

2. Promijenite sliku tako da samo pas na slici ostane u boji, a
ostali dio slike neka bude crno-bijeli, tj. u sivim tonovima.

3. Obrezite sliku na dimenziju 2000 x 2000 px, tako da pas i
dalje bude glavni motiv na slici.

4. Spremite sliku pod nazivom Moj_pas.xcf i izvezite ju u
JPEG format pod istim nazivom.

5. Otvorite sliku Bombonijera.png.

6. Kao stoi vidite, u kutiji nedostaju tri Cokoladice. Vas zadatak
je da ,stvorite“ jednu €okoladicu na bilo kojem praznom
mjestu u kutiji.

7. Spremite sliku pod nazivom Bombonijera_2 nedostaju.xcf.
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9. lIzrada kompletnoga grafickog
rjeSenja koristenjem rasterskog i
vektorskog alata

Po zavrSetku ovoga poglavija moci cete:

o retuSirati fotografiju u programu GIMP za neko graficko
rfeSenje

e jzraditi graficke elemente u Inkscapeu

e izraditi vizul u obliku postera u Inkscapeu u A3 formatu

e jzraditi diplomu za uspjeSno zavrSen glazbeni teCaj u A4
formatu

e podesiti i prebaciti sve elemente iz postera A3 u poster A4
format.

U ovom poglavlju izradit ¢e se grafi¢ko rieSenje za projekt pod nazivom
Glazbena Skola. Potrebno je izraditi plakat/poster u A3 formatu koji ¢e se
staviti na oglasnu plocu tako da se ljudi mogu prijaviti na te€aj sviranja
nekoga glazbenog instrumenta. Nakon toga, potrebno je izraditi i
diplomu u A4 formatu koju ée primiti polaznici koji uspjesno zavrse teca,.
Kao posljednji dodatni zadatak, izradit ¢e se i manja verzija plakata, tj.
postojeéi A3 plakat ¢e se prebaciti u A4 format, tako da se moze
prikazivati i na manjim oglasnim plo¢ama, autobusnim stajalistima,
rasvjetnim stupovima itd...

9.1. lzrada A3 postera za glazbenu skolu

1. Izradite A3 poster dimenzije 297 x 420 mm dizajna kao na
donjoj slici. Sve boje koje su navedene u zadacima su u
heksadecimalnom obliku.

2. Napravite pozadinu tako da nacrtate pravokutnik veliine
stranice, promijenite mu boju ispune u ,e3fcffff“ i promijenite
ime sloja u Pozadina. Zaklju€ajte sloj pomocu ikone lokota.

3. lzradite novi sloj Tekst i pozicionirajte se na njega.
Cjelokupni tekst treba biti poravnan po sredini stranice
(Object - Align and Distribute).Tekst:

e "GLAZBENA SKOLA" je veli¢ine 110 to€aka, fonta
Calibri bold, proreda 128 tocaka i boje "4b1211ff",

e "upisi u tijeku" i datum "17.6. - 28.6.2019." je veliine
36 to€aka, fonta Arial Rounded MT Bold i boje
"019482ff",

e "dostupniinstrumenti" je veliCine 40 to€¢aka, fonta
Verdana i boje "7alf26ff",

o "flauta, truba, klavir, saksofon, gitara, harmonika" je
veli¢ine 35 to¢aka, podebljano, fonta Verdana i boje
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Zanimljivosti i napomene

Uvijek je pozeljno kada se
radi neki veéi projekt kao
Sto je ovaj da se povremeno
spremi dokument zbog
neocekivanih prekida u
radu, blokiranja programa,
nestanka struje itd. Mozete
spremiti dokument pod

nazivom A3_poster.svg.

"7alf26ff", izmedu njih je krug visine i Sirine 3 mm, iste
boje kao i natuknice,

e "www.glazbena-skola.hr" je veliCine 25 to€aka,
podebljano, fonta Calibri i boje "ffO000ff".

Izradite novi sloj Linije i pozicionirajte se na njega. lzmedu
teksta "upisi u tijeku” i datuma nalazi se linija elipsastog
oblika koja se moze izraditi pomocu Bezierove krivulje.
Odabere se alat Pen, u dodatnim opcijama alata pod Mode
se odabere Create regular Bezier path, a pod Shape se
odabere Ellipse. Pritisne se lijeva tipka miSa (moze se i
drzati tipka [Ctrl]] uz povlagenje, tako da linija bude ravna) i
povlaci se u lijevu ili desnu stranu. Nakon toga, pritisne se
opet lijeva tipka mi&a, linija promijeni boju u zelenu te se za
iscrtavanje linije pritisne desna tipka miSa. Kada je linija
nacrtana, promijeni joj se dimenzija na 210 mm Sirine i 2,6
mm visine, crne boje.

U isti sloj Linije, potrebno je dodati i dvije linije s markerima,
koje se nalaze s lijeve i desne strane teksta "dostupni
instrumenti”. Linije su Sirine 37 mm, debljine obruba 1,3
mm, boje "7alf26ff". Za srednji marker (dijaloski okvir Fill
and Stroke - Stroke style > Markers) odabrana je mala
strelica (tre¢a u padajuéem izborniku iza nedavno
koristenih).

Za crtanje dizajnerskoga prikaza tipki na dnu ekrana,
potrebno je prvo izraditi sloj Dizajnerski prikaz tipki i
pozicionirati se na njega. Nakon toga nacrtajte 20
pravokutnika (tipke) Sirine 14,27 mm i visine 52,2 mm.
Napravite jednak razmak izmedu njih pomocu izbornika
Object & Align and Distribute. Promijenite svakoj tipki
proizvoljno visinu pomocu alata Selector, tako da izgledaju
priblizno kao i na donjoj slici. Obojite tipke u Cetiri razlicite
boje kao i na donjoj slici (s lijeva na desno): b28b2eff,
cfa341ff, b69631ff, d2b557ff, a nakon toga se nasumice
mijesaju te boje.

Crne manije tipke su Sirine 8 mm i maksimalne visine 25
mm. Poredajte ih i promijenite visinu priblizno kao i na donjoj
slici.

U zaglavlju slike nalazi se crtovlje i note u valovitom prikazu.
Potrebno je prvo izraditi novi sloj Crtovlje i note i
pozicionirati se na njega. Pomocu alata Pen (Bezierova
krivulja) potrebno je izraditi jednu valovitu liniju kao $to je
prikazano na donjoj slici. NajlakSe je dobiti takav oblik
krivulje tako da se pritisne lijevom tipkom miSa na pocetak
krivulje (lijevi rub stranice), odvuce se linije do priblizno pola
stranice i tamo se pritisne i drZi lijeva tipka misa gdje se
stvara prvi brezZuljkasti dio krivulje. Nakon toga se pusti lijeva
tipka miSa i pokaziva¢ miSa se odvodi do desnog ruba
stranice. Kada je linija zadovoljavaju¢e dimenzije i oblika,
pritisne se lijeva tipka miSa (linija promjeni boju u zeleno) te
nakon toga pritiskom na desnu tipku mi$a stvara se linija.
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10.

11.

12.

Promijeni se boja linije (Object > Fill and Stroke - Stroke
paint) u ddaf22ff, debljine 0,3 mm. Potrebno je imati 5 linija
(kopiranjem ili dupliciranjem) i imati jednak razmak
izmedu njih pomocu izbornika Align and Distribute.

Ubacite (File = Import) 3 slike nota u dokument
(Nota_1.png, Nota_2.png, Nota_3.png), prilagodite im
veli€inu i rasporedite ih priblizno kao na donjoj slici.

Postavite G klju€ u gornji desni dio vizuala. Izradite sloj G
kljuc€ i pozicionirajte se u njega. Umetnite (File = Import)
dokument g_kljué€.svg. Postavite ga u crnu boju, zarotirajte
da izgleda priblizno kao na donjoj slici i postavite prozirnost
(engl. Opacity) na tom sloju na 40 %.

Izradite sloj Instrumenti. Umetnite (File > Import) dva
instrumenta iz datoteke Puhacki_instrumenti.svg,
promijenite im veli€inu i rotirajte ih tako da izgledaju kao na
kona¢nom vizualu.

Gitara, koju je potrebno ubaciti u sloj Instrumenti nije u
vektorskom obliku ve¢ u rasterskom i ima neku pozadinu.
Potrebno je otvoriti sliku u programu GIMP i obrisati
pozadinu. Pozadina se moze obrisati tako da se oznadi
gitara ili pozadina s nekim od alata za selektiranje (Tools =
Selection Tools) i nakon 5to se selektira samo pozadina,
obriSe se pritiskom na tipku [Delete]. Takva slika bez
pozadine se izveze pod hazivom
Gitara_transparentna.png. Nakon toga se u programu
Inkscape odabere sloj Instrumenti, uveze se (File >
Import) slika Gitara_transparentna.png i prilagodi kao sto
je na donjoj slici.

Na kraju je potrebno jo§ samo poslagati 6 transparentnih
nota kao Sto su na donjoj slici. Kako su note obojane i u
obliku slike, potrebno ih je najprije postavit u crnu boju da se
dobije isti efekt kao na donjoj slici. Otvori se Nota_1.png u
programu GIMP i pretvori se u Grayscale (Image - Mode
- Grayscale). Nakon toga je potrebno dobiti potpuno crnu
notu. Najlakse je to preko izbornika Colors - Levels. Pod
opcijom Input Levels povladi se lijevi crni trokuti¢ prema
desnoj strani do zadovoljavajuce crne boje. Nakon potvrde,
izveze se slika pod nazivom Nota_1 CB.png. Ponovi se isti
postupak za ostale dvije note i izveze ih se u

Nota_2 CB.png i Nota_3 CB.png. Nakon zavrSetka uvezu
se nove, crno-bijele note u Inkscape, izradi se novi sloj Note
u pozadini i poreda ih se kao $to je prikazano na donjoj slici.
Sloj Note u pozadini postavi se na 20 % Opacity tako da se
dobije prozirnost i siva boja kao na donjoj slici.

Spremite konacan vizual pod nazivom A3_poster.svg i u
PDF format pod nazivom A3_poster.pdf. Otvorite i
pogledaijte vizual u PDF formatu.
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9.2.

Izrada A4 diplome kombinacijom rasterskog i
vektorskog alata

1.

Izradite u programu Inkscape A4 diplomu, vodoravne
orijentacije, dimenzije 297 x 210 mm dizajna kao na donjoj
slici. Sve boje koje su navedene u zadacima su u
heksadecimalnom obliku.

U programu GIMP napravite pozadinu tako da otvorite novu
praznu sliku, bijele boje, A4 formata (300ppi), vodoravnog
usmjerenja. Nakon &to izradite sliku, primijenite filter Fog
(Filters > Decor > Fog) po standardnim postavkama za
dobivanje pozadine.

Standardne postavke filtera: Fog color fOb446, Turbulence
1.0, Opacity 100. Izvezite sliku po standardnim postavkama,
pod nazivom Pozadina.png.

U programu Inkscape promijenite ime sloja u Pozadina.
Umetnite sliku Pozadina.png i prilagodite ju stranici.

Izradite novi sloj naziva Crtovlje i note. Ubacite (File >
Import) sliku Crtovlje_s_notama.png u njega, prilagodite ju
i postavite na gornji dio diplome kao Sto je prikazano na
donijoj slici.

Izradite sloj Crtovlje i note (dolje) i nacrtajte u vektorskom
obliku doniji dio slike, crtovlje i note:

¢ 5 linija koje predstavljaju crtovlje su Sirine 297 mm
(Sirina stranice), debljine 0,3 mm (Fill and Stroke »>
Stroke style &> Width), boje 554400ff. Razmak izmedu
njih je 20 px po Y osi (Object — Arrange),

e uvezite g klju€ (File > Import) iz datoteke g_kljué.svg,
postavite ga u 554400ff boju i podesite veli¢inu prema
crtovlju,

e dvije Cetvorke koje se nalaze odmah na pocetku su
fonta Arial, veli€ine 40 to¢aka, 554400ff boje,

e nota se sastoji od elipse i tankoga pravokutnika. Elipsa
je 8irine 6,6 mm, visine 4,6 mm, 554400ff boje i
rotirana za 20 stupnjeva obrnuto kazaljke na satu
(Object - Transform - Rotate), a pravokutnik (desna
linija note) je Sirine 1 mm, visine 15,5 mm, 554400ff
boje,

e za dobivanje dviju nota zajedno, potrebno je duplicirati
note i postaviti gore na njih liniju (pravokutnik) Sirine 12
mm, visine 2,5 mm (note se postavljaju od ruba do
ruba gornje linije),

e za dobivanje Cetiriju nota zajedno, postavite gore na njih
liniju (pravokutnik) Sirine 34 mm, visine 2,5 mm gdje su
sve note jednako odmaknute jedna od druge,

e postavite note po crtovlju, kao na donjem crtezu,

Zanimljivosti i napomene

Uvijek je pozeljno kada se
radi neki vedi projekt kao
Sto je ovaj da se povremeno
spremi dokument zbog
neocekivanih prekida u
radu, blokiranja programa,
nestanka struje itd. Mozete
spremiti dokument pod
nazivom

A4_diploma.svg.

Zanimljivosti i napomene

Elemente mozete grupirati
tako da mozete s njima
lak§e manevrirati.

Zanimljivosti i napomene

Za lakSi rad na dokumentu,
kada zavrSite s nekim
slojem, mozete taj sloj
zakljucati tako da si
slu€ajno ne pomaknete
elemente u njemu.
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10.

e dvije linije koje se nalaze izmedu nota su visine crtovlja i
Sirine 0,465 mm, 554400ff boje.

Izradite sloj G klju€ i crtovlje u koji ¢ete postaviti crveni g
klju€ na prikaz crtovlja, kao $to je prikazano na lijevoj strani
donije slike:

¢ 5 linija koje predstavljaju crtovlje su Sirine 69 mm,
debljine 0,36 mm, crne boje. Razmaknute su jedna od
druge po Y osi 50 px (Object > Arrange),

e lijeva boc¢na linija koja spaja crtovlje je Sirine 0,36 mm,
visine 78 mm, crne boje,

e umetnite (File > Import) datoteku g_kljué.svg,
promijenite mu boju u aa0000ff, podesite ga na visinu
87 mm, Sirinu 33 mm i postavite na crtovije,

e oznacite crtovlje i g kljuc i otvorite filter Blur (Filters -
Blurs - Blur). UpiSite pod Horizontal blur 0.21,
Vertical blur 0,21 te pritisnite na dugme Apply za
potvrdu,

e rotirajte (Object > Transform - Rotate) oba objekta za
20 stupnjeva obrnuto kazaljke na satu i postavite ih
na diplomu kao $to je prikazano na donjoj slici.

Izradite sloj Pecat i umetnite (File > Import) u njega sliku
pecat.png. Podesite sliku na sirinu 42,5 mm, visinu 55 mm
i pozicionirajte ga kao na donjoj slici.

Izradite sloj Naslov. Upisite tekst Diploma o zavrSenom
te€aju, fonta Monotype Corsiva, veli€ine 45 tocaka,
800000ff boje. Pozicionirajte naslov kao na donjoj slici.

Izradite sloj Linije i tekst u koji Cete postaviti sve elemente
kao na donijoj slici:

e 3 dulje linije su Sirine 160 mm, debljine 0,5 mm, crne
boje, razmaknute jedna od druge po Y osi 80 px (Object
- Arrange),

e 2 krace linije su Sirine 90 mm, debljine 0,5 mm, crne
boje, razmaknute jedna od druge po Y osi 80 px (Object
- Arrange),

e tekstovi ispod linija, odozgo prema dolje: Ime i prezime
kandidata, Ime i prezime profesora, Instrument za
koji se izdaje diploma, Naziv glazbene Skole i datum,
Potpis, su crne boje, veliine 12 to¢aka, fonta Arial,
poravnati na sredinu linije.

Spremite dokument pod nazivom Diploma.svg i
Diploma.pdf. Otvorite i pogledajte kona¢an vizual u PDF
formatu.
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9.3. Dodatni zadatak — prebacivanje plakataiz A3 u
A4 format

1.

Potrebno je napraviti kopiju dokumenta A3_poster.svg i
preimenovati ga u A4_poster.svg. Otvorite ga i promijenite
mu dimenziju stranice na A4, 210 x 297 mm.

Potrebno je sve slojeve otklju€ati, oznaciti sve elemente i
proporcionalno ih smanijiti tako da na dnu ostane 28 mm
praznine za dodatan tekst, kao Sto je prikazano na donjoj
slici.

Potrebno je dodati 2 donje tipke tako da se s njima popuni
sve do kraja stranice, proSiriti pozadinu i podesiti sve
elemente na pozadini da budu na sredini.

NapiSite tekst ViSe informacija i u drugi red broj mobitela
098/889-7367, crvene boje iz donje palete boja, fonta
Verdana, podebljano, veli¢ine 7 to¢aka i razmaka izmedu
redova 7,5 to€aka, poravnati sve po sredini.

Rotirajte tekst za 90 stupnjeva, duplicirajte tekst 22 puta i
napravite jednak razmak izmedu njih.

Nacrtajte okomitu isprekidanu liniju visine 28 mm, crvene
boje iz donje palete boja, debljine 0,1 mm i postavite na nju
srediSnja 3 €vora. Umetnite horizontalno Skare iz datoteke
Skare.svg, podesite im veliginu te ih postavite kao marker
na sredisSnja 3 ¢vora linije.

Duplicirajte liniju sa Skarama 23 puta i postavite ih sa svake
strane teksta u jednakom razmaku.

Spremite dokument pod nazivom A4_poster.pdf.
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Prilog 1. — Napredne mogucnosti dorade
grafike

Po zavrsetku ovoga poglavija moci cete:
o Kkoristiti opcije za lijepljenje objekata
e crtati 3D elemente
e Koristiti tweak alat.

Postoje mnoge dodatne moguénosti za doradu grafike u Inkscapeu,
neke od tih moguénosti mogu samo olaksati i ubrzati rad dok druge
postavljaju konac¢an vizual na sasvim novu razinu. U ovom poglavlju
spomenut ¢e se samo neke napredne mogucénosti i kako se njima
koristiti.

1.1. Koristenje opcija za lijepljenje objekata (engl.
Snapping tool)

Snap Controls Bar uklju€uje niz ikona koje se mogu kliknuti i koje
ukljucuju ili isklju€uju razne opcije lijeplienja na objektima, mrezi ili
pomi€nim linijama. U prvoj sekciji se nalazi ikona kojom se moze
iskljuditi ili ukljugiti sva vrsta lijepljenja. Druga sekcija odnosi se na
lijepljenje do i od toCaka definiranih objekata. Tre¢a sekcija obuhvaca
opcije za prebacivanje na ¢vorove i tekst. Posljednja sekcija ima ikone
za uklju€ivanje i isklju€ivanje prebacivanja na granicu neke stranice,
pomicne linije i mreze.

Ikone i objadnjenja pojedine opcije lijeplienja Snap Controls Bar-a:

™ Enable snnaping — omogucuje ili onemogucuije lijepljenje.

Snap to edges of a bounding box — naredba kojom se mogu
prilijepiti rubovi okvira objekta.

= Snap bounding box corners — zakvacite se u kutove okvira
objekta.

= Snap midpoints of bounding box edges — prilijepite se od i do
srediSta rubova okvira objekta.

Snapping centers of bounding boxes — prilijepite se iz i do centra
okvira objekta.

v Snap to path — prilijepite ¢vorove ili rucke.

= Snap to path intersections —zakacite se za putanje.
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* Snap cusp nodes, incl. rectangle corners — lijepljenje na sjeciste
putanje.

.|

“ Snap smooth nodes, incl. quadrant points of ellipses —
pri€vrscivanje na vrhove ¢vorova.

o Snap midpoints of line segments — lijepljenje od i do sredidnjih
toCaka segmenta linije (to uklju€uje segmente ravnih linija na nekim
oblicima ili putanjama).

Snap centers of objects — lijepljenje iz ili u srediste objekta.

Snap an item's rotation center — lijepljenje na os rotacije nekog
objekta.

A Snap text anchors and baselines — lijepljenje donije linije teksta.
L Snap to the page border — lijepljenje na rubove stranica.
it Snap to grids — lijepljenje na mrezu.

1/ Snap guides - lijepljenje na pomicne linije.

Kako bi se objekti mogli precizno smijestiti na platno, moguce ih je
dodatno podesiti tako da se prilagode svojem cilju. Cilj moze biti drugi
objekt, granica stranice, linija mreze ili linija pomiéne linije. Lijeplienje se
dogada kada se odredena tocka na objektu priblizi svojem cilju.

Lijeplienje se moze postaviti tako da se uvijek dogodi ili da se dogada
samo kada je toc¢ka lijepljenja unutar zadane udaljenosti od cilja.
Postavljanje udaljenosti lijepljenja podesava se preko kartice Snap u
dijaloSkom okviru Document Properties koji je prikazan na donjoj slici.

2 @ srce



Osnove rada s alatima za graficki dizajn (Inkscape, GIMP) (M100)

4 Document Properties (Shift+Ctrl+D) - O =

7 Document Properties (Shift+Ctrl+D) = ®

Page Guides Grids Snap Color Scripting Metadata License
Snap to objects
O Always snap
(® Snap only when closer than:!
Snap distance l 20

[] Snap to clip paths
[] Snap to mask paths

Snap to grids
®) Always snap
(O Snap only when closer than:

Snap distance l 50

Snap to guides
() Ahways snap
(®) Snap only when closer than:

Snap distance l 20

Miscellaneous

[ Snap perpendicularly
[] Snap tangentially

1.2. 3D elementii njihova perspektiva

Alat 3D Box omogucuje crtanje 3D kutija koje se mogu uredivati u
Inkscapeu. Kako bi se nacrtala 3D kutija potrebno je odabrati alat 3D

Box [;:l (na alatnoj traci ima opis Create 3D boxes) i ljevom tipkom
misa povlaciti po platnu. Nacrtat ¢e se 3D kutija i prikazati ovisno o
nacinu prikaza koji je odabran u gornjem dodatnom izborniku, Box Tool-
u. Na donjoj slici nalazi se prikaz dviju strana i koordinatni sustav. Kad je
odabran alat 3D Box prikazat ¢e se i opcije pomocu kojih se moze
mijenjati nacrtani 3D objekt.

X Z

Tako postoji osam toCaka na kutovima objekta kojima se moze
promijeniti veli€ina 3D objekta ili dubina. Osim tih to¢aka, na 3D objektu
nalaze se joS$ tri dodatne tocke s kojima je omoguceno dodatno mijenjati
perspektivu objekta ili toke nestajanja. Na donjoj slici prikazane su sve
tocke koje se mogu pojaviti kada je odabran objekt s alatom 3D Box.
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Desna tocka

Lijeva tocka nestajanja
nestajanja
- _
O

&

Totke za \ Kretanje po

promjenu veli¢ine —/ perspektivi

Prema pocetnim postavkama, 3D kutija je nacrtana s dvije toCke
nestajanja, lijevom i desnom. ToCke nestajanja su postavljene na rubove
stranica objekta, poravnate po sredini izmedu gornje i donje stranice
objekta. Sve 3D kutije dijele tocke nestajanja tako da kada se mijenja
to¢ka nestajanja na jednoj, mijenja se i na svim ostalima. Ako se Zeli
promijeniti toCka nestajanja samo selektirane 3D kutije, potrebno je
pritisnuti i drzati tipku [Shift] kada se mijenja tocka nestajanja.

Alat 3D Box moze crtati kutije sa 1, 2 i 3 tocke perspektive. Vrsta
perspektive se mijenja putem dodatnih opcija 3D Box alata u Tools
Controlsu. Svaka od tri tocke perspektive (X, y i z) se moze postaviti na
beskonacénost ili na odredenu tocku. Ako se Zeli postaviti ili ponistiti
toCka perspektive na beskonacnost, potrebno je pritisnuti dugme
"paralelne linije", oznacene crvenim okvirom na donjoj slici.

-

Angle ¥: [319,276 = I Angle¥: (90,000 SN Angle Z: [192,828 - I

Kada je postavljena na beskonaénost, smjer perspektivne tocke se
postavlja pomocu parametra Angle. Kutovi se mogu mijenjati putem
polja za unos u Tools Controlsu ili pomocu tipkovnih pre¢aca x: [.1; y: (,);
i z: {,}. Ako se koriste tipkovni precaci, kutovi ¢e se promijeniti kutom
zakretanja od 15 stupnjeva, a ako se pritisne i drzi tipka [Alt] promjena
kuta bit ¢e 0,5 stupnjeva u Zeljenom smjeru. Npr. ako se Zeli povecati Y
kut za 15 stupnjeva, pritisne se otvorena zagrada [Shift + 8], a ako se
Zeli smanijiti za 15 stupnjeva pritisne se zatvorena zagrada [Shift + 9].

Perspektiva 1 tocke

Za perspektivu jedne toCke potrebno je X i Y toCke nestajanja postaviti
na beskonacnost pomoéu dugmeta "paralelne linije" te postaviti kut X na
180 stupnjeva i kut Y na 90 stupnjeva. Dugme "paralelne linije" za Z
toCku treba biti iskljueno. Nakon toga se povuce toCka nestajanja do
Zeljene lokacije (obi¢no je to blizu sredista crteza). Kao 5to se moze i
vidjeti, moguce je pomicati samo jednu to¢ku nestajanja Sto je i glavna
odlika ove perspektive.
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Za micanje neke od 6 ploha na kutiji, kao $to je prikazano na gornjoj
slici, potrebno je razgrupirati 3D kutiju [Shift+CtrI+G], oznaditi zeljenu
plohu, pa nakon toga premijestiti, obrisati ili ju izrezati [Ctrl+X]. Jednom
kada su plohe razgrupirane mogu se bojati, pomicati, moze im se
mijenjati veli€ina, odnosno moze se raditi sve kao i sa svakim drugim
objektom.

Perspektiva 2 tocke

Ova perspektiva je i unaprijed zadana perspektiva u programu. Postavlja
se Y toCka nestajanja na beskonacnost tako da se ukljuéi dugme
"paralelna linija" u Tools Controlsu. UpiSe se u kut Y 90 stupnjeva i
iskljuCuju se tocke X i Z. Nakon toga se povilace toCke X i Z do Zeljene
lokacije (obi¢no su na pocetku na istoj razini, ali na suprotnim stranama
stranice).

Na gornjoj slici moguce je vidjeti dvije to¢ke nestajanja koje je moguée
pomicati (crvena i zuta linija vode do njih).

Perspektiva 3 tocke

Uklju€uju se X, Y i Z toCke nestajanja tako da se isklju¢e sva dugmad
"paralelne linije" u Tools Controlsu. Povlace se X, Y i Z toCke nestajanja
na zeljena mjesta. Uobi¢ajeno je da su X i Z toCke nestajanja na istoj
razini samo na suprotnim stranama stranice, a Y se nalazi na suprotnoj
strani, ispod ili iznad objekta.
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Na gornjoj slici moZe se vidjeti sve tri toCke nestajanja koje je moguce
pomicati u Zeljenim smjerovima.

Izometrijska projekcija

Kutije se mogu iscrtati izometrijskom projekcijom tako da se ukljuci sva
dugmad "paralelne linije" u Tools Controlsu. Za izometrijsku projekciju X,
Y i Z kutovi se postavljaju na 150, 90 i 30 stupnjeva.

Na gornjoj slici moZze se vidjeti da nema ni jedne toCke nestajanja koju je
moguce micati.

1.3. Koristenje tweak alata

Tweak Tool ‘& se koristi za male izmjene objekata, putanja i boja. Alat
se moze odabrati direktno na Tool Boxu ili preko precice na tipkovnici,
odabirom slova W ili kombinacijom tipki [Shift] + [F2].

Tweak Tool radi kao Cetkica koja pokriva kruzni dio zaslona, a podrucje
na kojem djeluje oznaceno je narancastim krugom. Utjecaj alata je
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najjaci u sredini i glatko pada do ruba kruga. Dva parametra, koja su
smjestena u dodatnim opcijama alata u Tools Controlsu, utje€u na
ponasanje alata:

e With - odreduje veli€inu alata. Ima raspon od 1 do 100, gdje 20
odgovara radijusu od 100 ekranskih piksela. Vrijednost se moze
mijenjati okretnim dugmetom ili strelicama na tipkovnici lijevo i
desno. Tipka [Home] postavlja Sirinu na 1, a tipka [End] na 100.

e Force - odreduje koliko snazno kretanje alata utjeCe na objekte

na zaslonu. Raspon je takoder od 1 do 100, gdje 1 oznaCava
jako slab pritisak, a 100 jako snazan. Na tipkovnici tipke gore i
dolje mogu smanijiti ili povecati vrijednost pritiska. Odmah pokraj,
nalazi se tipka Use Pressure, a kada je uklju¢ena, moguce je
koristiti grafiCki tablet za crtanje i pisanje koji onda pretvara fizicki
pritisak na tabletu u odgovarajuéu silu u programu (najCesce se
koristi u kaligrafiji).

Tweak Tool ima nekoliko nacina za uredivanje objekata, putanje i boje.

Opcije se odabiru klikom na odgovarajucu ikonu u Tools Controlsu pod

opcijom Mode ili pomocu tipkovnog precaca.

Objekti moraju biti selektirani ako ih se Zeli uredivati pomocu alata
Tweak Tool. Pomocu tipke [Space Bar] moguée se na brz nadin
prebacivati izmedu alata za selektiranje (Select Tool) i alata Tweak .
Ako ni jedan objekt nije selektiran prije korisStenja alata Tweak , poruka
upozorenja ¢e biti ispisana na Status Baru.

U dodatnim opcijama alata Tweak se odmah na pocetku odabire
veli¢ina alata i sila, a nakon toga, pod opcijom Mode odabire se Zeljeni
nacin rada nad objektima.

Ima preko 10 nacina rada koji su podijeljeni u 3 skupine. Kada su objekti
selektirani, odabere se alat Tweak, klikne se na Zeljeni nacin rada i
pritisne se i drzi lijeva tipka miSa na objektima koje se Zeli izmijeniti. Kod
nekih nacina, moguce je pritisnuti i drzati tipku [Shift] kako bi taj nacin
radio u suprotnom smijeru ili suprotne stvari od uobi¢ajenih.

Prva skupina se odnosi na izmjenu samih objekata koji se mogu
pomicati na razne nacine, smanjivati i povec¢avati, rotirati, duplicirati i
@ X

zamudivati.

Na gornjoj slici moguce je vidjeti na prvom mjestu neki pocetni objekt i
nakon njega u ostalim kvadrati¢ima utjecaj razliCitih nacina rada na isti
objekt. Prednost Tweak alata je u jednostavnosti njegovog koristenja za
postizanje gore prikazanih rezultata. Potrebno je samo odabrati
odgovarajuéu opciju i proci tim alatom po objektima za razliku od nekog
drugog nacina kojim bi se moglo isto to posti¢i gdje bi se trebalo utrositi
mnogo viSe vremena da se postigne jednak ili slican konacan rezultat.

+
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Druga skupina se odnosi na izmjenu i podeSavanje putanja. Svi nacini
za izmjenu putanje dijele parametar Fidelity. Raspon parametra je od 1
do 100. Niska vrijednost daje grubo izobli¢enje koridtenjem nekoliko
¢vorova (engl. nodes), dok visoka vrijednost daje glade izobliCenje, ali s
viSe ¢vorova. Potrebno je imati na umu da ce bilo kakvo izoblicenje
putanja utjecati na cijelu putanju, ¢ak i na dijelove koji su daleko od
pokazivacga. Alati u ovoj skupini imaju i nekoliko poznatih problema. Ako
se koriste na otvorenoj putanji, putanja ¢e se zatvoriti. Ovi alati ne rade
dobro na ravnim linijama ili linijjama sa samo dva ¢vora.

y ¢
D 4

+

Treéa skupina se odnosi na podeSavanje boja objekata. Tweak Tool se
moze koristiti i za male promjene u boji objekata. Pritom se mijenja boja
Fill i/ili Stroke cijelog objekta. Za promjenu boje potrebno je u Fill and
Stroke dijaloSkom okviru, na kartici Fill, odabrati Zeljenu boju. MozZe se
koristiti za pode3avanje boje grupe objekata, pri Eemu se objekti koji su
najblizi pokazivacu, najviSe mijenjaju.

: ®

Tweak Tool u nacinu rada u boji ima Cetiri opcije. MoZe djelovati
neovisno o nijansi (Hue), zasi¢enosti (Saturation), svjetlini (Lightness) i
neprozirnosti boje (Opacity). Bilo koja od tih opcija se moze neovisno
prebacivati pomocu ikona H, S, L i O u dodatnim opcijama alata.

1.4. Vjezba: lzrada 3D prostora

1. Otvorite novi dokument formata A4 i izradite 3D prostor
kao na donijoj slici.

2. Nacrtajte kutiju u perspektivi 1 to¢ke (X 180, Y 90),
dimenzije 110 x 110 mm, izgleda pribliznog kao na donjoj
slici (zuta, desna tocka nestajanja treba se nalaziti unutar
kutije da se postigne dubina kao na slici).

3. Razgrupirajte kutiju ( [Ctrl] + [G]) i obriSite prednju plohu.
Boje kutije u heksadecimalnom obliku su:
- desnii lijevi zid je deaa87ff, straznji zid je
f4e3d7ff, strop je e9c6afff i pod je c87137ff.
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Prozor je Sirine 28 mm ivisine 33 mm, s obrubom 2
mm. SrediSnji dio koji razdvaja prozore na dva djela
(pravokutnik) je Sirine 2 mm. Boja ruba je 803300ff, a
ispune d5f6ffff u heksadecimalnom obliku.

Desni ormar s policama, takoder je u perspektivi 1 tocke,
Sirine 27 mm i visine 53 mmm. Potrebno ga je
razgrupirati i duplicirati gornju plohu tako da se dobiju
dvije police. Boje u heksadecimalnom obliku koje se
koriste u ormaru su:

- gornja ploha je 916f6fff, desna boc¢na i lijeva
unutarnja ploha je ac9393ff, donja unutarnja ploha
je e3dbdbff, straznja ploha je b3b3b3ff i police su
boje c8b7b7ff.

Lijevi donji ormari¢ je isto u perspektivi 1 tocke, Sirine 26
mm ivisine 26 mm. Kada se razgrupira, boje se mogu
uzeti alatom Dropper (kapaljka) iz desnog ormari¢a s
policama.

Jedan od nacina za dobivanje slike na lijevom zidu je da
se lijeva ploha (lijevi zid) duplicira i proporcionalno smaniji.
Boja obruba je 550000ff, a ispune 808000ff u
heksadecimalnom obliku. Debljina obruba je 1,5 mm.

Proporcionalno povecajte kompletan crtez do rubova
stranica i spremite pod nazivom 3D_prostor.svg.

Zanimljivosti i napomene

PokuS$ajte staviti sliku i oba
ormara u zasebne slojeve.
Tako ¢ete moci pomocu
skrivanja i otkrivanja
pojedinih slojeva vidjeti
kako izgleda soba sa ili bez
nekih dijelova.
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Prilog 2. — Opis izbornika — Inkscape

U nastavku su navedene najcesée koriStene naredbe i naredbe koje su
se koristile u ovome priru¢niku.

Izbornik File sli¢an je i kod drugih programa, a najosnovnije naredbe za
pocetnike u njemu su:

New — naredba za stvaranje novoga crteza
Open — otvaranje datoteke u programu
Save — spremanje crteza

Save As — spremanije crteza u formatu SVG koiji sluzi za kasnije
uredivanje crteza u programu Inkscape ili spremanje u neki drugi
poznati format kao sto je PDF, EPS ili neki drugi

Revert — postavlja crtez na zadnju pohranjenu verziju
Import — uvoz slika ili crteza u trenutno otvoreni dokument
Export PNG Image — sluzi za spremanije slike u PNG format

Document Properties — sluzi za podeSavanije stranice, mreze,
pomicnih linija i drugo

Close — zatvara trenutno otvoreni crtez

Quit —izlaz iz programa.

@ *Mew document 2 - Inkscape_
File Edit View Layer Object Path Text Filters Extensions Help
New Crd+N L [0 @ Q
Templates... Ctrl+Alt+M o :
= ¥ |BO9A3T ¥
= Open... Ctrl+0
Open Recent o I o P A L
Revert
& Save Ctrl+5
[ Save As... Shift+Ctrl+5
Save a Copy... Shift+Ctrl+Alt+5
+ Import... Cirl+I
[3 Export PNGImage... Shift+Ctrl+E
= Import Clip Art...
= Print... Ctrl+P
s Clean up decument
i1 Document Properties... Shift+ Ctrl+D
¥ Close Ctrl+W
el Quit Ctrl+Q)
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Izbornik Edit sadrzi sljedece, Cesto koriStene naredbe:

Undo, naredba koja briSe zadnju akciju (skracenica za ovu
akciju je [Control] + [Z]) ili Undo History u kojem se Cuvaju
sve prijasnje radnje

Redo — vra¢a zadnju akciju

Cut ([Control] + [X]) — sluzi za izrezivanje

Copy ([Control] + [C]) — naredba za kopiranje

Paste ([Control] + [V]) — sluzi za lijepljenje

Paste In Place ([Control] + [Alt] + [V]) — sluzi za lijepljenje na
istu poziciju iz koje se kopiralo

Duplicate ([Control] + [D]) — sluzi za dupliciranje elementa

Preferences — dodatan izbornik u kojemu se nalaze postavke
za prilagodavanje platna te razna druga pode$avanja u
programu.

l@ *New document 2 - Inkscape w

File Edit View Layer Object Path Text Filters Extensions Help

D Unde: Move jitter tweak Ctrl+Z \ @ @
g Redo Shift+Ctrl+Z :
Bl | @ Undo History... ShiftsCtrieH [ 3094375 ¥
I
[E ¥ Cut Cirl+ X :
pe | Copy Ctrl+C
Il_'l\ [ Paste Ctrl+V
B | B Pasteln Place Ctrl+ Alt+V
[ Paste Style Shift+Ctrl+V
Q Paste Size 4
% + Find/Replace... Ctrl+F
l:‘ U] Duplicate Ctrl+D
Clone 4
@ B Make a Bitmap Copy Alt+B
O 3 Delete Delete
(E}, B Select All Ctri+A
[l Select All in All Layers Ctrl+Alt+A
@ Select Same 4
Z@ Invert Selection !
i Deselect
‘Eg’ Resize Page to Selection Shift+Ctrl+R
l_L’Z Create Guides Around the Page
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Osnove rada s alatima za graficki dizajn (Inkscape, GIMP) (M100)

Izbornik View ima mnoStvo korisnih moguénosti za pregled crteza na
kojemu se radi. Neki od njih su:

Zoom — koristan za priblizavanje i smanjivanje kompletnoga
crteza ili nekoga njegova dijela

Display mode — koristan za pregled dokumenta u nekome
drugom pregledu

Page Grid — prekriva crtez na plathu mrezom koja sluzi za
poravnavanje elemenata na slici

Guides — prikazuje ili sakriva pomi¢ne linije

Show/Hide Dialogs — sakriva ili prikazuje dijaloSke okvire
Swatches — dijaloSki okvir s nekim predefiniranim paletama
boja

Default/Custom/Wide — nacini prikaza programa.

IQ *New document 2 - Inkscape “_

Eile Edit View Layer Object Path Text Filters Extensions Help
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Display mode » .
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Osnove rada s alatima za graficki dizajn (Inkscape, GIMP) (M100)

Izbornik Layer koristi se za dodatne opcije uredivanja slojeva. Korisne
naredbe su:

Add Layer — dodaje se novi prazni sloj na crtez odmah iznad
aktivnoga sloja

Rename Layer — mijenja se ime sloja

Duplicate Current Layer — dodaje se novi sloj, kopija
aktivnoga sloja

Delete Current Layer — briSe se aktivan sloj

Layers — otvara se dijaloSki okvir Layers u kojem je moguce
na brzi nacin dodavati, brisati, premjestati i duplicirati slojeve.

Q *New document 2 - Inkscape ——_
Eile Edit View Layer Object Path Text Filters Extensions Help
D = E Ygl £, Add Layer... Shift+ Cirl+ N
- ' 4. Rename Layer...
Ei= 3
Showhide Current Layer
7 2
[E h Lock/Unlock Current Layer
f-\:' 4 F Switch to Layer Above Ctrl+Page Up
. = Switch to Layer Below Ctrl+Page Down

Q o # Move Selection to Layer Above Shift+Page Up

i = Move Selection to Layer Below Shift+Page Down
% i B, Move Selection to Layer...
|:| 1 i® Raise Layer Shift+Ctrl+Page Up
@ 7 & Lower Layer Shift+ Ctrl+Page Down

1 H Layerto Top Shift+ Ctrl+Home
O i Layerto Bottom Shift+Ctrl+End
@}’ m = Duplicate Current Layer
@ i <8 Delete Current Layer
2@ | 2 Layers.. Shift+Ctrl+L
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Osnove rada s alatima za graficki dizajn (Inkscape, GIMP) (M100)

Izbornik Object koristi se za manipulaciju objektima. Neke od brojnih
naredbi koje nudi su:

Fill and Stroke — otvara se dijaloski okvir u kojemu je moguce
mijenjati boju ispune i obruba

Group/Ungroup — grupiranje objekata ili razgrupiranje

Raise/Lower/Raise to Top/Lower to Bottom — premjestanje
objekata ispod ili iznad

Rotate — rotiranje za 90 stupnjeva u smjeru kazaljke na satu ili
obrnuto od smjera kazaljke na satu

Flip — vodoravno ili okomito zrcaljenje

Transform — dijaloSki okvir u kojemu se radi manipulacija
objektom u smislu rotiranja, zrcaljenja, iskrivljenja, povecanja,
smanjivanja i drugo

Align and Distribute — dijaloSki okvir za poravnavanje
objekata

Arrange — dijalo3ki okvir za postrojavanje objekata.

ﬁ*NewdocumentZ-Inkscape - —
Eile Edit Wiew Layer Object Path Text Filters Extensions Help
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Osnove rada s alatima za graficki dizajn (Inkscape, GIMP) (M100)

Izbornik Path koristi se za manipulaciju putanjama i objektima. Neke od
brojnih naredbi koje ovaj izbornik nudi su:

Object to Path — pretvara neki element u krivulje
Stroke to Path — pretvara odabrani obrub u krivulje

Trace Bitmap — naredba koja se koristi za precrtavanje
rasterskih slika u vektorske

Union/Difference/Intersection/Exclusion/Division/Cut Path
— naredbe koje sluze za lakSe stvaranje nekih novih objekata
ili uredivanje postojecih

Break Apart — razdvajanje objekata u zasebne segmente

Simplify— zagladivanje neke krivulje.

G *Mew document 2 - Inkscape —_
File Edit View Layer Object Path Text Filters Extensions Help
(TEEZ | #& | [{% ObjecttoPath Shift+Ctrl+C 7]
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Osnove rada s alatima za graficki dizajn (Inkscape, GIMP) (M100)

Izbornik Text koristi se za uredivanje i manipulaciju tekstom. Korisne
naredbe su:

Text and Font — otvara se dijaloski okvir u kojemu se moze
dodatno oblikovati tekst

Put on Path — postavlja tekst na neku krivulju prateéi njen
oblik

Remove from Path — mi¢e tekst s krivulje

Q *New document 2 - Inkscape -—_—

Eile Edit View Layer Object Path Text Filters Extensions Help

T Iextand Font. Shift+ Ctrl+T
SVG Font Editor...
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# Put on Path
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Remove from Path

[T) Flow into Frame Alt+W

T Unflow Shift+Alt+W
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"% Check Spelling... Ctrl+Alt+K
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Osnove rada s alatima za graficki dizajn (Inkscape, GIMP) (M100)

U izborniku Filters nalaze se mnogi filtri koji se mogu primijeniti na bilo
koji element ili crtez. Potrebno je samo oznaciti element ili crtez i
primijeniti filtar iz zeljene skupine.

@ *New document 2 - Inkscape -

Eile Edit View Layer Object Path Text Filters Extensions Help
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Osnove rada s alatima za graficki dizajn (Inkscape, GIMP) (M100)

U izborniku Extensions nalaze se razni dodaci za program koji mogu
uvelike olak$ati rad u programu Inkscape. Primjenjuju se na jednostavan
nacin, isto kao i filtri, odabere se iz zeljene skupine naredba koja ¢e se
primijeniti na dokument ili element, ovisno o tome za $to je namijenjen
taj odabrani dodatak.

I@ *New document 2 - Inkscape -__-_

File Edit View Layer Object Path Text Filters Extensions Help
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Osnove rada s alatima za graficki dizajn (Inkscape, GIMP) (M100)

Izbornik Help nudi dodatne informacije i pomo¢ u vezi s programom
Inkscape. Naredbom FAQ otvara se web preglednik u kojemu su
obrazloZena Cesto postavljana pitanja. Pritiskom na naredbu About
Inkscape moze se vidjeti koja verzija programa se Koristi.

Q *New document 2 - Inkscape -h

File Edit View Layer Object Path Text Filters Extensions Help

TEEHE B B ® Inkscape Manual J
. i Keys and Mouse Reference
% @ b =i /| 809,43 Ask Us a Question
T e P L P Tutorials L
Comrmand Line Options —
FAQ

Mew in This Version
Report a Bug
S5VG 1.1 Specification

[ About Memory

# AboutInkscape
|
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Osnove rada s alatima za graficki dizajn (Inkscape, GIMP) (M100)

Prilog 3. — Opis izbornika — GIMP

Program GIMP pruza velik broj mogucénosti, a do svih njih moze se doci
preko izbornika u srediSnjem radnom prozoru. Naj¢eSce koriStene
naredbe ili alati nalaze se na brzo dostupnim mjestima u Toolboxu ili u
desnom prozoru s dodatnim opcijama, dok je ostale potrebno odabrati
preko izbornika.

Izbornik File sli¢an je i kod drugih programa, a najosnovnije naredbe za
pocetnike u njemu su:

e New — naredba za stvaranje nove slike
e Open — otvaranje slike u programu
e Save — spremanje slike

e Save As - spremanije slike u formatu XCF koji sluzi za kasnije
editiranje slike u programu GIMP

e Revert — postavlja crtez na zadnju pohranjenu verziju

e Export — sluzi za spremanije slike u razli€itim datotecnim
formatima kao &to su TIFF, JPG, PNG, GIF, PDF, BMP i drugi

e Close View — zatvara trenutno otvorenu sliku
e Quit —izlaz iz programa.

wd [Untitled]-34.0 (RGBE color 8-bit gamma integer, GIMP built-in sRGB, 1 layer) 1920x1080 -

File Edit Select View Image Layer Colors Tools  Filters Windows Help

* New.. Cir+N |
Create 4
5 Open.. Ctrl+Q 1 o+ 1 LR S T -
® Open as Layers... Ctrl+Alt+0
@ Open Location...
Open Recent L4
Save... Crlss ¢ ]
¥ Save fs.. Shift+Ctrl+5S 1
1
Save a Copy... i
‘s Revert 1
1
1
Export... Ctrl+E i
Export As... Shift+ Ctrl+E i
1
Create Template... !
1
7 Page Setup i
= Print... Ctrl+P !
% Copylmage Location {
i Show in File Manager Ctrl+Alt+F i
% Close View Chrl+ W
%3 Close all Shift+Ctrl+\W |
@ Quit Ctrl+Q ]
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Osnove rada s alatima za graficki dizajn (Inkscape, GIMP) (M100)

Izbornik Edit sadrzi jako korisne naredbe. Neke od njih su:

¢ Undo — naredba koja brise zadnju akciju (skracenica za ovu
akciju je [Control] + [Z]) ili Undo History u kojem se €uvaju sve
prijasnje radnje

o Redo - vraca zadnju akciju

e Cut ([Control] + [X]) — sluzi za izrezivanje

e Copy ([Control] + [C]) — naredba za kopiranje
o Paste ([Control] + [V]) — sluzi za lijepljenje

o Preferences, u kojem se nalaze postavke za prilagodavanje
radnoga prostora te razna druga podeSavanja

o Clear ([Delete]) — brise selektirani objekt

o Fill with FG Colour ([Ctrl + ,]) — ispunjava selekciju s bojom
podedenom pod Foreground (boja prvoga plana)

e Fill with BG Colour ([Ctrl + .]) — ispunjava selekciju s bojom
podeSenom pod Background (boja pozadine).

“ [Untitled]-54.0 (RGE color 8-bit gamma integer, GIMP built-in sRGE, 1 layer) 1920x1080 1
Eile Edit Select View Image Layer Colors JTeols Filters Windows Help

#  Undo Ctrl+Z
"""" ¢* Redo Ctrl+Y
P T T T T |25‘F‘

#3 Fade...

Unde History

Cut Ctrl+ X

o
]
LY

B Copy Ctrl+C
= Copy Visible Shift+Ctrl+C
& | [ Paste Ctrl+V

[7] Paste In Place Ctrl+Al+V

™ Paste Into Selection
™ Paste Into Selection In Place

Paste as 4
Buffer 4

Clear Delete
Fill with FG Calor Ctrl+,
Fill with BG Color Cirl+.
Fill with Pattern Ctrl+:

OOoma

£

Fill Selection Outline...
Fill Path...

K3

Stroke Selection...

&4 Stroke Path...

7 Preferences

Input Devices
Keyboard Shortcuts
& Modules

# Units

2 @ srce



Osnove rada s alatima za graficki dizajn (Inkscape, GIMP) (M1

00)

Izbornik Select sluzi za dodatne opcije kod oznacenog dijela slike ili
kompletne slike. Neke od koristenijih opcija su:

e All — sluZi za oznagavanije cijele slike
o None — brie selekciju sa slike

e Invert — naredba koja radi obrnuto oznacavanje od trenutno
oznacenoga djela, Sto znaci da ¢e se sve Sto je izvan selekcije
nakon odabira ove naredbe nalaziti unutar selekcije i obrnuto

o Float — tzv. privremeni layer, u kojem se nalaze svi objekti prije
nego se pocnu obradivati, dakle, kada se bilo koji element
zalijepi u program GIMP, on se nalazi u float layeru.

. [Untitled]-34.0 (RGB color 8-bit gamma integer, GIMP built-in sRGE, 1 layer) 1920x1080 -
File Edit = Select View |mage Layer Colors Teools Filkers Windows Help
Al Ctrl+ 4
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W O dw Fompath Shift+V
= £ § M Selection Editor
S e
(_k) @ [ Feather... !
Sharpen i
7 Shrink.. |
&4 Grow.. :
=¥ : 1
Tool Optio Border.. :
GEGL Operatil . !
Sample =y Remove Holes |
Distort... i
Radiuz # Rounded Rectangle... E
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Osnove rada s alatima za graficki dizajn (Inkscape, GIMP) (M100)

Izbornik View ima jako puno korisnih mogucénosti za pregled slike na
kojoj se radi. Neki od njih su:

o Dot for Dot — uklju€uje se prilikom obrade slike za web i ako se
obraduju slike za ispis, potrebno je onemoguditi tu opciju tako da
se slika vidi u svojoj punoj veli€ini

e Zoom — koristan za priblizavanje i smanjivanje kompletne slike ili
nekoga njezinog dijela

e Show Grid — prekriva sliku u radnom prostoru mrezom koja sluzi
za poravnavanje elemenata na slici

e Snap to Grid — ponasa se kao magnet te olakSava poravnavanje
elemenata po slici

e Show Rulers — prikazuje ili sakriva ravnalo u programu.

. [Untitled]-534.0 (RGBE color 8-bit gamma integer, GIMP built-in sRGB, 1 layer) 19201080 - GIM
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Osnove rada s alatima za graficki dizajn (Inkscape, GIMP) (M100)

Izbornik Image sluZi za promjene na slici kako bi se poboljSale boje,

veli€ina, polozaj itd. Korisne naredbe su:

Duplicate — izraduje jednaku kopiju aktualne slike te obrada

kopije ne utjeCe na originalnu sliku

Mode — mijenja prikaz slike u RGB ili crno-bijelom modu

Transform — rotira ili zrcalno okrec¢e sliku

Canvas Size — omogucuje kreiranje dodatnoga prostora izvan
slike koiji je koristan ako se zeli dodati okuvir ili tekst van slike

Scale Image — mijenja broj piksela neke slike.

. [Untitled]-34.0 (RGE color 8-bit gamma integer, GIMP built-in sRGB, 1 layer) 1920x1080 - GIMP
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Osnove rada s alatima za graficki dizajn (Inkscape, GIMP) (M100)

Izbornik Layer koristi se prilikom umetanja dodatnih slika na ve¢
postojanu sliku, kod umetanja teksta, crteza i ostalih elemenata. Korisne
naredbe su:

¢ New Layer — dodaje se novi prazni layer na sliku odmah iznad
aktivnog layera

o Duplicate Layer — dodaje se novi layer, potpuno jednaka kopija
aktivnog layera

o Delete Layer — briSe se aktivan layer.

. [Untitled]-54.0 (RGB color 8-bit gamma integer, GIMP built-in sRGB, 1 layer) 1920x1080 - GIMP
Eile Edit Select View |mage Layer Colors Tools Filters Windows Help
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Osnove rada s alatima za graficki dizajn (Inkscape, GIMP) (M100)

Izbornik Colors sadrZi velik raspon alata za podeSavanje boja na nekoj
fotografiji, slici ili crtezu. Koriste se alati ovisno o potrebi, a neki od
najCesce koristenih su:

o Color Balance - sluzi za povecéanje ili smanjivanje koli¢ine
tirkizne, purpurne ili zute boje (cyan, magenta, yellow)

e Hue-Saturation — omogucava povecanije ili smanjivanje nijanse
neke boje, svjetline boje ili zasic¢enja

e Levels — kontrolira sjene, svjetlinu i Sumove na slici

e Curves — alat koji sluzi za promjenu boja, osvjetljenja i kontrasta
neke slike.

-, [Untitled]-534.0 (RGE color 8-bit gamma integer, GIMP built-in sRGE, 1 layer) 19201080 — GIMP
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Osnove rada s alatima za graficki dizajn (Inkscape, GIMP) (M100)

Izbornik Tools takoder je dostupan u Toolbox Windowu s lijeve strane
programa u Single-Window Modu. Koriste se gotovo svi alati iz svake
skupine. Ovaj izbornik koristan je ako se zatvori Toolbox Window radi

dobivanja veéega prostora u programu.
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- [Untitled]-54.0 (RGB color 8-bit gamma integer, GIMP built-in sRGB, 1 layer) 1920x1080 — GIMP
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Osnove rada s alatima za graficki dizajn (Inkscape, GIMP) (M100)

Izbornik Filters sadrzi veliku koli€inu raznih filtara koji se koriste za
poboljSanje neke fotografije ili za stvaranje unikatne slike. Filtri u ovom
izborniku mogu se primijeniti na cijelu sliku, layer ili samo selekciju na
odredenoj slici.

“4. [Untitled]-54.0 (RGB color &-hit gamma integer, GIMP built-in sRGE, 1 layer) 1920x1080 - GIMP
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Osnove rada s alatima za graficki dizajn (Inkscape, GIMP) (M100)

Izbornik Windows pruza pristup velikom broju dijaloga ili panela koji su
dostupni u podizborniku Dockable Dialogs. Velika novost u odnosu nha
verziju GIMP-a 2.8. je Single-Window Mode koji spaja tri odvojena
panela u jedan. Za pocetnike je preporudljivo da koriste Single-Window
Mode zbog lak$eg snalazenja u programu.
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Osnove rada s alatima za graficki dizajn (Inkscape, GIMP) (M100)

Izbornik Help nudi dodatne informacije i pomoc¢ programerima koji zele
razvijati program, kao i obi¢nim korisnicima.

e GIMP Online — podizbornik koji obi¢nim korisnicima i
programerima nudi pomo¢ i dokumentaciju u vezi s programom.
Takoder je moguce preuzeti sadrzaj Helpa na lokalno raéunalo i
pregledavati ga bez koriStenja interneta.

o About — sadrzi informaciju o verziji GIMP-a instaliranoj na
raCunalo.
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Osnove rada s alatima za graficki dizajn (Inkscape, GIMP) (M100)
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